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About This Reference Guide
This online Reference Guide offers a complete description of the Arkitex Director 
interface and provides procedures and settings to work efficiently.

Access the online Reference Guide from the Help menu in the Arkitex Director 
menu bar. It is viewed in a new window of the standard web browser. Also refer 
to specific topics by context-clicking an area or icon in the software user 
interface.

Reading the Reference Guide

Topics can be viewed in the online Reference Guide by expanding the sections on 
the Contents tab and clicking a heading. Continue to read in sequence by 
pressing the Next Page button in the top or bottom right corner of the topic pane.

While progressing, the hierarchy of each specific topic is indicated at the top of 
the topic pane. Click any one of these levels to go back to a higher level in the 
hierarchy.

Use links to jump to Related Topics, to additional information within the 
documentation set, and to Internet sites. All the links are highlighted in red. In 
these cases, navigate back and forward pressing the Back and Forward buttons 
on the browser toolbar.

Using the Index

The index lists the features and concepts of the product in alphabetical order. 
Click the Index tab, and jump to the desired entry.

Using Search

Use Search to make a full-text search for a particular word in the topics.

Related topics: • Printing Information on page 7
• Context-Sensitive Topics on page 8
• Browser Requirements on page 8
• Navigation Overview on page 9

Printing
Information

To print information, two options are available:
7



8 READING THE REFERENCE GUIDE
� To print individual topics

Print a topic by pressing the Print this Topic icon in the top or bottom right corner 
of the topic pane (Windows only), or choose File > Print from the browser 
menu bar.

� To print the whole guide

All the information from the online Reference Guide is also provided in a printer-
friendly, Portable Document Format (PDF). Click the Print this Guide link on the 
blue tab at the top of the pane. The whole document can be printed, or specific 
sections by clicking the Print icon on the Adobe Acrobat toolbar. This feature is 
only available if the browser has the Adobe Acrobat plug-in.

Related topics: • “Navigation Overview” on page 9

Context-Sensitive
Topics

Jumping to relevant topics is done by context-clicking icons and other areas in 
the software user interface. Once the online help system is accessed this way, 
read further as explained in Reading the Reference Guide.

Once the online Reference Guide in the browser is opened, leave the browser 
application open to access new topics quickly.

Related topics: • “Navigation Overview” on page 9

Browser
Requirements

The following Internet browsers are supported for viewing the online Reference 
Guide.

Related topics: • “Navigation Overview” on page 9

Version Platform Operating System

I.E. 5.0 •PC Windows 95, 98, NT, 2000

I.E. 5.5 •PC Windows 95, 98, NT, 2000

I.E. 6.0 
and higher

•PC Windows 95, 98, XP, NT, 2000, 
2003

FoxFire •PC Windows 95, 98, XP, NT, 2000, 
2003

Safari •Mac OS X 10.3
:Arkitex Workflow Reference Guide
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Navigation
Overview

Keyboard and Mouse Conventions

All key names are shown in capital letters. For example, the Control key is shown 
as CTRL.

Keys are frequently used in combinations or sequences as shortcut keys. For 
example, SHIFT+F3 means to hold down the SHIFT key while pressing F3.

The following mouse conventions are used:

To ... Click ...

view topics the Contents tab and expand the sections by 
clicking  and  to open the topic.

jump to the Next topic in sequence

jump to the Previous topic in sequence

jump to a higher level in the document hier-
archy

the level desired in the path at the top of the 
topic pane:

find topics in the alphabetical Index the Index tab

perform a full-text search the Search tab

jump to Related Topics, to additional info and 
internet sites

text highlighted in red

jump Forward and Back in the browse 
sequence

the Forward and Back buttons in the web 
browser.

display a glossary definition the terms highlighted in red

print a topic (for Windows users only)
Click the printer icon  (Windows users 

only), or choose File > Print from the browser 
menu bar.

print the printer-friendly Portable Document 
Format (PDF)

To ... Do this ...

Click Point to an item, and then quickly press and release the mouse 
button without moving the mouse.

Double-click Point to an item, and then quickly press and release the mouse 
button twice.
:Arkitex Workflow Reference Guide



10 RELATED DOCUMENTATION
Related Documentation

The following documents can be referred to for more information:

Arkitex Workflow System Administration Guide, Part Number 
CG+0948500001

Arkitex Client Reference Guide, Part Number CG+0948520001

Context-click on Windows Click the right mouse button.

Context-click on Macintosh Hold down the CTRL key while clicking the mouse button.

Drag Point to an item. Press and hold down the mouse button while 
moving the mouse to a new location. Release the mouse button.

To ... Do this ...
:Arkitex Workflow Reference Guide



CHAPTER

Introduction

Technological advances in recent years are changing the way newspapers are 
produced. The central print site is becoming the norm, handling newspapers for 
a number of publishers, and thus receiving pages from numerous locations with 
differing deadlines.

Output of the correct number of separations per page for each edition — and 
then the correct number of duplicate plates — is always the target. Arkitex 
Director and Arkitex Pair makes sure they are in the right place at the right time. 
Through the use of colorful icons, it provides an at-a-glance status of each page’s 
progress towards the target, monitoring the arrival of files, and output of the 
required quantity of plates.

Arkitex Director and Arkitex Pair manages pages from the point at which they are 
received from the front-end through placing of plates on the press — via the 
output management/OPI system, the RIP, the platesetter, the processor, and the 
punch/bender.

Arkitex Director and Arkitex Pair is equally useful when outputting to film as 
when outputting direct-to-plate. 
11
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CHAPTER

Functional Description

This chapter describes the functional description of Arkitex Director and Arkitex 
Pair.

� Functional Description ......................................................................................... 14
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� Arkitex Publication Builder ................................................................................ 15
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� Arkitex Client ........................................................................................................... 17
� Arkitex Plate Builder ............................................................................................. 19
� Linker .......................................................................................................................... 20
� AutoInk ...................................................................................................................... 20
� Purge Utility ............................................................................................................. 20
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14 FUNCTIONAL DESCRIPTION
Functional Description

Arkitex Director and Arkitex Pair integrate a number of software modules to 
perform managing functions. All modules can be used, and most can function 
from remote platforms that have a network link.

NOTE: The number of modules that can be activated concurrently is controlled 
by passwords.

This online help assumes that the user has purchased both the Arkitex Director 
and the Arkitex Pair licenses. However, it will prompt where only Arkitex Pair, 
or Arkitex Director functionality is described, and can be skipped by specific 
users.

A user can activate each of the installed modules from the Windows Start button 
(e.g., Start > Programs > Arkitex Director).

On the Arkitex Director and Arkitex Pair platform, the user can activate other 
modules from the Console module. The following chapters will give an in-depth 
explanation of each module.

Arkitex Console

The Console is one of the main modules used for configuring Arkitex Director 
and Arkitex Pair. It is a control panel from which other modules can be activated.

NOTE: The Console can only be installed on the Arkitex Director and Arkitex Pair 
platform and cannot be installed on a remote platform.
:Arkitex Workflow Reference Guide



 

2 FUNCTIONAL DESCRIPTION 15
Arkitex Publication Builder

The Publication Builder module allows a user to create and configure specifica-
tions of an edition. 

NOTE: Additionally, an edition can be created by the importation of third party 
information.

Each edition may consist of up to 256 sheets, or 998 pages of any size, including 
tabloids, broadsheets, panorama, and paired pages.

NOTE: The term ‘sheet’ used in these guides refers to a 'Press Sheet’. A sheet can 
contain many pages. Each page can contain color layers. Each color layer of the 
sheet has a plate. Therefore, ‘sheet’ is the easy way to refer to the combination of 
multiple pages with 1 or more colors per page.

As a user progresses through the Publication Builder module, specific screens 
and functionality will become available depending on which product licenses 
have been purchased, i.e., an Arkitex Director license package or a Arkitex Pair 
license package.

� Input File Formats

Incoming pages may include up to seven color layers. Supported input formats 
are:

■ 1-bit TIFF single-strip (uncompressed, or CCITT Groups 3/4 or PackBits), 
(for RIPing or transmission as TIFFs)

■ EPS

■ DCS 1.0

■ DCS 2.0 (single file)

■ PostScriptTM (to enable the ‘RIP once, image many’ feature and the selective 
handling [e.g., holding or imaging] of individual layers within the page, the 
incoming PostScript file must be a composite, or individual single-layer files 
only [not a pre-separated file containing all layers])

■ PDF (for transmission as PDF’s only)
:Arkitex Workflow Reference Guide



16 ARKITEX PUBLICATION BUILDER
■ Output from Arkitex Director and Arkitex Pair is PostScript, TIFF, PDF, or 
XML.

� Arkitex Pair Functionality

The Arkitex Pair functionality allows a user to pair pages within an edition, 
controlling which pages are single pages, false pages, gutterless pages, double-
page spreads, etc., and assigning page numbers and page furniture as required.

� Arkitex Director Functionality

Arkitex Director functionality manages production of the edition. Priorities may 
be applied to different editions ensuring print site control of publications 
arriving from various locations. It is also possible to assign an automatic ‘hot’ 
priority during an edition’s time-critical production period. Different deadlines 
may be set for each page or separation in an edition. A warning is triggered on 
the Arkitex Client Tracking screen if the time is reached before completion — 
Arkitex Client is the tool used to monitor the status of pages/separations 
through production, and/or view Soft Proofs. Soft Proof web clients are 
available.

Incoming pages may be shared among editions, and section handling features 
are available.

A ‘hold’ can be implemented after a specific quantity of duplicate plates has been 
produced. This enables presses to start running, and the remaining duplicate 
plates to be released later. This facility is useful where late editorial changes are 
expected for a particular page.

A FastTrack method of setup is available for the speedy handling of unexpected 
editions. Previously created Publication Builder files may be re-opened for 
parameters to be previewed before production begins.

Publication Builder will preview an AutoPlan file. However, editing this type of 
file in is not supported, and viewing some information is restricted.

NOTE: Publication Builder information may be downloaded from an external 
source (e.g., Arkitex Planner, or a press planning system) so that existing data 
does not need to be manually re-entered. This is called an “AutoPlan’ type file.

Related topics: “Arkitex Publication Builder” on page 25
:Arkitex Workflow Reference Guide



 

2 FUNCTIONAL DESCRIPTION 17
Engine

Publication Builder definitions are entered into the Arkitex Director and Arkitex 
Pair database using the ‘activate’ process. The Engine is the module that receives 
incoming pages, forwards them for output (typically to Arkitex Producer), and 
then handles on-the-fly change requests during production.

NOTE: The Engine can only be installed on the Arkitex Director and Arkitex Pair 
platform. However, a module identical to the Engine called the Remote Engine 
can be installed on a remote platform.

A status log window is available on the Engine display with log messages held in 
an MS SQL database that may be queried for user-specific reporting.

� Log Viewer

The Log Viewer module is provided free-of-charge with the Arkitex Director/
Pair system. It is an administrative program that allows monitoring of system 
messages. Monitoring from a computer other than the Director server allows 
setting alerts and other custom scripting to notify people of system messages.

Related topics: • “(Remote) Engine” on page 213

Arkitex Client

Arkitex Client is the module used to view the current production status of an 
edition and replaces the Edition View modules previously used by earlier 
versions of Arkitex Director and Arkitex Pair. This module is accessed via a web 
browser, typically Internet Explorer.

An edition may be viewed as a whole at any production stage. The steps through 
which a sheet or single page/separation is passing may be displayed to easily 
follow specific progress. Local or remote user displays can be defined under 
password control, enabling selected staff to ‘view only’, or ‘view and manage’ 
specific pages/editions. ‘Hot’ pages needing special attention, or pages 
belonging to specific sections, can be grouped together in a single display.

A Soft Proof option enables pages and individual layers to be previewed before 
output. CMYK and spot color values are reported by Soft Proof to assist the 
checking of color output from the press.
:Arkitex Workflow Reference Guide



18 ARKITEX CLIENT
Approval can be used to block pages from output until the page has been 
approved.

Pages can be output to a local printer using the printing proof option, or hard 
proofed to network printers. Hard proofs can be output to different proofers, 
depending on whether the output is mono or color.

The following standard, on-the-fly changes are possible during production:

■ The number of expected layers

■ The color of expected layers

■ The output path of the page/s

■ The output filename

■ The Approval of a page

Depending on which product licenses have been purchased, the browser 
appearance and functionality will differ.

When accessing Arkitex Pair functionality via Client, the following on-the-fly 
changes are possible during production:

■ The expected incoming filename for each page within a pair

■ The page number assigned to each page within a pair

■ The template

■ The color to be resubmitted

■ The ignore status of each page within the pair

� Arkitex Director Functionality

Arkitex Director functionality accessed via Client will display the production 
status of each edition at every event in the production sequence.

NOTE: The Arkitex Pair functionality accessed via Client will only display the 
production status of each edition at the Arkitex Pair event.

Barcode readers may be used to feed that status back to Director at various 
stages of output (for example, when plates leave the processor or punch/bender, 
:Arkitex Workflow Reference Guide



 

2 FUNCTIONAL DESCRIPTION 19
and when they are placed on the press). Detailed log messages are easily 
accessible.

Director can also track transmission of files, with users at Send sites able to view 
progress at the Receive site, and vice versa.

On-the-fly changes possible during production are:

■ The expected incoming filename for each file/page

■ The number of duplicate plates required

■ The hold value

■ The deadline time

■ The hot time

■ The ignore status of each page

■ Priority

Single plates may be re-imaged in the event that one is damaged, without the 
need for the page or separation to be resent from the front-end.

Related topics: • “Client” on page 231

Arkitex Plate Builder

Page furniture can be added to/removed from incoming pages enabling, for 
example, a press site's required cut marks, color strips, etc., to be applied to 
pages input from various editorial sites and publishers. It also enables stripping 
in of rectangular elements, such as ads.

� Arkitex Pair Functionality

If the Arkitex Pair package of licenses is purchased, Plate Builder is able to define 
multiple pages within the full image area of a final film or plate. The user is able 
to change size, position, and rotation of pages as global templates, which may be 
applied to multiple publications/editions.

■ When the Arkitex Pair license has been purchased, up to two pages may be 
configured in a template.
:Arkitex Workflow Reference Guide



20 LINKER
■ When the Arkitex Imposer license has been purchased, up to eight pages may 
be configured in a template.

Related topics: • “Arkitex Plate Builder” on page 233

Linker

Plate Builder and AutoInk files can be added to, or removed from, incoming 
editions, sheets, pages, and separations; and to generate on-the-fly, updated 
Soft Proof and Ink Presets during production.

NOTE: Ink Presets can only be generated if the AutoInk license has been 
purchased.

Related topics: • “Linker” on page 293

AutoInk

Ink density calculations may be generated automatically for each file received, 
supplying non-inking areas and different-sized ink zones.

Related topics: • “Arkitex AutoInk” on page 285

Purge Utility

The Purge utility resets edition parameters, or deletes them after use. Log 
messages can also be removed when they are older than a user-defined date, and 
specified files can be deleted. Files can be purged manually, or automatically at 
specified dates and times according to specific criteria.

Related topics: • “Manual Purge Utility” on page 305
:Arkitex Workflow Reference Guide



CHAPTER

Arkitex Console

The Console is the ‘launch pad’ for the various Arkitex Director and Arkitex Pair 
modules:

NOTE: The Console will always be titled :Arkitex Console whether only Arkitex 
Director is installed, only Arkitex Pair is installed, or a combined Arkitex Director 
and Arkitex Pair system is installed.

� Toolbar

From left to right the buttons access:

■ Publication Builder

■ Engine

■ Arkitex Client

■ Plate Builder (optional)

■ Ink Setup (optional only in an Arkitex Director installation)

■ Activate

■ Link Template (optional)

■ Manual Purge
21



22 MENU BAR
Menu Bar

The Menu bar contains File and Help options. File contains configuration, 
backup, and console display options. Help contains information on the product 
build level.

� File

From File the following options can be accessed:

� Configuration

The default Configuration options relate to global system parameters. 

■ Options include: User Logins, Plate Builder, Event Manager, Event 
Sequence, Unplanned, FastTrack Colour Ids, Mail Notification, Coloured 
Paper, Load Configuration and Save Configuration.

NOTE: 
1. If Arkitex Courier has been enabled under System Setup > Console, an 
additional option called Arkitex Courier Destinations will also be listed.

2. Configuration options are password protected. See your system administrator 
if you have questions.

� All Tasks

The options under All Tasks relate to backing up and restoring the Producer 
server.

■ Options include: Backup System, Restore System, and Change :Arkitex 
Producer Server....

� Always on Top

Sets the Console to always appear on top of any other program display.

■ Once this has been chosen, right-click on the Console to revert back to the 
original display.
:Arkitex Workflow Reference Guide
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� Help

The Help menu contains the About... screen, which contains the Arkitex 
Director and Arkitex Pair build level.
:Arkitex Workflow Reference Guide
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4 ARKITEX PUBLICATION BUILDER 27
Publication Builder

Arkitex Publication Builder provides a number of user-friendly screens with 
prompts to enable you to create a *.pmd file, which contains the default param-
eters for tracking an edition.

� Activating Pub Builder

� Generating Editions

There are three methods that can be used to generate editions: generate a 
completely New Full Edition, generate another edition by editing or updating an 
existing edition, or create a FastTrack Edition.

Once page furniture has been created via Plate Builder in the form of *.pmt files, 
this furniture can be applied to an edition, or even specific sheet separations, via 
the Publication Builder or Linker modules.

Only one *.pmt file and only one output location can be applied to one sheet 
separation. Once pages are imposed, changes can only be applied to the sheet.

Wizard When creating a new plan, a wizard launches with different configuration 
screens. By clicking Next, you can work through each screen. After the plan is 
saved, and if it is edited, configuration tabs appear. 

The main tabs and their sub-tabs are:

By clicking on the icon on the Console, the Arkitex Publication 
Builder module is activated.
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� Start

■ “Publication” on page 31

■ “Naming” on page 64

■ “Page Counts” on page 72

■ “Edition Options” on page 90

■ “Inks Definition” on page 92

■ “Default Inks” on page 94
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� Page

■ “Colors” on page 98

■ “Doubleburn” on page 102 (optional tab)

■ “Content” on page 104

■ “ResubmitPlanned” on page 105 (optional tab

■ “Variations” on page 113

■ “Page Options” on page 115
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� Sheet

■ “Priority” on page 124

■ “Copies” on page 126

■ “Hold” on page 127

■ “Deadline” on page 128

■ “Sheet Options” on page 131

� Output
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■ “Imposition” on page 131

■ “Secondary Output” on page 158

■ “Barcode” on page 178

■ “Ink Presets” on page 166

■ “Transmission” on page 174 (Courier only)

� Review & Activate

■ “Preview and Change” on page 175

■ “View Groups” on page 185

■ “Save and Activate” on page 192

Publication

The Publication tab allows you to create a new edition, create a FastTrack 
edition, edit an existing publication, or import a publication.

� New Full Editions

The title Full Edition is used to distinguish this edition from a FastTrack 
edition. To create a new *.pmd, select New.
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� Editing and Activating Pre-existing Editions

To change an existing *.pmd file, select Edit/Activate, and locate the file using 
Browse. By default, the *.pmd files are stored in the Arkitex\Director\Config 
folder.

To edit an existing *.pmd file, select Edit/Active, and then select the tabs that 
corresponds with the necessary edits.

� FastTrack Editions

The FastTrack option can also be used to create *.pmd files in Publication 
Builder. FastTrack editions do not use any imposition control or default settings.

� Import

A publication plan can be imported from another system. 

Use the Browse button to located the file. The file path will populate the name 
box.

� Activate

Publication Builder is used to Activate an existing *.pmd file. Select Edit/
Activate, and then the Review & Activate tab.

Activating an edition means that the edition instructions defined in the *.pmd 
file will be entered into the Director and Pair database so that: 1) incoming pages 
from the edition are expected; and 2) the Edition Name appears on the Client 
display.
:Arkitex Workflow Reference Guide



 

4 ARKITEX PUBLICATION BUILDER 33
� Creating a New Publication

Select New to start a new publication. Clicking Next steps you through the 
configuration of relevant elements in the plan.

� Publication Type

If there is an Arkitex Pair or Arkitex Imposer license, the option Publication 
Type becomes available. Select either Single, Previously paired, or Imposed 
Publication.

■ Single - One printed page to one sheet (plate)

■ Previously Paired - A file contains already paired pages

■ Imposed Publication - If Arkitex Pair imposition control is a function of 
Director, the user can determine how many pages are imposed onto each web 
sheet, controlling which pages are single pages, false pages, gutterless pages, 
double-page spreads, and double-burns.

NOTE: For Director only systems, the Publication type is never an Imposed 
Publication.

� Publication Date

A specific publication date can be configured (by default, this is the creation 
date, but is configurable to any future date). Publication Date sets a day, 
month, and/or year variable(s) for inclusion in the incoming file name. A basic 
file name pattern can be used for many days. The date provides uniqueness to 
distinguish files from each other. Date variables can be added to the incoming 
file name.

� Publication Name

This is the long name variable defined during the Publication Setup 
Configuration.

■ Type in the new name in the Publication Name field.

■ Click on the Publication Tree Setup button located on the left below the 
Publication Tree Preview box.

■ Configure the publication hierarchy.
:Arkitex Workflow Reference Guide



34 ESTABLISHING DEFAULTS
� Plan Duration

A Plan Duration can be added to identify the expected life-span of the 
publication. The default is to purge the plan after one year’s activity.

Related topics: • “Save and Activate” on page 192

Establishing Defaults

This section describes how edition plan defaults are established. It is important 
to understand the parent-child relationship when planning a publication. 
Publication Builder allows flexibility and helps identify when children both 
share and differ in plan attributes.

� Default Settings Button

When selected establishes the necessary defaults used by Publication Builder for 
all publications.

� Publication Tree Setup

Consists of four tabs

■ “Names Tab” on page 35
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■ “Misc Tab” on page 38

■ “Import” on page 42

■ Transmission

Names Tab

Names are established as variables. Each variable will have both a long and a 
short name; and both names can be used in file name parsing and in plate 
annotation. 

The Edition long name may appear in the Client display and be used for plate 
annotation, while the Edition short name is used in the expected file naming.

� Group Types

Using Publication Builder one or more sets of names are created. For each type 
of name – Publication, Edition, Zone, Section, and Book – a set of long names, 
and the associated short names (a one-to-one relationship) are defined.

■ Publication

■ Edition
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■ Zone

■ Section

■ Book

■ Short names can have different lengths, but the length must be at least a 
single character.

■ The order of these names can be modified to move names up and down in the 
list. The order can be used to arrange the appearance of names in the publi-
cation tree.

� Save as Default

From this screen sets of names can be stored to disk. One set of names is defined 
as the default set.
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When a New plan is created, the default set of names is automatically imported 
for use in the new plan.

� Load Defaults

Loads the default settings into the new plan.

� Import

Other sets of names can be imported into Publication Builder and will replace 
the default set. This set of imported names is then used for configuring the 
Publication.

� Export

The Publication Builder configuration file is saved to a specified location of your 
choice.

� Help

Clicking Help launches context-sensitive help.

� OK

Clicking OK accepts the configured settings.

� Cancel

Clicking Cancel cancels the configured settings.
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Misc Tab

The Misc screen defines the standards used throughout the Director and Pair 
system regarding the following:

■ Variation Characters - A variation is a planned change to a page (or layer); 
Since variations are planned, each has a different expected file name. They 
appear in Client as separate pages within an edition or zone.

� Page variations may appear in the same edition (pages with A and B varia-
tions, sometimes called an A/B Split), or they may appear in different 
editions (or zones).

� The standard is set to either Alphabetic or Numeric, whichever is the 
character type to be used to identify a page variation.

■ Double Burn Characters - The merging of two bitmaps into a single bitmap 
for imaging. This is often the combination of an advertising bitmap with an 
editorial bitmap. 

� If a page layer color has a double burn layer expected, the file name must 
include a character to identify the primary layer and the double burn layer 
as it arrives.

� Set the expected characters for the Primary Layer or Double Burn Layer.

■ Default Date Format - Set the default by selecting from the pull-down 
selection the expected date format. Formats include:

� Day without leading zero (1-31) [d]
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� Day with leading zero (01-31) [dd]

� Day abbreviation [ddd]

� Day name [dddd]

� Day of week (1-7) [w]

� Week of Year (1-54) [ww]

� Month without leading zero (1-12) [m]

� Month with leading zero (01-12) [mm]

� Month abbreviation [mmm]

� Month Name [mmmm]

� Day of year (1-366) [y]

� Year 2 digit (00-99) [yy]

� Year 4 digit (0001-9999) [yyyy]

■ Change Pages - Use to set the Default Page Settings and Default Change 
Behavior.

� Default Page Settings - The default is set to either Shared or Changing, 
whichever is the majority of new page settings. When defining publica-
tions with multiple editions/zones, many of the pages are the same in 
each edition/zone (Shared), while the remainder of the pages change 
(Changing).

NOTE: Pages may be shared among multiple Editions/Zones within a 
Publication, but pages cannot be shared across different Publications.

� Default Change Behavior - This refers to a plan that has been reloaded. 
Share From Previous means share from the edition previous to this one. 
Share From First means share from the first edition relative to this one.

NOTE: This option only affects previously created plans that are being loaded 
(opened) in to Publication Builder.
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� Example One:

1 Load the plan "Share from first.pmd".

2 Click on Default Settings.

3 Go to the Misc tab.

4 You will notice that Share from First is selected.  Then click OK.

5 Go to the Page, and select the Page Options tab.

6 Click on Change Pages.

7 Right click on page LPR\006, then select Change Page.

a You will notice that page FUE\006 will jump share to page gen\006.

NOTE: This is correct behavior when Share from First is selected.

� Example Two:

1 Load the plan "Share from first.pmd".

2 Click on Default Settings.

3 Go to the Misc tab.

4 Change from Share from First to Share from previous. Then click OK. 

5 Save the plan as "Share from previous.pmd".

6 Reload (reopen) the plan "Share from previous.pmd".

7 Go to the Page and select the Page Options tab.

8 Click on Change Pages.

9 Right click on page LPR\006, then select Change Page.

a You will notice that page FUE\006 will share to page LPR\006.

NOTE: This is correct behavior when Share from Previous is selected.

� Destinations

Destinations refers to Courier transmission sites that will send publication plans 
to press sites.
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■ Web Service - Web Service gets transmission configuration information 
from the JBoss Server where the Courier engine runs.

� Host Name - The host name of the Courier server running the Courier 
engine. If local, enter localhost.

� Port - The port number of the Courier server. The default is 18181.

■ Import - Imports transmission configuration files from Courier servers. 
These are *.xml files stored in the Director > Config > General Settings 
folder.

NOTE: If Destinations is enabled, an additional tab called Transmission will 
appear after the Ink Presets tab. See “Transmission” on page 174.

� Apply Book To Extra Info

■ Short Book Name - The short name of a book.

■ Long Book Name - The long name of a book.

� Extra Info Field

There are four variables: %x, %2x, %3x, and %4x. Use this to automatically add 
a book name into the extra info field for a sheet.

� Apply Physical Page Number to Page Extra Info

The physical page number can be annotated onto plates, or used in output file 
names. Publication Builder can automatically enter the physical page number 
into the Page Information field.
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If this feature is enabled, you will not be allowed to manually enter Page Extra 
Info. Checking Apply Physical Page Number to Extra Info stores the physical 
page number in this field.

NOTE: When this checkbox is clicked, all areas where you can modify the Page 
Extra Info will be disabled.

Import

The Import tab contains Import Folders options, Import Control, Auto Scan 
Time, and Filter options.

� Import Folders

■ Import Folder - The path to the folder for importing configurations from 
Courier and AutoPlan.

■ Save Folder - The path to the folder to save configurations after creation in 
Publication Builder.

■ Error Folder - The path to the folder that holds error plans.
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NOTE: If the Save or Error folder is not specified, then the original plan is 
discarded after processing.

� Import Control

■ Enable Import - Turns on the import capability to scan for new 
configurations from Courier and AutoPlan.

■ Enable Import on Startup - Turns on the import capability when the 
Publication Builder starts.

■ Auto Scan Time (secs) - Sets the time interval to scan for imported 
configurations.

■ Filter - Used for filtering AutoPlan and Planner configurations.

Publication Tree Setup

The Publication Tree hierarchy is based on a parent-child relationship.

The term Parent indicates that the selected item (an Edition, for example) 
contains other nodes on the tree (such as Sections or Zones).
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■ Selecting a Parent node becomes, in effect, a shortcut to selecting a number 
of children.

■ The image above identifies a number of nodes and indicates whether the 
node is a Parent, a Child, or both a Parent and a Child.

The term Child indicates that a given object is a sub-element of a Parent object.

■ In order to be a sub-element, a given node in the tree must be positioned 
below and to the right of the Parent.

■ A Child (such as North) can itself be a Parent, so the selection of a node also 
selects all child nodes of the selected Child.

■ Selecting Manchester Evening News selects North and South. In turn all 
children of North and South are selected. The higher up on the tree the selec-
tion is made, the total number of children selected may increase.

■ At no time will the selection of one child cause changes to another child at the 
same level. For example, the selection of North will not cause any changes to 
South.

Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75

Selecting Multiple
Children

In the example below, Extra and First Final are both children of Manchester 
Evening News, and North and South are both children of Extra.
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If a user selects Extra, they are really selecting both the North and South Zone in 
the tree. In this case, the user has not selected any zones in the First Final or City 
Final Editions.

In many cases, a user may select a Parent node on the tree that, in turn, contains 
multiple children.

■ As an example, if the user selects First Final in the tree above, they are in 
reality selecting all of the zones in the First Final Edition.

■ When this is the case, the user sees in Publication Builder a composite view 
on the right-hand side of the screen.

■ This composite view (shown in the image above) displays information for all 
of the selected editions. The example above shows a composite display of 
North, South, Stockport, and Altirincham.

� Also note in the image that a  icon displays next to South, Stockport, 
and Altirincham indicating they are configured differently from North.

Related topics: • “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
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• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75

When Selected
Children Editions

Differ

There are times when multiple Editions are selected, and the editions are not 
identical. The number of sections in the editions, or the pages in the editions may 
differ. Images the North Edition and South Editions below demonstrate this.

In the two images showing the North and South Editions, the number of 
sections, and consequently the number of pages, in each edition differ. The first 

3 sections

1 section
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edition North has 3 sections and 80 pages. The second edition South has only 1 
section and 52 pages.

■ When this is the case, the composite display indicates where particular 
settings differ between selected editions.

■ This indication will be different based on the type of user interface control 
used.

The composite of North and South, the Number of pages, and the Number of 
sheets controls are blank indicating the number of pages and sheets is not the 
same in all Editions.

The composite display is the same regardless of the order of editions in the tree. 
If the South Edition (with only 1 section) appeared in the tree first, and the 
North Edition (with 3 sections) appeared second, the composite display will be 
the same as if the North were first and South second.

■ In the Composite picture of North and South, the  icon displayed in the 
tree not only represents the Edition selected that will be modified, but shows 
the South differs from the North.

NOTE: By default, the first selected edition cannot be different.

■ To view details of each edition, select each edition in the tree.
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■ Any time a user changes the value of a control, such as entering a number of 
pages in the screen above, that setting is automatically applied to all selected 
children.

NOTE: In the examples above, the first Edition includes 3 sections with page 
counts of 52, 16, and 16. The second Edition includes a single section with a 
page count of 52. The second Edition does not contain the second and third 
sections (Property and Sports). The composite display includes the page counts 
for those sections from the North Edition, since the page count value in the South 
Edition is non-existent and is considered, for display purposes, not to be 
different from the first Edition. Each time a specific setting is different between 
selected editions, the user interface will indicate this difference using the 
specific user interface control.

Related topics: • “Selecting Multiple Children” on page 44
• “Entering Publication Information when Children Differ” on page 48
• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75

Entering
Publication

Information when
Children Differ

When the editions differ in the number of sections, the following rules are used 
when the user enters information. Publication Builder applies that information 
to the selected editions.

In the North and South Editions example, the following assumes the user is 
entering information into the composite of North and South.

Publication Builder Action

User Action Compose View North South

Enter 80 pages. Pages set to 80; 
sheets set to 40.

Pages set to 80; 
sheets set to 40.

Pages set to 80; 
sheets set to 40.

Enter 52 pages in 
News section.

New pages set to 
52; sheets set to 
26.

News pages set to 
52; sheets set to 26.

News pages set to 52; 
sheets set to 26.
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Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75

Entering Informa-
tion when Children

are the Same

When all children either are the same, or they have the same structure (meaning 
if the user is looking at a composite display of the Page Counts screen, all 
children have the same number of sections), but different values, any changes 
are automatically made to all children.

Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75

Blanked User Inter-
face Control when

Children Differ

The table below lists each type of interface control and an idea of how the control 
will indicate that values among children are different.

Enter 16 pages in 
Property section.

Property pages set 
to 16; sheets set to 
8.

Property pages set to 
16; sheets set to 8.

Nothing, since there 
is no Property section.

Enter 12 pages in 
Sports section.

Sports pages set to 
12; sheets set to 6.

Sports pages set to 
12; sheets set to 6.

Nothing, since there 
is no Property section. 
Pages in South 
Edition set to 52 since 
there are only 52 
pages.
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NOTE: The specific display may differ from the examples below.

Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
• “Entering Information when Children are the Same” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75
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Page Colors Screen
Behavior when
Children Differ

Indicates that there are differences between the Page Colors for page 1 between 
the North and South Edition.

Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75
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Imposition Screen
Behavior when
Children Differ

The Imposition screen will automatically apply imposition information 
(templates, output paths) to all children editions.

When multiple children are selected, if there is a reason that a child cannot be 
imposed, the “warning” icon appears next to the specific edition to identify the 
indicated edition(s) could not be imposed. The following would cause an 
imposition warning:

■ Missing templates

■ At least one sheet does not have an event sequence (output path) assigned

■ Not enough sheets to hold all pages

■ Empty position (i.e., a Dinky needs to be assigned)

When multiple children are selected, and there is a difference in the number of 
pages, the following displays in the Imposition screen. The screen displays 
(- Pages) as the number of pages, and the Number of Sheets remains grayed 
out.
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Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55

Tree Structure
Preview

The Tree Structure Preview screen behaves differently than other screens in 
Publication Builder. 

When highlighted, an Edition/Zone will never represent an additional Edition/
Zone. Each Edition/Zone is considered unique, if a difference exists among 
children.

Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
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• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75

View Group Screen The View Groups Screen behaves differently than other screens. If a discrepancy 
exists among children, each child must be highlighted individually to define 
view groups for that child.

Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75
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Other Screens

Other screens will behave as previously described. Each time multiple Editions 
are selected, any change is automatically applied to all selected editions when 
possible.

NOTE: “When possible” refers to those instances where a selected edition does 
not include the parameter being changed. An example is where the first Edition 
contains 2 Sections, and the second Edition contains 1 Section. Any changes 
made to the second section (such as the number of pages in the second section) 
cannot be made to the second Edition, since it contains only 1 section.

Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75

Special Situations

There is a situation where the order in which editions appear in the tree may 
cause confusion in how Publication Builder will work.

A Publication with 4 editions appears in the tree in the following order: First, 
Second, Third, and Fourth. The First and Second Editions have 2 sections, while 
the Third and Fourth Editions have only 1 section. 

■ When all Editions are selected, any changes made to section 2 in the 
composite display are made to Editions 1 and 2.

■ The order of editions is changed so that Editions 1 and 3 have 2 sections, and 
Editions 2 and 4 have 1 Section. The same is still true: any changes made to 
section 2 in the composite display are made to all children with 2 sections, 
regardless of the order in which they appear in the tree.

Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
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• “Entering Information when Children are the Same” on page 49
• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Advanced Page Mapping” on page 75

Defining/Editing a Publication Hierarchy

A new publication can be selected several ways:

■ Click on Publication Tree Setup to setup or edit the structure of the 
publication. A publication name is optional and can be selected from the drop 
down list in the top, left-hand corner. The drop down list contains all 
publications that have been configured in Default Settings.

■ A publication name can be provided in New, through Edit/Activate an 
existing publication, or through importing a publication:

� Create Publication

10 Click on New.

11 In the Publication Name field, supply the new publication name.

� Publication Structure

Below the publication pull down menu, you can select one of four publication 
options for how they want their publication to be structured. After selecting the 
basic structure of the publication, the corresponding list of pre-configured, 
available names will appear on the right.

NOTE: If an existing previously Paired page type is opened, and the publication 
structure is edited, options that contain Section will be disabled. A plan with 
previously paired pages cannot have sections; therefore, sections will be 
disabled and not shown on the tree.
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� How to use the Publication Tree Setup

To setup a publication with two editions, two zones and four sections in each 
zone:

� Setup

1 Check the names of the editions, and then highlight the first edition.

2 Check zones, and apply for that edition.
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3 Select the first zone, and select sections that apply.

4 In the Tree Preview to the right, highlight the first zone, and drag it onto the 
second zone. The sections of the first zone will be copied onto the second.

5 After the edition is setup in the Tree Preview, highlight and drag the first 
edition onto the other editions. This is an easy way to setup identical edition 
structures.
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6 To edit the structure for a particular edition or zone, highlight the edition 
and/or zone that requires modification.

NOTE: If an item cannot be dropped at the location of the mouse pointer, the 
pointer changes to a No Drop cursor. If the item can be successfully dropped, the 
cursor changes to an arrow with a plus sign next to it.

7 The tree will scroll automatically to make the selected item visible. If the user 
changes the structure option on the left, the lists and the tree are updated. 
The screen can be resized to enlarge the Tree Preview for viewing.

8 After setting up the publication structure, check the Tree Preview to make 
sure it is set up correctly. If the tree structure is incomplete, a warning will 
display when OK is selected.

CAUTION: If an item is unchecked within an edition/zone, and the item is 
dragged and dropped again to update other editions/zones, it will not 
uncheck that item. These types of changes/updates must be done manually 
within each edition/zone. Drag and drop only adds items; it does not 
uncheck them.
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How To Utilize FastTrack

FastTrack offers speed when setting up an edition with less edition specification 
control. This is useful in a number of situations where setup speed is required 
(maybe a last minute edition); where fixed elements in the incoming filenames 
are limited; or where edition setup data is provided at the last minute by a press 
planning system, SoftProofs and/or Ink Presets are generated.

Related topics: • “FastTrack1 Config Dialog Box” on page 60
• “FastTrack2 Config Dialog Box” on page 62

FastTrack1 Config
Dialog Box

This is the first of two dialog boxes when configuring a FastTrack edition.

� Display Mode

Select Intelligent or Sequential to affect the manner in which incoming page 
softproofs are displayed in Client. Intelligent mode displays overlays layers of 
the same page. Sequential mode displays a single layer, thumbnail softproof.

� Control Edition input by

Edition input can be controlled by File Name, or by Directory.

If by File Name, at the prompt define a number of alphanumeric characters that 
will be the same for all file inputting for this edition and will become known as 
the edition identifier.
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If there is no consistent edition identifier in the incoming filenames, route all 
pages for one edition into a special directory (not the standard Arkitex\In 
folder).

� Edition Identifier

There is a maximum of 75 alphanumeric characters that will be the same for all 
file inputting for this edition and will become known as the edition identifier.

NOTE: A wildcard ‘?’ can be entered as part of the edition identifier.

� Starting at position

The starting position identifies where the edition identifier begins in the file 
name.

� Specify fixed # position from

Identifies the page number positions. It is not necessary to specify an incoming 
page number position, but it will affect the display in Client.

� Specify fixed $ position from

Identifies the color separation identifier positions.

� Action for resubmitted files

What happens if a file is input more than once? Choose between:

■ Ignore implies that no action is to be taken. Do not display receipt in 
Tracking, do not SoftProof, do not calculate Ink Presets, do not forward to 
Arkitex Producer, do not overwrite the existing file in the 
Arkitex\DIrector\Complete folder.

■ Substitute and output all plates, i.e., substitute this page/separation for the 
one previously submitted, and re-output the full number of duplicate plate 
copies defined. If any of the first submission’s duplicate plate copies are still 
waiting in an Arkitex Producer queue, they will be deleted.

■ Substitute and output pending plates, i.e., substitute this page/separation 
for the one previously submitted, but only output the quantity of duplicate 
plate copies which have not been output using the first file. Any of the first 
submission’s plate copies waiting in an Arkitex Producer queue will again be 
deleted. This rule is particularly useful in conjunction with the Hold After 
feature if the typical input is composite and late blacks are expected.
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■ Substitute and do not output plates, i.e., substitute this page/separation 
for the one previously submitted, but do not output duplicate plate copies 
which have not been output using the first file. Any of the first submission’s 
plate copies waiting in an Arkitex Producer queue will again be deleted. 

Related topics: • “FastTrack2 Config Dialog Box” on page 62

FastTrack2 Config
Dialog Box

This is the second of two dialog boxes when configuring a FastTrack edition.

� Priority Options

Top Priority is 127. Specify a number between 2 and 126.

� Initial Status

Initial Status relates to what should happen when the edition instructions 
created (*.pmd file) are activated, i.e., the edition instructions defined in the 
*.pmd file are submitted to the Director and Pair database so that incoming 
pages from the edition are expected, and the Edition Name appears on Client. If 
the On radio button is checked, Director and Pair will accept incoming pages for 
output and forward them to Arkitex Producer in the normal manner.

■ If the Off button is checked, Director and Pair will accept incoming pages, but 
will not forward them to Producer for output until the edition is manually 
released. Client will flag a red traffic light against this edition to show it is ‘on 
hold’ (stopped). Click the green traffic light (if available) to switch the 
edition On in Arkitex Client and allow pages to be forwarded to Producer.
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NOTE: That if the SoftProof option is configured, soft proofs of incoming files are 
always generated, regardless of whether an edition has been stopped or not. 
Similarly if the Ink Presets option is configured, ink calculations will be 
generated immediately when a file is input, regardless of whether an edition has 
been stopped or not.

� Copies

The number of copies specified relates to the quantity of duplicate plates of each 
layer of this edition to be output.

� Soft Proof

Soft Proof may be enabled or disabled for a FastTrack edition. A new 
background color for the Soft Proofs is available by selecting the Colored Paper 
box. The default Soft Proof background color is white.

� HoldAfter

It is possible to specify a HoldAfter value. It is sometimes the case that a small 
number of duplicate plates is required to get the press running, while the 
remainder are held back. This facility is useful if late changes are expected.

NOTE: These values apply to the whole edition’s pages. To specify different 
output quantities for different pages/separations, create a full Arkitex edition.

■ NoHold - Output all duplicate plates one after the other.

■ Hold after N copies - Hold output after the specified number of copies.

� Select an event sequence

One event sequence may be selected to apply to all pages in a FastTrack edition.

� Ink Presets files

One Ink Presets file may be selected to apply to all pages in a FastTrack edition.

NOTE: The ink presets file format is configured at setup by the system 
administrator. It will either be a *.ini file or a *.ips file.
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� Plate Template file

One plate editor template may be selected to apply to all pages in a FastTrack 
edition. 

� Secondary Output

A secondary output path may be selected to route a second copy of incoming files 
for output, e.g., if a TIFF is required to be generated from an incoming composite 
file in order to be forwarded to a third-party press control system.

NOTE: In FastTrack, the secondary output filename will always be the same as 
the input filename. To specify a custom, secondary output filename, create a full 
Arkitex edition.

Related topics: • “FastTrack1 Config Dialog Box” on page 60

Naming

Variables for the input and output structure can be added to the publication.

� Control Edition Input By

When the Publication Type selected in the Create new or open existing 
Publication dialog is either Single or Previously paired, pages can be defined 
as Controlled edition input by File Name or Controlled edition input by 
Directory.

Using the Controlled edition input by File Name method, all pages are 
submitted into the Arkitex\Director\In folder.

For those editions whose Publication type is Imposed Publication, pages must 
always be defined as Control edition input by File Name, and the Control 
edition input by is not available.

� Change Internal Postscript Name

If this value is set to Enable, Publication Builder will change the internal 
PostScript job name of files going to output to follow the structure 
Edition_Name#.$, where Edition_Name reflects what was defined on the first 
screen of the Publication Builder module. (This assumes incoming PostScript 
files to be modifiable.) Without this change, TIFF input to the Arkitex GRAFIXrip 
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— which has no internal name — would always reflect the same name, making 
it impossible to differentiate one file from another. If this registry value is set to 
Disable, the internal name (if there is one) is left untouched. This can be useful 
if the file is to be forwarded to a third-party transmission system.

� Input File Name Structure

This field is used to define the configuration to be used to control which 
incoming pages relate to which edition. The variables are used to define the 
configuration. These variables are derived from the way in which the publication 
has been defined in the Tree Structure - Hierarchy Selection and can be 
overridden by selecting and rearranging other variables.

The Input File Name Structure field may consist of up to 75 characters (total 
number of characters the variables expands to). An input filename should 
contain alphanumeric characters (but not spaces or \ /:*?"<>|), plus (where 
required) the variable page number, separation identifier, composite identifier, 
section, page type information, and date variables. 

Literals are allowed in the Input File Name Structure.

A number of wild card characters may be specified that may be different for 
every incoming file but must always be in the same position. A wild card is repre-
sented by a question mark when defining the structure on this screen. 

If the wild card feature is being used, a registry value may be set to check for 
conflicts in case an incoming filename is applicable to two activated editions. If 
a conflict is found, the file is routed to the Unplanned edition. If the wild card 
feature is not being used, set the registry entry to “no” to maximize performance.

■ Variables - a pull-down of the various Arkitex variables can be selected to 
redefine the Input File Name Structure. Variables include:

� Page number [%P]

� Publication full name [%u]

� Publication short name [%U]

� Edition full name [%e]

� Edition short name [%E]

� Section full name [%s]

� Section short name [%S]
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� Color ID [%C]

� Publication date [%0d]

� Double burn ID [%0V]

� Variation ID [%1V]

■ For double burn select the Double burn ID (%0V) variable from the drop 
down list.

NOTE: If the color identified is not supplied, the color id is appended to the 
separation file names.

� Format of the Input Variable Structure

For example when the EXPRESS publication is selected, the output filename 
structure is %u, but the internal name structure stored in the PMD is actually 
%(/_/7+)u (EXPRESS is 7 characters in length). Therefore, if the actual publi-
cation name length is the same as the formatted publication name length, only 
%u will be displayed.

When the STAR publication is selected, Publication Builder will show 
%(/_/7+)u. Publication Builder must maintain this formatting because it may 
have previously been done by the operator on purpose.

If you need to change this, try one of these alternative solutions:

■ After STAR pulication is selected, change the formatting from: %(/_/7+)u 
to %(/_/4+)u.

■ Change the Output File Name Structure from: %u_%1P.%C  to 
%U_%1P.%C.

This will make the Output File Name use the short publication name. Then 
make all of the short publication names the same length.

� Number of digits for %P

Choose the radio button for the number of digits for the page number.

NOTE: The page number must be a fixed number of digits.
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� Specify %C for composite

All composite pages for a single edition must include: a) an edition identifier 
within each incoming filename; and b) the page number, both in the same 
character positions. If this edition is to receive composite page input only, no 
color identification needs to be present within the incoming filename. 

If the edition is to receive a combination of composite and separated input, and 
the color identification of the separated input is at the end of the filename as an 
extension, e.g., PARIS001.K (for the black layer), no color identification needs 
to be present within the composite incoming filenames. 

NOTE: If the color identifier for separated input is in the middle of its filenames 
e.g. PARISK001 — then composite filenames for this edition must include a 
dummy color identifier in the same position, e.g., PARIS_002 (do not use spaces 
or \ /:*?"<>|). The dummy identifier must match in length the number of 
alphanumeric characters used by the separation identifier.

The separation identifier may be up to 16 (consecutive) alphanumeric charac-
ters in length.

All incoming files must include a separation id of the same length for a particular 
edition.

� Sheet Name Structure

The term Sheet Name Structure is used to identify the collation of these imposed 
pages/separations and page furniture.

By default, the Sheet Name Structure is %1P if no sections are defined and 
%S%1P if sections have been defined (page number of lowest page on the 
sheet).

The Sheet Name Structure will be displayed under each page icon in Arkitex 
Client to ensure that each page or combination of pages can be correctly 
identified.

For Previously paired, the default display is %1:1P - %1:2P.

NOTE: As sections and page numbers are added to the Input File Name Structure, 
the section and page number variables are automatically added to the Sheet 
Name Structure.
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Variables: Below the Sheet Name Structure field is a Variables pull-down 
menu to add variables to the Sheet Name Structure. For example, to configure 
an edition to display the left and right page numbers in the Sheet Name after an 
edition has been imposed, change the variable from %1p to %1:1p. Variables 
include:

■ Lower imposition page name [%1p]

■ Higher imposition page name [%2p]

■ Lower even imposition page name [%3p]

■ Higher even imposition page name [%4p]

■ Lower odd imposition page name [%5p]

■ Higher odd imposition page name [%6p]

■ Page name for row 1, column 1 [%1:1p]

■ Sheet Number [%0P]

■ Lower imposition page name [%1P]

■ Higher imposition page name [%2P]

■ Lower even imposition page name [%3P]

■ Higher even imposition page name [%4P]

■ Lower odd imposition page name [%5P]

■ Higher odd imposition page name [%6P]

■ Page number for row 1, column 1 [%1:1P]

■ Publication full name [%u]

■ Publication short name [%U]

■ Edition full name [%e]

■ Edition short name [%E]

■ Section full name [%s]
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■ Section short name [%S]

■ Variation ID [%1V]

� Output File Name Structure

By default the Output File Name Structure will match the Input File Name 
Structure. 

However, the Output File Name Structure is customized, select the Output File 
Name Structure check box. This will, by default, apply to all pages in this edition 
— which will appear in the Engine messages and in the Arkitex GRAFIX rip 
(‘single if’) log information as the edition goes through production. The output 
name structure may consist of up to 35 alphanumeric characters (but not spaces 
or \ /:*?"<>|), and the page number may be up to 3 digits (#). The separation 
identifier may be up to 5 digits ($).

In the Output File Name Structure field, add additional variables from the 
Variable pull-down menu as previously described for the Sheet Name Structure. 
Variables include:

■ Lower imposition page ID [%1n]

■ Higher imposition page ID [%2n]

■ Lower even imposition page ID [%3n]

■ Higher even imposition page ID [%4n]

■ Lower odd imposition page ID [%5n]

■ Higher odd imposition page ID [%6n]

■ Page ID for row 1, column 1 [%1:1n]

■ Sheet name [%0p]

■ Lower imposition page name [%1p]

■ Higher imposition page name [%2p]

■ Lower even imposition page name [%3p]

■ Higher even imposition page name [%4p]

■ Lower odd imposition page name [%5p]
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■ Higher odd imposition page name [%6p]

■ Page name for row 1, column 1 [%1:1p]

■ Lower imposition page number [%1P]

■ Higher imposition page number [%2P]

■ Lower even imposition page number [%3P]

■ Higher even imposition page number [%4P]

■ Lower odd imposition page number [%5P]

■ Higher odd imposition page number [%6P]

■ Page number for row 1, column 1 [%1:1P]

■ Lower imposition page extra info [%1X]

■ Higher imposition page extra info [%2X]

■ Lower even imposition page extra info [%3X]

■ Higher even imposition page extra info [%4X]

■ Lower odd imposition page extra info [%5X]

■ Higher odd imposition page extra info [%6X]

■ Page extra info for row 1, column 1 [%1:1X]

■ Extra information #1 (same as %1x) [%x]

■ Extra information #1 (same as %x) [%1x]

■ Extra information #2 [%2x]

■ Extra information #2 [%3x]

■ Extra information #2 [%4x]

■ Publication full name [%u]

■ Publication short name [%U]
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■ Edition full name [%e]

■ Edition short name [%E]

■ Zone full name [%z]

■ Zone short name [%Z]

■ Section full name [%s]

■ Section short name [%S]

■ Event sequence [%q]

■ Color name [%c]

■ Color ID [%C]

■ Publication date [%0d]

■ Variation ID [%1V]

■ Lower imposition page original input filename [%1F]

■ Higher imposition page original input filename [%2F]

■ Lower even imposition page original input filename[%3F]

■ Higher even imposition page original input filename [%4F]

■ Lower odd imposition page original input filename [%5F]

■ Higher odd imposition page original input filename [%6F]

■ Page original input filename for row 1, column [%1:1F] The value depends 
on the number of rows/columns of a page on a sheet (1, 2, or 4).

NOTE: For Imposed publications, the Output File Name is required.
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Related topics: • “Preview and Change” on page 175

Page Counts

The Page Counts tab allows you to set the page count per edition/section/zone. 
The page counts dialog box can appear differently regarding page numbering. 
This depends on whether or not sections have been defined for that publication.

� When sections are not defined

■ Number of pages - In a 4 up or 8 up, up to 998 pages (or 256 sheets) may be 
tracked within a single publication. On a 2up, 512 pages are possible. 

■ Starting at page - The Starting at page field enables this edition to be config-
ured to commence page numbering from a page number greater than 1.

� When sections are defined

■ Section Page Numbering - Select either Start at 1, if each section is to begin 
page numbering at 1, or Continuous, if the sections are to be numbered 
consecutively. Click the Continuous button in the Page Numbering box to 
view.

NOTE: An edition may have up to 20 sections.
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� AutoUpdate

If the AutoUpdate box is checked, and the number of sections is increased from, 
for example, 1 to 3, Publication Builder automatically distributes the remaining 
pages equally within the sections.

� Number of pages

The number of pages in that edition.

� Imposed by

The Imposed by field appears in the dialog if the publication is imposed. Select 
from the Imposed by pull-down the type of imposition.

■ Edition - All sections are contained within one ‘book’. The first page of the 
first section is paired with the last page of the last section.

� The number of sheets is set on the Impose Sheet screen.

■ Section - Perfect Bound - Each section is a separate ‘book’. For example, the 
first page of each section is paired with the last page of that same section.

The number of sheets is set on this screen and cannot be changed on the 
Imposed Sheets screen.
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■ Section - Saddle Stitch - Each section is a separate ‘book’ with each section 
inserted into the middle of the previous section.

� Page numbering is continuous. The first page is paired with the last page 
of the first section.The page numbers are then split so that the last page 
number of the first section is the highest page number in the edition. This 
page number splitting takes place for every section except for the last 
section, which is in the middle of the edition. The last section has no page 
number split.

� The numbered sheets is set on this screen and cannot be changed on the 
imposed Sheets screen.

■ Advanced Page Mapping - Allows configuring complex edition plans easily. 
Examples of these complex editions are Collect press runs where a small 
number of pages are folded together to create larger printed products.
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� Number of Sheets

The Number of Sheets field appears in the dialog, if the publication is either 
imposed by Perfect Bound or by Saddle Stitch. The number of sheets per 
publication gets calculated by Publication Builder. The ability to override the 
calculation is available as long as the number of sheets is divisible by 2.

NOTE: The default calculation rules are as follows: 2up is assumed up to 512 
pages; 4up is assumed if there are more than 512 pages.

� Section

■ Pages - The number of pages in that section.

■ Range - To number a section from pages 13 to 24 rather than 1 to 12, click on 
the combo box under Range. Publication Builder gives two more ‘logical’ 
page number choices for the start of a section. To choose any other page 
number for the start of a section, choose Custom to clear the box to enter a 
value; or simply highlight the existing value, and key the new one in its place.

■ Sheets - The Sheets field appears in the dialog if the publication is imposed. 
The number of sheets per section gets calculated by Publication Builder. The 
ability to override the calculation is available as long as the number of sheets 
and pages is divisible by 2.

Advanced Page Mapping

Using Advanced Page Mapping requires a general understanding of the 
following:

■ Number of printed books.

■ Number of physical pages.

■ Logical sections.

■ Page numbering of logical section pages.

■ Printed book pages.

■ Assignment of logical pages to physical pages.

■ Logical sections can cover non-continuous pages.
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■ Printed books can contain one or more logical sections.

■ Logical sections can span books.

� Terms

The following terms relate to this feature:

■ Book - A Book is a set of pages printed together on the press. Pages are 
considered as printing together when they fold on the same former board 
(the first fold on the press). Many individual Books may then fold together on 
the jaw folder (the second fold on the press) creating a larger printed 
product. When defining the number of books being printed in a Collect press 
run, the two plates around the cylinder (the High and Low plates) are each 
considered a different book.

■ Collect - A Collect Press Run is a run in which two different plates are 
mounted around a plate cylinder. These plates are often identified as High 
and Low. For the purposes of defining the number of books in an edition, 
High and Low are considered different books. Each single revolution of the 
plate cylinder results in a single copy of the paper.

■ Physical Pages - Physical Pages describe an actual page in the newspaper 
and the page’s position in the book. Physical Page numbers start at page 1 
and continue up to the total number of pages printed. Taking a 32-page 
edition printed as two 16-page books, the first page of the second book is 
physically page 17.

■ Section Character ID - A Section Character ID is a set (zero, one or more) of 
characters in the file name that identify a particular page as being part of a 
Logical Section. Section Character ID’s are only required when page numbers 
in two or more Logical Sections are the same (i.e., page 1 appears in more 
than one logical section).

■ Imposition - In the Advanced Page Mapping screen, all imposing of pages is 
within the book. The first page of a book always pairs up with the last page of 
the book.

The Advanced Page Mapping screen opens with Total Pages and Total Sheets 
filled in with the information from the previous screen and defaults to 1 book. 
The Page Mapping area already has one row for each section in the edition.

Related topics: • “Selecting Multiple Children” on page 44
• “When Selected Children Editions Differ” on page 46
• “Entering Publication Information when Children Differ” on page 48
• “Entering Information when Children are the Same” on page 49
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• “Blanked User Interface Control when Children Differ” on page 49
• “Page Colors Screen Behavior when Children Differ” on page 51
• “Imposition Screen Behavior when Children Differ” on page 52
• “Tree Structure Preview” on page 53
• “View Group Screen” on page 54
• “Other Screens” on page 55
• “Special Situations” on page 55
• “Advanced Page Mapping” on page 75

Examples The following examples demonstrate the functionality of Advanced Page 
Mapping.

Related topics: • “Example A” on page 77
• “Example B” on page 84
• “Example C” on page 86

Example A

A 48-page edition consisting of five logical sections and run on the press as two 
24-page books. These books then fold into one larger 48-page book.

The page numbering of the logical sections is: 

■ News: 4 pages numbered 1 to 4.

■ Local: 10 pages numbered 1 to 10.

■ Business: 12 pages numbered 1 to 12.
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■ Sports: 12 pages numbered 1 to 12.

■ Life: 10 pages numbered 1 to 10.

NOTE: Any of the sections can have page numbering starting with page numbers 
other than 1. Sports may be numbered 27 to 38, or another number.

The Sections appearing in this screen are known because of settings made earlier 
in Publication Builder.

� Setup

1 Enter the number of pages (48), the number of sheets (12), and the number 
of pages per section, and then click Map Pages.

NOTE: The number of pages and sheets may be skipped here and entered on the 
Advanced Page Mapping screen. Also, any changes to the number of pages per 
section made in the Advanced Page Mapping screen will automatically be 
reflected in the Page Counts screen.

The Advanced Page Mapping screen displays the following options:

■ Main:

� Total Pages - The number of pages in the edition.

� TotalSheets - The number of sheets in the edition.
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� Total Books - The number of Books being printed. These Books may 
include pages from one or more sections and may fold together to create 
a larger book. For a Collect press run, the High and Low plates are consid-
ered to be two books.

NOTE: For a Collect press run, the High and Low plates are considered to be 
two books.

■ Books - Information regarding the Books being printed.

� Book Name - The name of the Book.

� Pages - The number of physical pages in each Book.

� Sheets - The number of sheets in each Book.

� Wrap - A book that is folded around the outside of another book. The 
pages are split in half with half of the pages appearing before the books 
being wrapped around, and the remaining half after the wrapped books.

Book 1 - Example A

■ Page Mapping - Information that defines how pages are placed in the edition 
appears in the Page Mapping area. Each row defines a set of pages from a 
logical section and their placement into a book, how many pages from the 
section are being placed, the page numbers being placed, and the physical 
pages where the logical pages are placed.

� Section - A logical section is a group of pages with a similar topic such as 
“news” or “business”. Logical sections may or may not have a section 
character ID in the file name, and the page numbering of the logical 
section may start at 1 or at any other number. 

� Pages in Section - The number of pages in each logical section. This 
information is entered only one time per logical section.
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� Pages to Place - The number of pages of the logical section being 
positioned by this row in the Page Mapping list.

� Page Numbering - The actual page numbers for the pages in this logical 
section. This becomes the page number in the expected file name. The 
page numbers for each row in the Page Mapping list can start with 1 or 
with any other number. The only restriction is that the page numbers in a 
single row must be sequential.

� Physical Position - The physical page where the pages appear. This 
allows the user to position the pages starting anywhere in any of the 
books. Remember that the first page in Book 1 is physical page 1, and the 
physical page numbers increase to the last page in the last book.

■ Help - Clicking Help launches context-sensitive help.

■ Cancel - Clicking Cancel cancels the configured settings.

■ OK - Clicking OK accepts the configured settings.

NOTE: The initial flow of pages into books assumes that page 1 of the first logical 
section appears on page one of Book 1 and that all logical sections flow in the 
planned order. At any point during configuration, you may change the number 
of pages for a given section into a book, or the page numbering.

After the number of books is entered, colors representing each book appear 
along with the book number. The colors assist in identifying which pages in the 
Page Mapping box appear in which book.
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2 Enter 2 in the Total Books counter. You can have up to 10 books configured.

As soon as the number of books is entered, Publication Builder will automati-
cally update the pages through the books starting with page 1 of the first logical 
section appearing on the first page in Book 1.

NOTE: Once any number is changed in the Page Mapping box, Publication 
Builder will no longer automatically flow pages so that manual changes are not 
overridden. An example of a change is changing the page number of a section 
where, for example, Business may be numbered 15 to 24 in Example A.

You do not have to position all of the pages of a logical section in sequence. The 
Sports section may be split into two-page groupings with 6 Sports pages before 
Life, and 6 pages after.

Each time more than one row is required to complete the book (pages from more 
than one logical section are placed into a single book for example), all rows for 
that book will appear in order in the Page Mapping box unless a Wrap is 
identified. Then the pages for that book are split in half, and the rows for that 
book are separated.
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3 Now indicate that Book 1 is a wrap around Book 2 by checking the Wrap box.

4 The imposition for this publication is complete.

It will print as two 24 page books that, when folded together, result in one 
larger 48 page book.

The number of books increases to two with 24 pages in each book. By default, 
the number of pages and sheets per book are divided as evenly as possible across 
the books. The number of pages per book can be modified, but the total number 
of sheets must equal the number of sheets entered at the top of this screen.
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■ An example of a change is changing the page number of a section where, for 
example, Business may be numbered 15 to 24. You do not have to position all 
of the pages of a logical section in sequence. The Sports section may be split 
into two, 6-page groupings with 6 Sports pages before Life and 6 pages after.

■ A break automatically appears after the first 10 pages of Business, at which 
point all 24 pages in Book 1 are filled. The next page from Business (page 11) 
then appears at the start of Book 2.

The final setting indicates that Book 1 is wrapped around Book 2. The imposition 
for this publication is complete. It will print as two 24-page books that, when 
folded together, result in one larger 48-page book.
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Example B

A 40-page edition consisting of three books: two 16-page books and one 8-page 
book. The unique characteristic of this example is that the first book wraps 
around the other 2 books. This example resembles a publication being printed 
on press in three Books where Books 2 and 3 insert after printing.

The page numbering of the logical sections is:

■ Barcelona: 6 pages numbered 1 to 6.

■ Culture: 8 pages numbered 1 to 8.

■ Cinema: 8 pages numbered 1 to 8.

■ Classified: 6 pages numbered 1 to 6.

■ Ads: 12 pages numbered 1 to 12.
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� Setup

1 Change the number of books to 3.

Now the pages flow into three separate books. However, the number of pages 
per book is still not correct. At this point Cinema appears in both Book 1 and 
Book 2.
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2 Indicate that Book 1 wraps around books 2 and 3 by clicking the Wrap box 
for Book 1.

3 The imposition for this publication is complete.

You now see that Book 1 is split with 8 pages at the start and 8 pages at the 
end of the edition. The Ads section, although it appears at the end of the 
edition, prints on the last 4 pages of Book 3, and on the last 8 pages of Book 1.

Example C

A 168-page edition consisting of one 128-page Main logical section that wraps 
around a 40-page Liftout logical section that appears in the middle of the Main 
pages.
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The page numbering of the Main section is from 1 to 64, and then from 105 to 
168. The numbering of the Liftout section is 1 to 40.

This example prints on press in three Books that, when folded together, result in 
one large 168 page book. Each of the three books contains 56 printed pages.

Physically pages 1 to 56 are in the first book, pages 57 to 112 are in the second 
book, and 113 to 168 are in the third book.

� Setup

1 Select Map Pages.
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2 Enter 3 in the Total Books counter.

The 168 pages are divided evenly across the three books. Although these 
numbers are correct for this edition, you may change them. However, the total 
number of sheets must total the number of sheets entered at the top of this 
screen.

Since the 128 pages of Main will not entirely fit into Book 1, it automatically 
flows across Books 1, 2, and 3.

Next indicate that Book 1 is a wrap around Books 2 and 3.

When the Book 1 wrap check box is selected, Book 1 splits into two 28-page 
groupings, with one at the beginning of the edition, and one at the end.

The final 28 pages of Main are automatically renumbered to start with page 
number 101 (which follows the last page of Main in Book 3, which is page 100).
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3 Now check the Book 2 Wrap box so that Book 2 wraps around Book 3.

As soon as the wrap box is checked, Book 2 is split into two, 28-page group-
ings around Book 3, and that the page numbers for Main are once again 
automatically renumbered.

4 Change Book 3 to indicate that Main is split into two, 8-page groups with 8 
pages before and 8 pages after the Liftout section.

5 Change Pages to Place from 16 to 8 which, automatically adds another row 
in Book 3 to place the remaining eight pages.
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6 Change the Page Number for the Main pages that appear after the Liftout 
section.

7 The imposition for this publication is complete.

The Main pages appearing after Liftout (physically pages 105 to 112) are 
numbered starting with page 105 (and not 65, which would be the page 
number had it not been changed), and continue to page 168.

Edition Options

When editing a publication plan, the Edition Options tab will appear.

� Initial Status

Initial Status relates to what should happen when the edition instructions 
created (*.pmd file) are activated. The edition instructions defined in the *.pmd 
file are submitted to the Director and Pair database so that incoming pages from 
the edition are expected, and the Edition Name appears on Client. If the On 
button is checked, Director and Pair will accept incoming pages for output, and 
forward them to Producer in the normal manner.

■ If the Off button is checked, Director and Pair will accept incoming pages, but 
will not forward them to Producer for output until the edition is manually 
released. Client will flag a red traffic light against this edition to show it is ‘on 
hold’ (stopped). Click the green traffic light (if available) to switch the 
edition On in Client and allow pages to be forwarded to Producer.
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NOTE: Note that if the SoftProof option is configured, soft proofs of incoming 
files are always generated regardless of whether an edition has been stopped 
or not. Similarly, if the Ink Presets option is configured, ink calculations will 
be generated immediately when a file is input, regardless of whether an 
edition has been stopped or not.

� SoftProof

If the SoftProof option is configured, the user may not necessarily always want 
to run it. The Disable option may be selected to switch SoftProof off for a partic-
ular edition. In that case, the Soft Proof icon on the Client’s Tracking display will 
be grayed out when that edition is viewed.

If the SoftProof option is Enabled, select the color background to preview 
against the edition soft proofs.

� Colored Paper

NOTE: Colored Paper is available when SoftProof is Enabled.

To select a new color background (the default background color is white), check 
the Colored Paper box, and select one of the colors displayed. This feature is 
especially useful when previewing an edition that will be printed on colored 
stock.

The colors selectable from the Colored Paper display are configured within the 
Console > Configuration > Coloured Paper.

� Press Run Time

Check Press Run Time to assign the Press Run date and start time as part of 
either an edition or a zone. If the publication contains editions and zones, then 
Press Run dates and times are assigned only to the zones.

Press run date and time is assigned to either the edition or the zone, whichever 
is lowest on the publication tree. For example in a publication with multiple 
editions (and no zones), a Press Run date and time may be assigned to each 
edition. For a publication that has an edition with many zones, a Press Run date 
and time may be assigned to each zone.

NOTE: For publications that only include a single edition name, Press Run dates 
and times will be assigned to that edition.
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NOTE: If it is not defined, Client will not be able to sort editions based on press 
run date/time.

� Resubmitted files

What happens if a file is input more than once? Choose between:

■ Ignore - implies that no action is to be taken. Do not display receipt in 
Tracking, do not SoftProof, do not calculate Ink Presets, do not forward to 
Producer, do not overwrite the existing file in the 
Arkitex\DIrector\Complete folder.

■ Substitute and output all plates, i.e., substitute this page/separation for the 
one previously submitted, and re-output the full number of duplicate plate 
copies defined. If any of the first submission’s duplicate plate copies are still 
waiting in an Producer queue, they will be deleted.

■ Substitute and output pending plates, i.e., substitute this page/separation 
for the one previously submitted, but only output the quantity of duplicate 
plate copies that have not been output using the first file. Any of the first 
submission’s plate copies waiting in an Producer queue will again be deleted. 
This rule is particularly useful in conjunction with the Hold After feature, if 
typical input is composite and late blacks are expected.

■ Substitute and do not output plates, i.e., substitute this page/separation 
for the one previously submitted, but do not output duplicate plate copies 
that have not been output using the first file. Any of the first submission’s 
plate copies waiting in an Producer queue will again be deleted.

Inks Definition

A maximum of 7 inks may be tracked per page in a single edition, and within the 
Publication Builder module, only a maximum of 7 inks may be configured for a 
single edition.

The term ink is used to reflect the maximum number of colors (including blacks) 
used by the press for this edition. 

NOTE: Editions created externally without using the Publication Builder module 
may track more than seven colors per edition, but only seven colors per page.
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By default the first four colors are identified as Black, Cyan, Magenta, and 
Yellow with separation identifiers of K, C, M, and Y. The angle value is applied 
to the separation as it goes out to the Arkitex GRAFIXrip. These entries may be 
changed if required.

The separation identifier is used to enable the recognition of the various layers 
of pages being input as separations, or assigned within composite files.

Imagine the edition has a fifth color. The gray square on the fifth line indicates 
the current color that will be displayed on Client soft proof screens to represent 
the fifth color.

To configure which color will represent the fifth color within the edition, click on 
the gray square below the yellow colored square, and select Custom. The Color 
screen will then be displayed.

In the Color screen, choose to select one of the Basic colors displayed by clicking 
on the color and pressing the OK button. Alternatively, define custom colors to 
add to the standard color palette by selecting the Define Custom Color button.

There are four methods of selecting a custom color. Firstly, select the custom 
color by clicking on the color required in the rainbow color palette. Secondly, 
select the tint required in the tint box on the right-hand side. Thirdly, type in the 
color values in the Red, Green, and Blue boxes. The final method is to type in 
the color values required in the Hue, Sat, and Lum boxes (these represent Hue, 
Saturation, and Luminosity color values). 

NOTE: This is particularly important if the Soft Proof option is configured as it 
will control how the fifth color is displayed. If using Pantone color, enter the RGB 
values in the select color screen.

Once the custom color required is selected, it will be displayed in the Color Solid 
box. Now click on the Add to Custom Colors button, and this color will be added 
to the standard color section of the screen. If required, continue adding custom 
colors to the standard palette. Once the particular color required is selected from 
the standard colour palette, click on the OK button.

From the picture above, a new colored ink has been added. Repeat the above 
tasks until all the inks required are added.

In the Ink Name text entry box, enter the name of the fifth color, which may be 
up to 25 alphanumeric characters (but not spaces or \ /:*?"<>|). Spot color 
names should be entered exactly as they will be defined from the front-end so 
that the Engine recognizes them as expected layers, e.g., if the front-end is 
sending Pantone124, key this and not PANTONE124.
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NOTE: Red, Green, and Blue should not be used as ink names as these are 
definitions used to define color space in PostScript files.

When entry of the name begins, the separation identifier box will automatically 
fill out with the first character of the name. Change the separation identifier if 
required, taking care to ensure that the separation identifier matches in length 
that used in the incoming filenames, if submitting separations (and defined on 
Publication Builder’s Input and Output Name screen)

By default the angle for spot colors is defined as 45, but this can be changed if 
required.

Default Inks

The Default Inks UI can display with or without an Enable Resubmit column.

Related topics: • “Without Enable Resubmit” on page 94
• “With Enable Resubmit” on page 96

Without Enable Resubmit

On this screen the default colors to be expected are defined for incoming 1-color 
pages, 2-color pages, etc. The system automatically designates the inks for the 
pages using the order keyed in on the Inks Definition screen earlier. For 
example, 1-color pages are defined as black (K), 2 -color as black & cyan (K & C), 
etc.
:Arkitex Workflow Reference Guide



 

4 ARKITEX PUBLICATION BUILDER 95
If all the 2-color pages should be black and spot Green instead, click on the cyan 
square, and choose Green from the sub-menu (assuming that the Green ink has 
been pre-defined in the Inks Definition screen and is available now).

� Convert to CMYK

The Convert to CMYK option relates to a situation where one might be working 
on a 4-color edition, yet by mistake a CMYK page including spot colors is sent.

If the corresponding box to the 4-color page is not checked, any incoming spot 
colors will not be output. However by checking the corresponding box, any spot 
colors included in a 4-color page by mistake should be converted to CMYK. In 
this way the spot color data is not lost, but converted to CMYK equivalents.

� 2 & 3 color boxes with Spot Colors

The 2-color- and 3-color boxes need to be considered in two ways:

■ When the expected output is black and C, M, and/or Y.

� Imagine expecting K and C for the 2-color pages. By mistake K and C were 
sent plus a spot color (in this example identified as Green); by default, the 
spot would not normally be output. If enable the Convert to CMYK 
option is on, only two pieces of film will be output, but whatever 
percentage of spot color was K and C would appear on the appropriate 
piece of film.

■ When the expected output is black and spot color(s).

� The user is expecting K and spot 1 (in this example, identified as Green) 
for 2-color pages. By mistake a K and spot 1 (Green) and spot 2 (identified 
as Lilac) are sent. By default spot 2 would not normally be output. In this 
case, if enable the Convert to CMYK option is on for the 2-color page, it 
will still only output two pieces of film; but whatever percentage of the 
spot color was black will appear on the K film. In this instance, all that will 
output of the spot (green) will be whatever percentage of black is 
required when creating the spot color.

Related topics: • “Preview and Change” on page 175

CAUTION: Arkitex Pair will output a pair of pages the second time either on 
receipt of one page of the pair, or on receipt of both pages of a pair, 
depending on what was defined in System Setup.
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With Enable Resubmit

Selecting the Enable Resubmit options affect the display of the pages under the 
ResubmitPlanned tab.

There are two methods that can be used: Manual and Automatic.

■ The Manual process causes pages to display the Output symbol (O) for 
specific inks.

■ The Auto process places causes pages to display the Output symbol (O) and 
the Resubmit symbol (R).

� Manual process

1 Select the box(es) under Enable Resubmit for the number of inks in your 
publication. 

NOTE: You must choose at least one ink.

a Two check boxes will appear.

b The left box (First Output) will be checked, the right box (Resubmit 
Output) is empty.

NOTE: The first check box is called Output on first submission, the second 
check box is called Output on resubmission.
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� Example

The user is working in a 4-color edition and plans to output C, M, Y separations 
at the start of production, but to hold back the black page awaiting final text 
changes. In this example, check the Enable Resubmit option corresponding to 
the 4-color page.

Next disable the first tick box under the black 4-color icon, and enable the 
second check box under the black 4-color icon.

This indicates that when the page is sent the first time, only C, M, and Y will be 
output; when the page is resubmitted, only the black separation inside the EPS 
file will be imaged. If resubmitted again, Arkitex Director & Arkitex Pair will 
continue to apply the resubmission rule and output only the K separation.

NOTE: Remember that on this screen, the default situation for all color pages in 
this edition is being set. 

� Convert to CMYK

The Convert to CMYK option relates to a situation where one might be working 
on a 4-color edition, yet by mistake a CMYK page including spot colors is sent.

If the corresponding box to the 4-color page is not checked, any incoming spot 
colors will not be output. However by checking the corresponding box, any spot 
colors included in a 4-color page by mistake should be converted to CMYK. In 
this way the spot color data is not lost, but converted to CMYK equivalents.

� 2 & 3 color boxes with Spot Colors

The 2-color- and 3-color boxes need to be considered in two ways:

■ When the expected output is black and C, M, and/or Y.

� Imagine expecting K and C for the 2-color pages. By mistake K and C were 
sent plus a spot color (in this example identified as Green); by default, the 

CAUTION: This option only relates to imputting composite (EPS) files.

CAUTION: Arkitex Pair will output a pair of pages the second time either on 
receipt of one page of the pair, or on receipt of both pages of a pair, 
depending on what was defined in System Setup.
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spot would not normally be output. If enable the Convert to CMYK 
option is on, only two pieces of film will be output, but whatever 
percentage of spot color was K and C would appear on the appropriate 
piece of film.

■ When the expected output is black and spot color(s).

� The user is expecting K and spot 1 (in this example, identified as Green) 
for 2-color pages. By mistake a K and spot 1 (Green) and spot 2 (identified 
as Lilac) are sent. By default spot 2 would not normally be output. In this 
case, if enable the Convert to CMYK option is on for the 2-color page, it 
will still only output two pieces of film; but whatever percentage of the 
spot color was black will appear on the K film. In this instance, all that will 
output of the spot (green) will be whatever percentage of black is 
required when creating the spot color.

2 Click Next until you get to the ResubmitPlanned tab.

Related topics: • “ResubmitPlanned” on page 105

Page

The Page tab includes: Colors, Doubleburn (optional), Content, Variations 
(optional), ResubmitPlanned, and Page Options.

■ Colors

This screen displays each expected page so that the number of inks for each may 
be defined. By default all pages are displayed at first as 1-color, but if the 
majority of the pages are 4-color, it is easier to click on the 4 button in the bottom 
left-hand corner of the screen to change all pages to display as having 4 inks — 
and then to make changes to pages not conforming to this specification.

By right-clicking on the sheet/page icon, in addition to setting the number of 
inks, there is the added convenience of defining the layer file names and adding 
extra information to the page.

If the publication is imposed, the ability to Set # of inks for all pages on a sheet 
will become available. Setting the # of inks for all pages on the sheet, allows a 
global setting per plate.

If Sections have been defined, the screen will identify the sections unless the 
publication is imposed by Saddle Stitch.
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■ Manually Assign # of inks

The number of inks for a specific page may be changed in several ways:

� Selecting all pages:

1 Press Ctrl-A to select all pages.

2 Under Manually Assign # of inks, press the # of inks to be assigned to all 
pages.

3 Click on any Page icon.

NOTE: When ink is set for all pages, the assumption is a 2up template unless 
another template is assigned. The number of colors to a page on that 2up sheet 
is available for publications imposed by Edition or Perfect Bound.

� Selecting the page to assign # of inks:

1 Under Manually Assign # of inks, press the # of inks to be assigned to the 
page. The appropriate number attaches itself to the Arrow-cursor.

2 Click on the page number required, and the number of inks chosen (the # 
attached to the Arrow-cursor) is reflected on the page icon. 

3 Similarly, clicking on the IgnorePage X icon allows removal of a page. The X 
option enables ‘removal’ of a page if it is expected via a different route, and it 
is not to be tracked.

� Selective pages:

1 Using the cursor, lasso the applicable pages.

2 Under Manually Assign # of inks, press the # of inks to be assigned to all 
pages. The appropriate number attaches itself to the Arrow-cursor

3 Click, and the number of inks chosen (the # attached to the Arrow-cursor) is 
reflected on the page icon. 

� Selecting the # of inks to be assigned to a page:

1 Right-click on a page icon, and a sub-menu appears.
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2 Select Colors and X-7 appears. (If only 4 inks for this edition are defined, the 
options will only be X-4.)

3 Select the appropriate # of inks, ‘X’, or custom....

4 By selecting custom..., a Custom Colors dialog appears.

5 Select the Number of Colors to appear on that page, along with the color of 
the Ink, by selecting a color in each ink’s pull-down.

NOTE: If imposed, all pages on the sheet will be affected by the custom color 
specification.

� Selecting page ranges

1 Press the Shift key on the first and last page icons of the page range.

2 Deselect a page by selecting the unwanted page and pressing on the Ctrl key.

3 Under Manually Assign # of inks, press the # of inks to be assigned to all 
pages. The appropriate number attaches itself to the Arrow-cursor.

4 Click, and the number of inks chosen (the # attached to the Arrow-cursor) is 
reflected on the page icon. 

� Page Input Name

1 Right-click on a page icon, and a sub-menu appears.
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2 Select Page Input Name.

3 In the Change Existing Name Here box, type in the new name. The new 
name also appears in the Composite Name box.

4 Click the Apply to Separations button, which will copy the new name 
throughout the layer boxes. Do this regardless of whether the file is input as 
a composite or as separations. 

� Page Extra Info...

1 Right-click on a page icon, and a sub-menu appears.

2 Select Page Extra Info....

3 The Page Extra Info dialog box displays:

4 Extra text info fields will appear for every color defined, and for the 
composite. Information will be added per page as opposed to per sheet.

5 Enter the desired information in each field.

6 Click OK to accept the changes.
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Doubleburn

This screen identifies which pages are to be doubleburned: the merging of two 
bitmaps into a single bitmap. Double burn must be activated under Naming > 
Input File Name Structure > Variables > Double burn ID (%0V). An extra tab 
will appear next to Colors called Doubleburn.

Pages can be assigned the following Double Burn Types:

■ Monochrome/Monochrome

■ Monochrome/Color

■ Color/Monochrome

■ Color/Color

The type of Double burn for a specific page may be changed in several ways:

� Selecting all pages

1 Press Ctrl-A to select all pages.

2 Under Assign Double Burn Type, press the type to be assigned to all pages.
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3 Click on any Page icon.

� Selecting a page to assign the double burn

1 Under Assign Double Burn Type, press the type to be assigned to the page. 
The appropriate icon attaches itself to the Arrow-cursor.

2 Click on the page number required, and the double burn type (the icon 
attached to the Arrow-cursor) is reflected on the page icon. 

� Selective pages

1 Using the cursor, lasso the applicable pages.

2 Under Assign Double Burn Type, press the type to be assigned to the page. 
The appropriate icon attaches itself to the Arrow-cursor.

3 Click on the page number required, and the double burn type (the icon 
attached to the Arrow-cursor) is reflected on the page icon. 

4 Click on the page number required, and the double burn type (the icon 
attached to the Arrow-cursor) is reflected on the page icon. 

� Selecting page ranges

1 Press the Shift key on the first and last page icons of the page range.

2 De-select a page by selecting the unwanted page and pressing on the Ctrl key.

3 Under Assign Double Burn Type, press the type to be assigned to the page. 
The appropriate icon attaches itself to the Arrow-cursor.

4 Click on the page number required, and the double burn type (the icon 
attached to the Arrow-cursor) is reflected on the page icon. 

5 Click on the page number required, and the double burn type (the icon 
attached to the Arrow-cursor) is reflected on the page icon.

� Custom...

1 Select Custom....

2 The Custom Double Burn dialog box displays.
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3 For each layer to have a double burn, check the box  next to that layer.

4 Click OK to accept the changes.

Content

Page Content can be assigned to individual pages and layers comprised of three 
content descriptions. These are:

■ Editorial - Approve Editorial.

■ Advertising - Approve Advertising.

■ Classified - Approve Ads.
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A page/layer can have from zero to all three contents assigned to it. These will 
be used for: (1) Filtered views, allowing the user to view pages based on the 
content of those pages; (2) Multiple page approvals, based on whether the 
page has Advertising, Editorial, or both.

� Content

1 Assign page contents to just the black layer; only the color layers (not black), 
or to all layers according to the check box selected pertaining to the page 
content desired by checking on the corresponding check boxes.

NOTE: All three types of page content (Editorial, Advertising, and 
Classified) can be selected before proceeding to step 2.

2 Once the Content box(es) have been checked, select the pages to be Content 
assigned.

Editorial Content will place a black E when Editorial content is assigned to 
a black layer, and a red E when assigned to the color layers. 

Advertising Content will place a black A when Editorial content is assigned 
to a black layer, and a red A when assigned to the color layers.

Classified Content will place a black C when Editorial content is assigned to 
a black layer, and a red C when assigned to the color layers.

NOTE: Content for a specific page may be applied in several ways: (1) Selecting 
all pages: Press Ctrl-A to select all pages; (2) Selecting an individual page; and 
(3) Selective pages: using the cursor, lasso the applicable pages.

ResubmitPlanned

ResubmitPlanned allows planned resubmissions for selective pages rather than 
for an edition. Default Inks is for the entire edition, and ResubmitPlanned is 
for selective pages.

Whatever is set under this tab overrides settings set under Default Inks. To 
activate the ResubmitPlanned tab, you must first select an option other than 
Ignore under Edition Options.

� Setting Edition Options

1 Go to the Edition Options tab.
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2 In Action for resubmitted files, select one of the radio buttons other than 
Ignore:

� Substitute and output all plates, i.e., substitute this page/separation for 
the one previously submitted, and re-output the full number of duplicate 
plate copies defined. If any of the first submission’s duplicate plate copies 
are still waiting in an Producer queue, they will be deleted.

� Substitute and output pending plates, i.e., substitute this page/separa-
tion for the one previously submitted, but only output the quantity of 
duplicate plate copies that have not been output using the first file. Any of 
the first submission’s plate copies waiting in an Producer queue will again 
be deleted. This rule is particularly useful in conjunction with the Hold 
After feature, if typical input is composite and late blacks are expected.

� Substitute and do not output plates, i.e., substitute this page/separa-
tion for the one previously submitted, but do not output duplicate plate 
copies that have not been output using the first file. Any of the first 
submission’s plate copies waiting in an Producer queue will again be 
deleted.

3 Click Next to reach ResubmitPlanned tab.

� Manual process

1 Select the box(es) under Enable Resubmit for the number of inks in your 
publication. 

NOTE: You must choose at least one ink.
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a Two check boxes will appear.

b The left box (First Output) will be checked, the right box (Resubmit 
Output) is empty.

NOTE: The first check box is called Output on first submission, the second 
check box is called Output on resubmission.

2 Click Next until you get to the ResubmitPlanned tab.

NOTE: 
1. This tab will only appear if any option other than Ignore was selected under 
the Edition Options tab.

2. Checking the Enable Resubmit check box in Default Inks preselects that 
layer as a resubmit layer, and an O (output) will display in each page that has 
that ink(s).
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■ When O appears on a page, it means a first output hold does not happen.

3 The second check box is called Output on resubmission .

4 Click on a page, and a red R (resubmit) will appear indicating a resubmit.

■ When an R appears on a page, it means use a manual setting.

■ Both an O and R can appear on a page.

NOTE: Unchecking the right box in the layer, and then clicking on the plate, will 
undo the resubmit.
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� Auto process

Under Default Inks, when the right empty box is checked (for the layer chosen 
for resubmission) automatically selects that layer for resubmission for all plates 
under ResubmitPlanned.

1 Check the Enable Resubmit check box:

a Two check boxes will appear in the layer. 

b The left box (First Output) will be checked. The right box (Resubmit 
Output) is empty.

c Check the Resubmit Output check box in the layer.

2 Click Next to reach the ResubmitPlanned tab.
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NOTE: This tab will only appear if any option other than Ignore was selected 
under the Edition Options tab.

� ResubmitPlanned shortcut menu

The ResubmitPlanned shortcut menu is used to set the resubmission rules for 
individual pages of an edition. Options include: Late Black, Late Color, Output, 
Resubmit, Output & Resubmit, Reset to edition default, and Reset To 
Output all.

■ Late Black - When this option is selected, color layers will be marked by O’s; 
the black layer is marked with an R. Late Black means no output on the black 
layer with output on colors.

■ Late Color - When this option is selected, the black layer will be marked by 
an O; color layers are marked with R’s. Late Color means no output on colors 
with output on black.
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■ Output - Allows selection of Black, Cyan, Magenta, or Yellow for output on 
the edition page.

■ Resubmit - Allows selection of Black, Cyan, Magenta, or Yellow for resub-
mission on the edition page.

■ Output & Resubmit - Allows selection of Black, Cyan, Magenta, or Yellow for 
both output and resubmission on the edition page.

■ Reset to edition default - The edition pages are reset so the inks designated 
under Default Inks will be used.

Color layers will be output.

The Black layer will be output.
:Arkitex Workflow Reference Guide



112 RESUBMITPLANNED
■ Reset To Output all - Resets the edition pages so all colors will be output.

� Selecting multiple pages

1 To select more than one page to apply a resubmit rule:

a Hold down the Shift key and left click on the first page and click on the 
last page in the group.

b Hold down the Control key and left click on individual pages.

2 Right-click to display the shortcut menu.
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Variations

A variation is a planned change to a page (or layer). Each variation has a 
different expected file named and they appear in Client as separate pages within 
an edition or zone.

Page variations may appear in the same Edition (pages with A and B variations 
sometimes called an A/B Split), or they may appear in different Editions (or 
Zones)

There may be questions such as how to choose variations as opposed to 
changing pages.

First, a customer has few zones and few zoned pages and does not care about 
tracking zones separately in Arkitex Client. This customer may only have two 
zones, and they only have three pages that change in the second zone. In this 
case, they can plan a single edition and create page variations using the Varia-
tions planner in Publication Builder.

Second, a customer has a number of zones, and the zoning of pages is more 
complex. They have many zones, and pages may not all change from zone to 
zone. In this case, the customer will create a plan that has multiple editions or 
zones, and will design the changing pages using the Changing Pages tool that 
allows them to plan more complex zoning. Not only is the zoning planned using 
a different tool, but each zone appears as a different node in Client.

The use of Variations and the definition of Changing pages across multiple 
Editions/Zones cannot be used in the same Publication Builder plan. If the varia-
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tion ID character is used in any naming scheme in the plan, the Variations 
interface is used, and the Changing Pages interface is disabled.

� Number of Variations

The number of variations for a specific page may be changed in several ways:

1 Selecting all pages:

a Press Ctrl-A to select all pages.

b Under Number of Variations, press the # of variations to be assigned to 
all pages.

c Click on any Page icon.

2 Selecting the page to assign # of inks

a Under Number of Variations, press the # of variations to be assigned to 
the page. The appropriate number attaches itself to the Arrow-cursor.

b Click on the page number required, and the number of variations chosen 
(the # attached to the Arrow-cursor) is reflected on the page icon. 

3 Selective pages:

a Using the cursor, lasso the applicable pages.

b Under number of Variations, press the # of variations to be assigned to 
all pages. The appropriate number attaches itself to the Arrow-cursor.

c Click, and the number of variations chosen (the # attached to the Arrow-
cursor) is reflected on the page icon. 

4 Selecting page ranges:

a Press the Shift key on the first and last page icons of the page range.

b Deselect a page by selecting the unwanted page and pressing on the Ctrl 
key.
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c Under Number of Variations, press the # of variations to be assigned to 
all pages. The appropriate number attaches itself to the Arrow-cursor.

d Click, and the number of variations chosen (the # attached to the Arrow-
cursor) is reflected on the page icon.

Page Options

Sets Approval and HardProof attributes for a specified page. 

Change Pages identification becomes available on this screen, if variations are 
not defined as part of the Input file name structure, and multiple editions/
zones and the publication name are defined.

Approval This option allows you or a department to hold pages or separations to ensure 
these pages have been approved before they are output. Typically, this option is 
used for approving SoftProofs and Page Content

This option can be enabled or disabled by selecting the relevant radio buttons. If 
this option is enabled, the Arkitex Client Edition Icon and Sheet Icons linked to 
this edition will contain check boxes and circles, indicating approval is required 
before this edition can be released for production.

Select either Content, Page, or No. If Content is selected, check Advertising, 
Editorial or both.
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Hard Proof Arkitex Director, Foundation, and Pair allow two methods of hardcopy proofing 
of pages and sheets:

■ The first method, a standard feature of Director and Pair systems, allows 
users to print soft proof data directly from Client to standard network-based 
printers. This printed copy is not high-resolution.

■ The second method, known as HardCopy Proofing, automates the printing 
of high-resolution data from the server. In the case of TIFF input, the high-
resolution TIFF files are sent for proofing when all of the layers (one for 
monochrome, and multiple for color) of a plate have arrived. These files can 
be written directly to a proofing folder, or to a Producer queue that sends the 
files out for proofing.

The Hard Proof option allows a person or a department to use the actual high-
resolution data that will be used for imaging to create a hardcopy proof. This 
uses the TIFF, PS, or PDF file that will be used for imaging. In the case of PS and 
PDF, it uses the same RIPs for proofing as will be used for imaging.

■ To turn on automatic Hardcopy proofing, select either All or Custom by 
either mono and/or color layers. 

NOTE: Selecting Custom provides hardcopy proofing according to content 
selection (Editorial, Advertising, and Classified).
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Change Pages

The Publication Builder program includes a screen for defining which pages are 
shared or changing throughout publications with multiple editions or zones. 
This feature enables sharing and changing of files down to the separation level 
in the workflow.

NOTE: The plan must contain multiple editions or zones, have a publication name 
defined, and not have variations.

Click on Change Pages button to display the Change Pages screen.

� Change Pages Screen

The initial appearance of the Change Pages screen is determined by the 
Publication Builder Default Settings.

NOTE: This setting can be accessed and changed in the Default Settings dialog 
box, accessed by clicking the Default Settings button under the New Page 
Settings on the Misc tab. Shared implies that all new pages added to the plan 
will be automatically shared. Changing means that all new pages will be made 
changing.

NOTE: A new page is any page that was not present when the Change Pages 
window was opened the last time, and Okayed.
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� Columns

Each column represents a single edition, with the short name at the head of the 
column. If every edition/zone has press run times (and they do not have to be 
different times), then the columns are ordered by the press run time.

■ If some editions/zones have the same press run time, those are ordered 
among themselves according to their plan order. 

■ If at least one group does not have a press run time, then all groups (editions/
zones) are ordered by plan order.

Pages can only be shared from previous editions. In this example, pages in PM 
can only be shared with pages in AM. Pages in FF can be shared with pages in PM 
and with pages in AM.

When there is a change page, it will be shared with the edition page immediately 
to its left rather than sharing with a page from the first column.

For each edition/zone, each page and a color representation of its layers are 
displayed. 
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If a layer is shared, the corresponding rectangle will be white. If a page is 
ignored, it will show a red X in the box where colors would be. If the parent is 
ignored, the child will also be ignored. If colors of the parent are changed (in the 
Page Colors screen), the colors of the child will be updated to match. However, 
if you change colors of a shared page directly, that page will be automatically 
made a changing page, and the sharing link to the parent is lost.

The following screenshot shows a page icon representing an ignored parent 
page and its child.

� Tool Icons

The toolbar contains five sharing tools.

The first four tools are applied by simply clicking the target page.

■ Share from Other - This tool creates special shares. It requires two clicks. 
First select the child page, which highlights it. Then select the parent page, or 
the page to share from. If a decision is made not to share the child page 
selected, there are two options. Click the child page again to un-select it, and 
continue by selecting a different child page. Or, click Share from Other 
again to completely exit sharing mode. As was noted earlier, the parent page 
must be in a parent group – one to the left of the group containing the child.

Icon Name Function

Change Black Layer Changes the black layer only

Change Color Layers Changes the color layer only

Change All Layers Changes all layers at once

Share From Previous Shares from the previous parent page.

Share from Other Share from the previous parent page.
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The screenshot above shows the same setup as the one before it, only the 
page in FF has been specially shared with page 6 in AM. This information is 
displayed in the tool tip. Tool tips are shown for all pages, not only the special 
shares, and they stay visible for an extended period of time to give the user 
enough time to read them.

� Changing

If the page is changing, the single word Changing is displayed.

The above displays the state after the Change Color Layers operation has been 
applied to page FF-1, and Change Black Layer had been applied to page FF-2. 
The tool tip shown is for page FF-2.
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� Shared

If the page is shared with its default parent, the single word Shared is displayed.

� Special Share

If the page is a special share, the tool tip includes the following information: 
“Shared [Short Edition Name of parent page] [Short Zone Name of parent page 
(if plan includes zones)] [Short Section Name of parent page (if plan includes 
sections)] [Page Number of the parent page]”.

Special shares are shown with color boxes half-filled. The color behind the page 
number is changed to the color of the group that contains the parent page, and 
there is a red double-arrow between the page number and the color boxes. These 
pieces of information give a good at-a-glance picture about the number of 
special shares and where their parents are located. 

Just as normal shares do, special shares inherit the parent’s colors. Page FF-8 
used to be a color page, now it is monochrome. The change of colors for any 
shared page you create is not permanent. If the page is made changing, it will get 
its original colors back.

The color change becomes permanent after clicking the OK button. 

An important detail to know is that if there is already a page in the child page’s 
column that has the same parent page, that other page will be changed. This only 
happens when creating special shares. This works because page 6 became a 
changing page. This behavior is designed to prevent the user from accidentally 
linking two pages to the same parent, which is a highly unlikely scenario. Force 
the issue by sharing page 6 in FF with page 6 in AM using the Share from 
Previous tool. When OK is clicked, Change Pages will check every column for 
multiple pages shared with the same parent. If there are any, a warning will be 
displayed. 
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� When There Are Zones or Sections

The screenshot above shows a plan with both zones and sections.When a plan 
has zones, each column represents a zone. Here, each of the three editions we 
were looking at before has two zones – N (North) and S (South).

The column headers now show both the short edition name and the short zone 
name, separated by a dash. Also, when using zones, a drop-down list appears 
next to the toolbar.

The list contains All, meaning show all editions, and the long names of all 
editions in the plan. This list allows you to restrict the display of pages to a single 
edition and its zones. For example, selecting Evening (long name of the PM 
edition) from the list will hide all columns except PM-N and PM-S.

When a plan has sections, as above, the grid is divided into sections vertically. At 
the top of each section is a section header – a lightly colored horizontal bar 
showing the Long section name. If an edition or zone does not contain a given 
section, no pages will be shown for that section in that column. For example, PM-
N does not have the AA section. The user can hide sections by single clicking on 

the arrow  to the left of the bar, or on the bar itself.

To display that section again, click on the arrow or the bar again. When sections 
are used, background color of page numbers matches section color instead of 
edition color. However, when a page is a special share, page number 
background is still changed to the color of the parent edition. 
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Different users may have different preferences as to whether pages should be 
made shared or changing initially. Some may want to start with all pages shared, 
and then break shares. 

� Context-sensitive pop up menu

A way to make changes is the context-sensitive pop up menu. It is independent 
of the toolbar, i.e., it can be accessed and used while a sharing tool is in use. 

Right-click on a page; the page is highlighted so that it is clear exactly which row 
and column were right-clicked. If a blank cell is selected, it is not highlighted.

The Change Page and Share Page items have the same effect as the Change All 
Layers and Share from Previous buttons, respectively. But they provide a quick 
way to do these operations even if a different tool is selected on the toolbar. 
These two items are grayed out if right-clicking on an empty cell.

Change Row and Share Row operations change or share all pages in the 
selected row. If right-clicking on a row that does not have any pages, these two 
items will be grayed out.

Change Column and Share Column are column counterparts of the row 
operations.

Change All and Share All change or share the entire plan. These two items and 
the two column items will ask for confirmation before proceeding.

CAUTION: If making any significant structural changes to the plan, such as 
adding/removing groups; modifying the publication tree structure; 
defining press run times for all groups; removing press run time from one 
or more groups; or adding new pages to groups, please re-check the status 
of the designated “Changing Pages”, because these changes may have 
affected the shared and changing pages.
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� Saving Change Pages Configuration

Press OK to save the Change Pages configuration.

Priority

The default priority given to all pages in all editions is 50. Priority levels are 
custom selectable between 2 (low) and 127 (high). Use the buttons to scroll up 
or down through the numbers, or highlight the existing number and key in a new 
one to change the priority. Click the Top Priority button to select 127.

The priority defined here will be applied to all pages within this edition as they 
are forwarded to Arkitex Producer. Priorities set in Publication Builder will 
override the queue priority set on Arkitex Producer.

� Specify

Check Specify to assign another value.

CAUTION: After clicking OK, the pages will become old. Therefore, if 
changing the Publication Builder Default Setting New Page Settings to 
Changing and then going back to the Change Pages screen, the pages will 
still be shared. However, if more pages are added (two more to each 
edition), the last two pages in PM and FF will honor the New Page Settings 
and be Changing.
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Hot Time

If the Define Hot Time button is checked, you are able to define a specific time 
is defined during which this edition is regarded as in production.

An edition activated Before the hot time may be defined as Off. Alternatively 
you may wish to allow pages from this edition to proceed to output if they are 
input in advance of the hot time — in which case you are prompted to define a 
priority to apply to such pages. In this case, check the Specify radio button in the 
Before box, and define the priority required (probably fairly low so that they do 
not take priority over another edition’s pages outputting within their critical 
production cycle). 

During the Hot time, it can be specified that Top priority should be applied to 
this edition’s incoming pages — or check the Specify button to assign another 
value. 

The period After the hot time may be defined similarly to the Before period. The 
edition may be Off — or a high priority may be specified for pages arriving at 
that stage. The priority of a page/separation already in the Arkitex Producer 
queue will automatically be changed when the time passes from Before Time to 
Hot Time to After Time to match the priorities defined for these periods.

To define the start of the Hot Time, click on the time entry box to specify the 
hour. The 24-hour clock is used. By clicking on the buttons adjacent to this box, 
the time may be amended earlier or later as required. The time is altered in one 
hour and quarter-hour units. It is not possible to click within the time entry box 
to define the minutes of the hour, although the hour values may be defined in 
this way.
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The date on which the hot time is to begin may be Today, Tomorrow, or a 
Custom Day that may be selected by clicking on the appropriate radio button. 
To define a Custom Day, first select the day, month or year as required and 
either key in the new value, or click on the arrows to change the displayed value.

The date on which the hot time is to end may be Same Day, Next Day or a 
Custom Day.

Using Today and next day entries means that the *.pmd file may be activated 
once and used repeatedly without the need to be opened and edited to define a 
specific date. Care is necessary to ensure that the end time of the first production 
cycle next day does not conflict with the start time of the following production 
cycle. At the end of each production cycle, the Purge utility is used to reset the 
edition.

NOTE: When setting deadline time, do not set one to match the exact end of Hot 
Time if After Hot Time is set to off.

Copies In a CTP environment, it is normal to produce a number of duplicate plates for 
each separation to enable the high-volume print requirements to be met. 
Typically the same number of duplicate plates is required for every separation of 
an edition. Up to 99 duplicate plates may be defined.

� For All Inks

With the Standard button checked, key in the quantity of duplicate copies 
required against the text entry box marked For All Inks. The number will be 
reflected in the text entry boxes next to each specification of inks per page, and 
indicates the separation to be output.

If for example, 10 duplicate plates of all 1-color pages are required, key the 
required quantity in the text entry box adjacent to the single ink specification 
square.
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� Standard\Custom

It is also possible to specify a separate quantity of duplicate plates for one layer 
of a multi-layer page, e.g., for 2-color black and cyan pages, if three cyan plates 
and five black are desired, click on the Custom button to display a text entry box 
against each separation, allowing for adjustment of the quantity of duplicate 
plates.

Hold It is sometimes the case that a small number of duplicate plates is required to get 
the press running, while the remainder are held back. This facility is useful if late 
changes are expected.

There are three options:

■ No Hold 

■ Standard 

■ Custom

� No Hold

Output all duplicate plates one after the other.

� Standard

Using the same principle as the Default Number of Inks screen, with the 
Standard box checked, the number entered in the text entry box next to the 
words For All Inks reflects through all color page specifications in the first 
instance. 
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To hold after, for example, three copies of all 5-color pages, key the required 
quantity into the text entry box adjacent to the 5-color page specification 
squares.

� Custom

To hold back more (or less) of a particular separation, click on the Custom 
button to display a text entry box against each separation, and adjust the 
quantity as required.

In an example of incoming composite, 4-color pages, each file will be sent twice 
— once to enable the C, M, and Y separations to be output and a second time 
when the black is ready (late changes are expected).

Each time the composite file is input, it contains C, M, Y, and K layers. But it can 
be specified that the K separation be Held After 0, so that when the first file 
arrives only the C, M, and Y proceed to output. Then when the composite page 
arrives again with the changed text, the new file overwrites the old. The K 
separation is unheld (from the Tracking screen), and it is the new black that is 
output. (It is important in this example that the substitute and output pending 
plates rule be selected.)

If implemented on this screen, the user would be defining that all 4-color pages 
should have the K placed on hold after 0.

Related topics: • “Preview and Change” on page 175 to assign plate holds for specific pages in the 
edition tree.

Deadline A deadline time may be set that triggers a red flag in Tracking if all copies of the 
specified ink have not been completed by that time. It makes it easier to see that 
the completion target is not being met.

Pages/separations arriving after their deadline time has been reached are 
automatically assigned top priority, which has been configured under Deadline 
Time Priority. If a page/separation is already in a Producer queue when its 
deadline time is reached, its priority will automatically be raised to the Deadline 
Time Priority.

No deadline time need be set. But when the Standard button is checked, an 
alarm clock appears adjacent to the words For All Inks.

� Setup

1 To specify an earlier deadline time for all 4-color pages, click on the alarm 
clock next to the row containing four squares, and edit the time.
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2 After returning to the screen, the clock is colored green to indicate that 4-
color pages have a different deadline time.

� Custom

1 The Custom button allows setting different deadline times for different color 
layers of a page.

2 To set an earlier deadline for the spot orange layer of all 2-color pages than 
the black, click on the Custom button to display an alarm clock for every 
color layer.

3 Click on the orange square, and edit the time as required.

4 After returning to the screen, the clock is colored blue to indicate that orange 
layers of 2-color pages have a different deadline time to the black layer of 2-
color pages.

NOTE: Once a deadline time has been defined, it cannot be switched off in 
Tracking. However, in effect the deadline time may be made redundant by 
setting it to a time later than the end of the known production cycle.

NOTE: If a Hot Time has been specified for this edition, do not define a Deadline 
time to be exactly the same as the Hot Time end if After Hot Time is set to off.
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1 To set the appropriate Deadline or Custom Deadline Time, click on the icon.

2 Click OK button to close

Symbolizes a deadline time based on the color of the icon.
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Sheet Options This screen sets Approval and Hard Proof attributes for a specified sheet. By 
configuring Sheet Options, it implies any plate furniture is to be applied to that 
sheet.

NOTE: If the edition is not Imposed, the Sheet Options setup should be defined 
the same as the Page Options setup.

� Approval

The Approval option allows a person or a department to hold sheets or sheet 
separations to ensure that these sheets have been approved before they are 
output. 

This option can be enabled or disabled by selecting the Yes or No, respectively, 
radio buttons. If this option is enabled, the Arkitex Client Edition Icon and Sheet 
Icons linked to this edition will contain check boxes and circles, indicating 
approval is required before this edition can be released for production.

� HardProof

The HardProof option allows a person or a department to use the actual high-
resolution data that will be used for imaging to create a hardcopy proof. This 
uses the TIFF, PS, or PDF file that will be used for imaging, and in the case of PS 
and PDF, it uses the same RIPs for proofing as will be used for imaging.

Select either Enable or Disable.

Imposition The Imposition dialog box displays only when configuring an Imposed 
Publication.

The Imposition dialog box is used to:

■ Configure the amount of creep for each publication, and turn creep on or off. 

■ The ability to define a creep adjustment is restricted through a license on the 
server.

NOTE: Creep (also known as Shingling) occurs when a document containing a 
large number of pages is folded. The tendency is for the printed sheets in the 
middle of the book to protrude. The amount that each sheet protrudes depends 
on the thickness of the paper (known as Caliper), and the number of finished 
sheets.
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Creep

When the Adjust for Creep check box is selected, creep can be adjusted in MM, 
CM, or Inches as a positive value in increments of 0.001 from the center. An 
automatic adjustment is made, thus giving a uniform look for the margins for 
every sheet.

Select Template

Configure which Arkitex Plate Builder template/s *.pmt file should be used for 
this edition. The relevant *.pmt files should previously have been configured 
with the number of pages to be imposed, the orientation, and position of each 
page and piece of page furniture per sheet.

� Setup

1 To select the relevant *.pmt file/s for this edition click the Add button, and 
the Add Template File screen will appear.

2 The Add Template File screen will always default to the location of the 
Arkitex\Director\Config\Pef folder; this is where by default all Arkitex 
Plate Builder templates will be stored.

3 Select the relevant *.pmt file/s, and click Open.

NOTE: Multiple *.pmt files can be selected to apply to an edition; however, all 
*.pmt files must impose the same number of pages per sheet. Depending on the 
Imposition license purchased, a maximum of 8 pages can be imposed per sheet; 
the minimum number of pages per sheet is 1.

4 To remove an incorrectly selected *.pmt file/s, select the relevant file/s from 
the list, and then press the Remove or Remove All buttons.

5 Next click the Impose button.

CAUTION: An odd number of pages per sheet cannot be imposed.
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NOTE: The Number of Sheets entry field is only enabled if it is by edition, or no 
sections have been defined.

6 When the Impose Sheets screen is first displayed, it will initially display 
pages as:

7 within Sheet icons.

8 If the Alert Icon (shown above) and any pages within a Sheet Icon are 
displayed with the number 999 inside, a small cross (without an Output 
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Location listed or a *.pmt file assigned) indicates that this Sheet icon is 
waiting to be configured/imposed.

9 In this example *.pmt files that impose 2 pages per sheet have been loaded. 
This example represents a 48-page edition. By default, 24 is displayed in the 
Number of Sheets field.

Defining Separation Input

By default, while configuring all the sheets in the Impose Sheets screen, the 
Composite button has been selected displaying all the sheets and pages in 
Composite mode (as displayed in this new example of a mixed color edition).

To apply different page templates, or output to different Event Sequences per 
separation, you can view per sheet all the sheets and their pages via a Single-
color mode.

By clicking on the Black button, just those pairs for which black films or plates 
will be generated will be displayed.
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If Spot #1 were clicked, only those pages for which this spot color will be gener-
ated will be displayed, and so on.

Individual templates and event sequences can be applied to each separation 
using the same procedure as previously described for composite pages; 
however, always ensure the single-color mode is selected while applying these 
changes.

� Applying *.pmt files to the entire edition

1 To apply a single template for the entire edition, click on the Apply Template 
to all pull-down screen.

CAUTION: The separation specific configuration will only be displayed 
when in that particular single color mode. Separation specific 
configuration cannot be displayed in the Composite mode.
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2 Select the default *.pmt file you need to apply to all pages. In this example 
the 2Up.pmt file has been selected as the default.

3 In the example below, one *.pmt file has been assigned to all pages. Below is 
a close-up of the above image.

4

5 Per the example below, page 48 has been paired with page 1, the number of 
colors per page has been correctly assigned, and the *.pmt file name is 
displayed within each Sheet icon.

6 Depending on the layout of the template, a 2-page, Imposed Sheet Icon could 
appear as:
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Or:

7 The layout of the pages within the Sheet Icon will reflect the layout of the 
imposed pages.

8 If imposing 4 pages per Sheet, the Sheet Icons may appear as:

9 A sheet with 8 pages imposed could appear as:
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10 The page numbering and imposition would vary per edition according to the 
requirements of the press.

11 In this 48-page edition example, with each increase in the number of 
imposed pages the Number of Sheet field has reduced accordingly, from 24 
to 12, and from 12 to 6.

Applying an Event Sequence to the entire edition

All Sheet Icons (pages) need to follow a path through Arkitex Producer to a RIP. 
This path is configured as an Event Sequence.

This screen has the functionality to allow one Event Sequence to be configured 
for Mono (1-color) pages, and another for Color (2+ color) pages.

To assign the Event Sequence/s to output the entire edition, click on the Apply 
Output to all pull-down screen.

For Mono only editions, just set the Mono Event Sequence.

For Color only editions, just set the Color Event Sequence.
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Select the default Event Sequence/s needed to apply to all pages.

The 50 Pairing BW Film Event Sequence was selected for the Mono pages, and 
the 50 Pairing CLR Film Event Sequence for the color pages as the default Event 
Sequences. Here is a close-up of the image.
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Notice that 50 Pairing CLR Film has been added to all the 4-color Sheet icons.

The number of colors within Sheet Icons can be identified by the number of color 
blocks inside them.

Making changes to specific pages

The following changes can be made per separation or page (or Sheet Icon where 
specified):

■ “Page Style” on page 141

■ “Colors” on page 143

■ “Template per Sheet Icon” on page 145

■ “Event Sequence per Sheet Icon” on page 146

■ “Page Name” on page 147

■ “Application of 1/2 Web (Dinky) - where relevant” on page 149

■ “Application of 3/4 Web - where relevant” on page 152
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■ “To set a 1/4 dinky in the third column” on page 157

� Page Style

By default, all icons display pairs, showing that incoming pages will be placed 
side by side according to the parameters previously defined in Arkitex Plate 
Builder (including any gutters). Such pairs are Standard. To change the page 
style to Single or Double Pages, and Add/Remove Pages, position the mouse 
pointer on the sheet icon. Click with the right mouse button.

NOTE: It does not matter if one clicks on the top/bottom, left/right page. The 
changes made will apply to the pair/s.

Standard Pair

This relates to the pair as positioned by default shown above.

Single Pages

‘Single pages’ indicates that the incoming pages are to be retained as singles and 
not paired - single pages are placed in their appropriate left or right-hand 
positions on the film/plate, and all components for the complete pair are output 
in each case.

These are examples of a pair of single pages:
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Double Page Spreads

Double Page spreads indicate that only one file will be received, generating a 
double-page spread. 

NOTE: An incoming filename of a double-page spread must include the left-hand 
page number.

A double-page spread will look like this example:

Add/Remove Pages

Sometimes only one page of a pair should be output as there may already be the 
film or plate of the other page. Remove the one page, for example - meaning that 
the system will no longer be expecting to receive the left or top page. As soon as 
the right or bottom page arrives, the ‘pair’ will be output - with the right/bottom 
page in its correct position on the film/plate, and with any defined components 
for the pair in the correct position. Below are examples of a removed left hand 
page.
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and

The Add/Remove Page options provided work on a toggle basis. The first time 
they are clicked, the Sheet icon reflects a removal; the next, an addition.

� Colors

The number and specification of color layers expected for a particular pair of 
pages can be changed via this option.

There is a choice between 1 to 7colors. If working on a mainly 4-color edition, 
but one of the pairs is CMYK with one spot (i.e. 5-color), move the cursor to 5 
Colors and select 5. The icon changes to reflect 5 colors.
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At least one spot color must be defined previously in the Ink Definitions screen. 
The expected color will, by default, be the first spot color in the ink definitions 
list. Similarly, a 6-color page will assume that the two spot colors are the first two 
in the list previously defined.

If the 5th color in the example should be, for example, the second spot color 
defined, click the Number of Colors option again, and select Custom.

NOTE: When clicking within a page on a sheet, only that page is affected. When 
clicking on the sheet’s background, all pages on that sheet are affected.
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Click on the 5th color, and then select the color desired for the 5th color for this 
page from the pull-down menu.

� Template per Sheet Icon

The next possibility is to remove the default template applied previously, and 
apply a different template to this pair. The templates available for this edition 
are those previously defined in the Template field within the Imposition screen.
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� To apply the template

1 Select the relevant Sheet Icon. 

2 Right click with the mouse. 

3 Scroll to Template.

4 Select the relevant template to apply to that specific Sheet Icon.

5 The Sheet Icon will be updated accordingly to reflect the new layout of that 
template, and the updated template name will appear below the Sheet Icon.

NOTE: If the relevant template was not initially loaded into the template list 
before the Impose screen was entered, return to the Imposition screen by 
pressing OK (responding as required to any warning messages). In the 
Imposition screen, can add the missing template, and then return to the Impose 
screen by pressing the Impose button.

� Event Sequence per Sheet Icon

A different Event Sequence can be selected for a specific pair. 

� To apply a different Event Sequence 

1 Select the relevant Sheet Icon. 

2 Right click with the mouse.

3 scroll to Output.

4 Select the relevant Event Sequence to apply to that specific Sheet Icon.
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5 The Sheet will be updated accordingly to reflect the updated Event 
Sequence. Its name will appear below the Sheet Icon.

6 The list of Event Sequences will be displayed under Console > File > 
General > Event Sequences.

� Page Name

Earlier within Arkitex Publication Builder, within the Input and Output Name 
screen, the Input File Name Structure was assigned for all pages for this 
edition. Occasionally a page should be input that does not conform to this 
structure. By clicking on the Page Name options, a non-standard, incoming file 
name can be specified for either page of this pair.

In the example, page 35 was selected:
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� To update the Page Input File Name

1 Type the new name in the above field.

2 Press OK.

3 If the name for page 14 needed to be changed, click on Page Icon number 14 
within the Sheet Icon.
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� Application of 1/2 Web (Dinky) - where relevant

A 1/2 Web (also called a dinky or a 1/2 reel) is a roll that does not extend the full 
width of the press unit. When the number of pages, in the edition cannot be 
achieved by a full web sheet of pages, (because there cannot be an odd number 
of pages in an edition), a 1/2 web (or Dinky) is required, (typically used for 
inserts). The above illustration is an example of the press configuration for a 36-
page, broadsheet edition with a 1/2 Web width reel printing onto tinted paper. 

The fact that it is not the full width means it cannot print the maximum number 
of pages possible for the unit (2-pages or 4-pages across depending on the width 
of the press). In addition, it means that the page numbers within the edition 
need to be adjusted to compensate for the 1/2 Web.

Although each user and each country vary greatly in relation to printing 
standards, as an example, a panorama plate is referenced that will hold a total of 
8 pages: two pages on the left, two on the right, and when trimmed and folded 
will result in a total of 8 pages (since there are 4 pages on each side of the web).

A 1/2 Web (Dinky) is a roll that has only 2 tabloid pages. The result is 4 printed 
pages (2 pages on each side of the web).

If narrow plates are used, even though no pages should be printed on the right 
side of the web, a printing plate must be mounted on the right side of the printing 
cylinder.
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When imaging to a wide film or CTP device, the complete plate must be imaged 
for cylinders running a 1/2 Web, even though there are no pages.

Typically, it is when the number of pages in a publication is divided by 8 and 
does not equal a whole number, yet dividing that same number by 4 does equal 
a whole number, that a 1/2 Web (dinky) must be configured.

■ For example a 48-page edition, divided by 8 = 6 (a whole number) does not 
typically require a 1/2 Web (Dinky).

■ However, a 44-page edition, divided by 8 = 5.5 (a fraction), and divided by 
4 = 11 (a whole number) would typically require a 1/2 Web (Dinky).

� Configuring 1/2 Web (Dinkys)

In this example, a 44- page edition has been configured with Event Sequences 
and a template that imposes 4 pages per sheet.

In this image of the screen, 4 pages have automatically been set as blank pages 
by the Impose Sheet screen, and the Alert Icon is displayed, implying that the 
imposed needs more pagination.
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NOTE: The difference between a Blank Page in the Impose Sheets screen and an 
Ignore Page is that the Blank Page does not have a page number displayed within 
the Page Icon.

Once the location of where the 1/2 web (Dinky) needs to be applied (which will 
vary according to the press and the printing requirements of the edition), select 
the relevant Sheet Icon, and right click with the mouse, then select 1/2 Web 
(Dinky).
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In this example, a left 1/2 Web (Dinky) has been applied to the Sheet Icon 
containing pages 30, 43, 19, and 6.

The Alert Icon has been removed, and the Blank Page Icons have moved to the 
relevant positions in the edition.

To remove a 1/2 Web (Dinky), re-apply the 1/2 Web (Dinky) command to the 
same sheet icon again.

� Application of 3/4 Web - where relevant

The 3/4 Web follows the same principle as previously described for a 1/2 Web, 
except where the 1/2 Web adds 4 Blank Pages, the 3/4 Web adds 2 Blank Pages.
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Copying and Pasting page configurations

Having made changes to one page, some or all of the changes can be copied to 
other pages in this edition.

First, a simple change will be applied to the Sheet Icon for page 1 and 48 of a 48-
page, black & white edition that is using the default template 2up, and the 
default Mono Output Event Sequence CTP.

A close up of this screen is displayed that shows pages 1 and 48 are configured 
to use the 2up-head template and outputting to CTP2.
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� To copy the configuration of the sheet containing pages 1 and 48

1 Select that sheet icon using the Select command.

2 Once the page has been selected, the background to the sheet icon will 
change from gray to green.

3 To copy the entire configuration for this sheet, click Copy All.

4 To copy selected parts of this sheet’s configuration, click Custom Copy.
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The options are:

■ Colors - Copy all the available colors.

■ Resubmission - Copy the resubmission parameters.

■ Conversion - Copy the conversion parameters.

■ Page Style - Copy the page style.

■ Template - Copy the template applied to this sheet (pair of pages).

■ Output - Copy the Event Sequence selected for this pair.

■ Rotation - Copy the sheet’s rotation.

NOTE: All page rotation is applied via the Arkitex Plate Builder template and 
should be previously configured in the Arkitex Plate Builder module.

Choose a combination, or all of these parameters, by clicking in the boxes.

To apply these parameters to another page or pages, select:

■ Paste to all pages by clicking Paste All.

■ Paste to all odd numbered pages by clicking Paste odd.

■ Paste to all even numbered pages by clicking Paste even.
:Arkitex Workflow Reference Guide



156 PAGE OPTIONS
Or, paste these parameters to a specific page or pages by clicking Custom Paste, 
which will open the Custom Paste screen.

To paste previously copied parameters into sheets, in the Custom Paste screen, 
use the Select All > Unselect All > Select odd, and Select even to choose the 
sheets.

NOTE: To paste parameters into most odd numbered pages, use Select Odd in 
the Custom Paste screen to select all the sheets, and then manually remove the 
ticked boxes from the few sheets that should not change.

� Application of 1/4 Web - where relevant

The 1/4 Web dinky occupies one column on an 8-up and is set up the same way 
as a 1/2 and 3/4 dinky.
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� To set a 1/4 dinky in the third column

1 Right-click on the page to set the dinky.

2 Choose Column 3.

3 The dinky occupies the third column of the 8-up.

Related topics: • See “Preview and Change” on page 175

Output

■ Allows selection of event sequences when Imposition is off.

■ Allows selection of event sequences for color pages and for monochrome 
pages.
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� Secondary Output

When enabled, the Secondary Output feature allows routing a copy of the 
incoming file to one other Arkitex Producer path (per event sequence). 

■ For example, a third-party ink control system may require a bitmap, yet the 
input file is a composite. The Secondary Output feature could be used to 
route a copy of the composite to a RIP where the bitmap files can be 
generated.

NOTE: This feature enables a single copy to be output, and it will not be tracked 
in Client.

■ Another example is if incoming files are not only required to be output as 
high-resolution, but also to be generated as PDF. In this case, the Flat PS 
setting must be set in System Setup to ensure the correct data is routed to 
Acrobat Distiller.

The name of the file generated by Secondary Output may be:

■ The same as the incoming filename.

■ The same as the output filename (this option is grayed out, if a custom output 
filename structure has not been previously defined).

■ A custom file name.
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The custom filename may be up to 28 alphanumeric characters, to include a 
page number that must have the same number or more digits than the incoming 
file (up to 5), and a separation id.

■ In this example, imagine that the incoming filename structure is %e%(/0/
3+)P%C.

■ In the File Name Structure field, manually type in Page Number #, Separa-
tion $, Section & variables, or select variables to add from the Variables pull-
down menu.

NOTE: Section variables can only be added to the File Name Structure, if the 
section option has previously been enabled within this edition.

By checking Customize Separation id ($), the entries may be edited to reflect 
a new ID for the secondary output files, e.g., k2, c2, etc. But all secondary output 
layers must have an ID of the same length.

Label Definition If the Plate Editor option is configured, the following screen is available only for 
those non-imposed publications.
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NOTE: If the Plate Builder option is not configured, the screen will not be 
displayed.

If the On option is selected, this screen allows a text label to be defined and 
placed on the plate output of all incoming pages for this edition.

Clicking on the icon allows the plate to be switched from positive to negative, 
right-reading to wrong-reading using a toggle effect:

To add labels to specific pages/separations requires the use of Plate Editor and 
Link.

� Units of Measurement

Units of measurement are millimeters, centimeters, or inches. The width and 
height of the plate must be defined, as well as the x,y position of the bottom left 
corner of the incoming page on the plate.

� Label Definition - Define a Text label

1 Specify the width and height of the plate.

2 Specify an x,y position for the bottom left of the label relative to the bottom 
left of the plate.

3 Click Add.
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4 Key the required text in the Label entry box.

5 Enter the desired Rotation. Labels may be rotated 90, 180, or 270 degrees.

6 Add any Variables using the drop-down list.

7 Select the label Font from the drop-down list. If a text font is selected, the 
label is output on the plate as text.

NOTE: Fonts are defined under Console > File > Configuration > Plate 
Builder.

8 Click OK.

9 The new text label appears in the Label box.

� To Define a Barcode Label

1 Click Add.

2 Enter the label Name.

3 Enter the desired Rotation.

4 Specify the x,y coordinates.

5 Select the Barcode font from the drop-down box. If a barcode font is 
selected, the label is output on the plate as a barcode.

6 If a barcode font is selected, the Tracking Barcode check box becomes 
available.

7 Leave the Tracking Barcode box unchecked.

8 Click OK.

9 The new barcode label appears in the Label box.
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Defining a Tracking Label

A barcode may be added to a plate for many different purposes. If one of those 
purposes is to enable Director to track the status of various functions when it is 
swiped, then the Tracking Barcode box should be checked. In this case, a 
Tracking Barcode must include a page number and separation identifier 
variable (note the following variables):

■ Output name

■ Input name

■ Ink name (color)

■ Event Sequence name

■ Barcode - may only be included in the Tracking Barcode string if it is placed 
AFTER the following variables:

■ Page number

■ Separation Identifier

■ Plate copy number

And/or:

■ Resubmit counter. This requires a valid resubmission rule to have been 
configured.

Plate Builder Option

If the Plate Builder option is configured, it is possible to automatically generate 
a unique barcode for each duplicate plate copy using the %b variable. The user 
may also define where this barcode should be placed on the plate.

Barcode Variable %b

If the Barcode variable is chosen, it is generally entered on its own in the Label 
entry box. It is used to indicate that the barcode generated for each plate should 
match the entry in the Barcode tab accessed through the Preview and Change 
screen of Publication Builder.
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� Label Option

If the Label Option is not configured, these entries default to the defined input 
filename structure, or the Tracking Barcode structure. They may be customized 
either manually or automatically when external input data is downloaded from 
an external source (e.g., a press planning system).

� To Define a Tracking Label

1 Click Add.

2 Enter tracking barcode variables in the label field.

3 Enter the desired Rotation.

4 Specify the x,y coordinates.

5 Select the Barcode font from the drop-down box. If a barcode font is 
selected, the label is output on the plate as a barcode.

6 If a barcode font is selected, the Tracking Barcode check box becomes 
available.

7 Check the Tracking Barcode box.

8 Click OK.

9 The new tracking barcode label appears in the Label box.

� Label Types

The type of label is identified by a unique icon:
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■ Text Label - Indicated by the green T.

■ Barcode Label - Indicated by the black barcode symbol that will not be used 
by APS PRM for tracking purposes.

■ Tracking Barcode - Indicated by the red barcode symbol.

� Edit

To edit a previously defined label, double-click on the entry under Label.

� Save

Once the labels for this edition have been defined, their definition may be saved 
into a *.pmt file in the Arkitex\Director\Pef folder so that they may be 
downloaded to a new *.pmd, if required. Click on the Save button at the top 
right of the Label Definition screen.

� Using in Another Edition

To use labels in another edition, click on Load to download the definitions into 
the new *.pmd.

� Removing

Labels not required in an edition may be removed individually by selecting one, 
and clicking Remove. All labels may be removed at once by clicking Remove All.

NOTE: The time that will appear on the high-resolution output will relate to the 
time the file leaves Director for the Producer high-resolution queue. On the soft 
proof, it will represent the time the file left Director for a Producer Soft Proof 
queue.

Tracking Barcode If the Barcode Reader or External Barcode Input options are configured, data is 
sent back to the Director and Pair Engine when a barcode is swiped. Director and 
Pair need to know which edition/page/separation to which the data refers.
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If Director and Pair are generating the barcode that will appear on the plate for 
tracking purposes, then they assume that the data returned to the Engine will 
match the structure of the Tracking Barcode defined previously.

However, if the barcode is being generated by the front-end system, Director and 
Pair assume by default that the structure of the barcode data will follow the 
input filename structure if using the Control edition input by file name 
method, and there are no wild card characters defined in the input file name 
structure.

■ If there are wild card characters in the input filename structure, the expected 
barcode structure takes the form %U%E%P.%C (where the file name struc-
ture is defined on the first screen of Arkitex Publication Builder).

■ When using the Tracking Barcode Structure, replace the ”?” with “.” in the 
Barcode tab to get the proper barcode names for the pages.

� Using an example of Input file name structure “%U%E%S%P.%C”, the 
default tracking barcode structure is displayed as "%(/_/2+)U%(/_/
2+)E%(/0/2+)1P?%(1+)C" in the Publication Builder.

� Notice “?”. This is incorrect. Replace “?” with “.” so that the default 
barcode structure is "%(/_/2+)U%(/_/2+)E%(/0/2+)1P.%(1+)C".

If the barcode generated by the front-end does not conform to the above struc-
tures, one may define the expected structure by completing the barcode screen:
:Arkitex Workflow Reference Guide



166 PAGE OPTIONS
■ Barcode strings can be up to 35 characters, but should not include spaces or 
\ /:*?"<>|.

■ Although the Barcode Tracking field has a default structure taken from the 
Input and Output screen, one can manually edit this field and apply variables 
from the Variable pull-down menu to add the relevant information as 
required.

■ Publication date (%0d) can now be used in the Tracking Barcode. There are 
some limitations on how it can be used. Here is an example of a typical 
Tracking Barcode structure:

� %(yymmdd)0d%e%(/0/3+)1P%(1)C - which is Publication Date, long 
Edition name, Page number, and ColorID.

� The minimum Tracking Barcode must have at least Page number and 
ColorID. These two variables must be grouped together. If other variables 
like Publication Date and long Edition name are added, then these 
variables must be grouped as well. Otherwise, the Engine may give a 
“Data unexpected when the BCR is received” message.

NOTE: Unless the Copy Number variable is used, this facility does not 
differentiate between the first black separation of a page and a second duplicate 
separation. Imagine 3 copies of LONDON48.K have been imaged. When the 
barcode reader swipes LONDON48.K (plate 1), the data is sent back to the 
Engine. The black thermometer against LONDON page 48 on the Tracking 
display will rise. When LONDON48.K (plate 2) is swiped, the black thermometer 
will rise for a second time. If LONDON48.K (plate 2) is swiped again by mistake 
(not plate 3), the black thermometer will rise once more.

Related topics: • “Variables” on page 347.

Ink Presets If the Ink Presets module is configured, and it is required that Director 
automatically calculates ink densities for files outputting for this edition, select 
the On radio button.

There are two methods to handle Ink Presets. The new method uses *.ini files for 
calculating inks. The older method uses *.ips files.

NOTE: The desired ink calculation method is configured in System Setup by the 
system administrator.
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� Using *.INI Files

Details of the press zones and orientation of incoming bitmaps, etc., should be 
previously defined using the Ink Presets option. These details are stored in *.ini 
files. Available *.ini files are displayed in the top right of this screen in Arkitex 
Publication Builder.

There can be, for example, two *.ini files available — one contains information 
about pages from this edition that may output to plates that will be mounted on 
a Goss press; the other contains information about pages from this edition that 
may output to plates that will be mounted on a MAN Roland press.

If the ‘Goss.ini’ box is checked, the ‘GOSS.ini’ details will be applied to all pages 
in this edition.

1 Click on page 1 to confirm that the ‘GOSS.ini’ data will apply.

NOTE: If a number of duplicate plates are to be produced, but some will be 
mounted on the MAN Roland press, two sets of ink calculations will be needed 
for each page — one for each press. This is achieved by clicking on the ‘MAN.ini’ 
box. Only one *.ini file can be selected per page.

2 Click on page 1 to confirm the default instructions for this edition.
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If for some reason, all page 1’s plates are to be mounted on the MAN Roland 
press, but all other pages will share plate output to both presses, it is possible to 
cancel the ‘GOSS.ini’ file for page 1 only.

3 Uncheck the ‘GOSS.ini’ box on page 1.

4 Click OK or Cancel to leave page 1. Where a page contains different *.ini 
data to the default definition for this edition, the page icon turns yellow.
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5 Click the Default button on page 1 to apply the default definition for this 
edition again.

If a complicated application of *.ini files has been configured for this edition, 
the configuration can be preserved to apply to another edition. 

6 To save Ink Presets Configuration files, click on the Save button to the left of 
the screen.

Configuration files are given an *.ipf extension and stored in the InkPre-
sets\Groups folder.

7 To load an existing *.ipf file into an edition, click on the Open button. The 
number of pages of the new edition must match the number of pages refer-
enced in the *.ipf file.

a If mistakes are made during the application of *.ini files, it is preferable to 
start all over again.The Reset to Default button is a useful tool to remove 
any changes applied to pages and ensure that the default *.ini files shown 
at the top right of the screen are applied to all pages in this edition.

b If Sections have been defined for this edition, the display here will be 
similar to this. A scroll bar will appear to the right, and the new section 
will be identified (N for News and B for Business).
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� Using *.IPS Files

Details of the press zones and orientation of incoming bitmaps, etc., should be 
previously defined using the Ink Presets option. These details are stored in *.ips 
files. Available *.ips files are displayed in the top right of this screen in Arkitex 
Publication Builder.

There can be, for example, two *.ips files available — one contains information 
about pages from this edition that may output to plates that will be mounted on 
a Goss press; the other contains information about pages from this edition that 
may output to plates that will be mounted on a MAN Roland press.
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If the ‘Goss.ips’ box is checked, the ‘GOSS.ips’ details will be applied to all pages 
in this edition. 

1 Click on page 1 to confirm that the ‘GOSS.ips’ data will apply.

If a number of duplicate plates are to be produced, but some will be mounted on 
the MAN Roland press, two sets of ink calculations will be needed for each page 
— one for each press.

2 Click on the ‘MAN.ips’ box.

3 Click on page 1 to confirm the default instructions for this edition.
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If for some reason, all page 1’s plates are to be mounted on the MAN Roland 
press, but all other pages will share plate output to both presses, it is possible to 
cancel the ‘GOSS.ips’ file for page 1 only.

4 Uncheck the ‘GOSS.ips’ box on page 1.

5 Click OK or Cancel to leave page 1. 

NOTE: Where a page contains different *.ips data to the default definition for this 
edition, the page icon turns yellow.

6 Click the Default button on page 1 to apply the default definition for this 
edition again, i.e., application of both *.ips files.
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If a complicated application of *.ips files has been configured for this edition, the 
configuration can be preserved to apply to another edition. It is possible to save 
Ink Presets Configuration files.

7 Click on the Save button to the left of the screen:

NOTE: Configuration files are given an *.ipf extension and stored in the 
InkPresets\Groups folder.

8 To load an existing *.ipf file into an edition, click on the Open button. The 
number of pages of the new edition must match the number of pages refer-
enced in the *.ipf file.

a If mistakes are made during the application of *.ips files, it is preferable 
to start all over again.The Reset to Default button is a useful tool to 
remove any changes applied to pages and ensure that the default *.ips 
files shown at the top right of the screen are applied to all pages in this 
edition.

b If Sections have been defined for this edition, the display here will be 
similar to this. A scroll bar will appear to the right, and the new section 
will be identified (N for News and B for Business).
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Transmission

The Transmission tab will display if Courier has been enabled under the Default 
Settings (see “Destinations” on page 40).

� Steps

1 Check Enable Transmission to display a list of Courier Destination Groups.
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NOTE: Group names were configured in Courier and received in the *.xml file 
that was imported.

2 Check one or more destination groups.

� Enable Priority - The priority can be set to a Top priority (see “Priority” 
on page 124), a Set priority (2 to 127), or with a Hot Time enabled (see 
“Hot Time” on page 125).

� Initial Status - The status can be Active or On Hold.

3 Click Next to move to the next tab.

Preview and Change

This screen offers the possibility of reviewing and changing the following default 
parameters for a specific page/separation:

■ The expected input filename

■ The expected barcode data

■ The color of the inks expected (note that it is not possible to change the 
number of inks expected, though this is possible on-the-fly from the Tracking 
display).

■ The number of duplicate plates (copies)
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■ The number of copies which should be output before a hold is enforced

■ The deadline time 

■ The event sequence

NOTE: The expected (if imposition is on) input filename and the plate template 
must be changed in the Impose Sheets screen as these changes may need to be 
applied to individual pages or separations, and all the changes in this Preview 
and Changes screen will be applied to Sheets (pairs of pages).

NOTE: The plate template and the ink preset file attached to an edition can 
additionally be changed via the Linker module.

Up to 48 Sheets (or pairs of pages) are displayed on one tab. Click on tab 2 to see 
the next 48, and so on.

By moving the cursor over a Sheet Icon, a preview appears to the left showing all 
current parameters defined for the page.

The resultant list indicates all the parameters that may be changed at this point 
by right-clicking on the Sheet Icon.

All changes parameters are displayed on the Sheet Icons. The key to the colors 
used is shown in the bottom, left hand corner of the screen to make it easier to 
identify changes which may be difficult to see if many parameters change for a 
particular page.
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Customized Plate dialog - Changing Parameter Values

� Input Name

1 In the Change Existing Name Here box, type in the new name. The new 
name also appears in the Composite Name box.

2 Click the Apply to Separations button which will copy the new name 
throughout the layer boxes. Do this regardless of whether the file will be 
input as a composite or as separations.
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NOTE: If using the Control edition by directory method, or specifying wild 
cards in the input filename structure, no input filenames will be displayed in this 
screen.

� Barcode

The other changes that can be made to a page are the expected barcode and the 
output path.

The expected Tracking Barcode is displayed here, its definition having been 
derived from the structure defined earlier in Arkitex Publication Builder. 

Since it is a 6-color sheet, the names of the six color layers are also displayed.

In the example, the ? represents a single variable character, and the * represents 
multiple variable characters.

1 Key in the exact barcode expected under Change Existing Name Here (do 
not include # [page number] or $ [separation identifier] symbols), if a 
change from this is desired for a particular page.

2 Click Apply to Separations, and Director and Pair will automatically add 
.K, .C, .M, etc., at the end of the name keyed. 

NOTE: If 02PARIS is entered and Apply to Separations clicked, the entry 
against each separation will read 02PARIS.K, 02PARIS.C, etc.

3 Key the expected barcode for each layer individually in the appropriate entry 
boxes under Separation Names, if the separation identifier should be 
positioned elsewhere.
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� Inks + Copies + Hold After

1 Go to the middle box entitled Copies, and click on the up arrow against the 
black ink so that the value changes.

2 Repeat this action for all color layers.

3 The number may also be changed by highlighting the value in the box and 
keying in a new one.

This tab display also shows the existing parameters relating to the color of the 
Inks for the layers of this page.

NOTE: While the color used within this sheet is displayed, the colors cannot be 
changed. Any color change can only be applied via the Impose Sheets Screen.

The second option available for change on this tab relates to the Hold After 
values already defined. These may be changed in the same way as described 
under Copies. This is particularly useful if editorial changes to a page are 
expected, and all copies of the black separation should be held back until the last 
minute. The Hold After value may be set to 0.

� To cancel all Hold After requests for this page

1 Uncheck the box next to the Hold After column title.

2 Click OK to exit this screen.
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NOTE: The changes are reflected on the screen preview. The Sheet icon now 
includes a C in green to indicate that the number of Copies has been changed, 
and an H in yellow to indicate that a Hold After value has been changed.

� Deadline Time

The next change you need to make will be to our first page, changing the 
deadline time for the K separation.

1 Click on the number on the page 1 icon.

2 Click Change, and enter the Deadline time.

The same screen displays as before, but to a different tab. It is not necessary to 
exit out of each tab to apply changes. Changes may be made on any of the tabs 
before leaving this screen, if required.

Each separation displays with its existing deadline time and may be individually 
changed.

� Setup

1 To change all separations to the same deadline time, check the To All Inks 
box at the bottom of the tab.

2 Edit the time. The new time will automatically be applied to each layer.

3 Individual separation deadline times may be changed if required.
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NOTE: It is not possible to cancel deadline times on the Tracking display once 
they have been defined. However, in effect the deadline time may be made 
redundant by setting it to a time later than the end of the known production 
cycle.

4 Click OK to exit this screen.

5 The changed deadline time is displayed on the preview, and the icon adds a 
D in red to indicate a Deadline time change for page 1.

� Output Location/Event Sequence

The Output Location screen displays (checked) the existing default event 
sequence defined for this edition.

1 Select a different event sequence from those listed by checking the box 
against the choice. 

NOTE: The only event sequences that will be displayed here are those which 
contain the same number and type of events as the default choice.

2 If the Sheet icon clicked on represents a color page, and the event sequence 
for all color pages in an edition should be changed, check the Apply to all 
color pages box.

3 If the page icon clicked on represents a mono page, the box is labelled Apply 
to all mono pages and works in the same way.

4 The Barcode change is shown on the page icon by a B in black. The Event 
Sequence change is shown on the page icon by an O in blue.
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� Plate Template

1 Select a different plate template for a color layer by checking the ink box and 
browsing to the desired template.

2 To apply the change to the composite, check the Composite check box.

3 If the same plate template is desired for all layers of the page, select the Apply 
To All Inks button.

� Extra Info

The Extra Info screen provides the ability to change any of the four Extra Info 
variables available for manually creating labels used in Barcode Tracking.

Related topics: • “Imposition” on page 131
• “Tracking Barcode” on page 164
• “Variables” on page 347
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Copy & Paste A number of changes may have been made to a page that could be applied to 
another page. It is possible to copy all or a combination of page parameters to 
another page that has the same number of separations defined. Note that 
parameters of a 4-color page cannot be copied to a 2-color page.

� Setup

1 Click on the page icon with parameters to copy, and select Copy Plate 
Options.

2 If only the value for the Number of Copies should be copied, check the 
appropriate box.

3 Select all categories for copying using the Select All button.

4 Click OK to exit this window.

5 Paste the parameters by clicking on the desired page.

6 Select Paste from.

Reset To Default All or any of the seven change categories can be returned to their default 
settings.
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� Setup

1 If changing page 1’s deadline time to ‘22:30’ should be reversed, click on the 
icon.

2 Select Reset to Default, and click Deadline Time.

NOTE: The page icon loses its red D for deadline time indicator, and the time 
reverts to ‘19:30’ on the preview screen. Individual or all change categories for a 
particular page may be reset in this way.

Imagine that an edition was defined where the duplicate number of plates to be 
output is 5. Then, on the Preview and Change screen, all 4-color pages are 
defined to output 6 plates.

Now all 4-color pages should be reset to output 5 duplicate plates.

� 4-Color Pages

1 Go to the combo box next to the Reset All To Default button at the bottom 
of the screen.

2 Select Number of Copies.

NOTE: If the Reset All To Default button is clicked, all 4-color pages where a 
change has been made to the number of copies (be it an increase or a decrease) 
will revert to the original. Individual or all change categories may be reset in this 
way to apply to all pages.

NOTE: Arkitex Publication Builder instructions input from an external source 
using the AutoPlan option (i.e., input from a press planning system) may also be 
viewed through the Preview and Change screen.
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The Sheet icons are colored to distinguish between Sections. Remember the 
pages are typically paired, and therefore, this will affect the layout of the Sheet 
icons.

� Sheet Layout

1 Move the cursor over the Sheet icon of the first page of the first section.

2 The separation identifier is displayed with the page number and identified as 
A.

View Groups In Arkitex Client display an edition’s pages in one of two ways:

■ All pages appear together in a simple, scrollable display.

■ Pages may be displayed in groups.

The default sheet group displayed in Arkitex Client consists of all pages expected 
for this edition split into windows of 72 pages each. Alternatively, define up to 7 
custom sheet group displays of up to 72 pages each.
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� Custom Sheet Groups

1 Select the Custom button to define custom sheet groups.

2 Key in the number of groups to create as prompted.
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All pages display as a white page icon incorporating the number of inks per page 
and with their page number in a box above each icon. The boxed number 
indicates that a page has not yet been assigned to a group. Where paired pages 
with two page numbers in the filename are expected, the lower page number is 
displayed in the box. 

The groups are named Group1, Group2, etc., but group names may be edited as 
desired (do not include spaces or \ /:*?"<>|). In the following examples, five 
groups have been named News, Sport, Fashion, Features, Late_Pages.

3 Click on the green box next to Group1 (News). The number 00 means that no 
pages have yet been allocated to this group. The cursor is colored green to 
match the group color indicator.

4 Click on the sheet 1 icon.
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It turns green to indicate that it is included in the News group. The box 
disappears from the page number above the icon. The green box to the left of the 
screen has changed display from 00 to 01 to indicate that the News group 
consists of one page.

At the bottom of the screen a new box appears whenever the cursor is moving 
over the page 1 icon. It indicates that Sheet 1 is included in the (green) News 
group.

5 To define pages 2-16 as part of the News group as well, point the green cursor 
just outside of the page 2 indicator box.

6 Drag it to create a green box surrounding pages 2-16.

7 Define sheets to be included in the other groups using the same procedures. 
If a mistake is made, clicking on a sheet a second time will remove a sheet 
from a group (turning the sheet icon white again).

In the following example, there are 16 sheets in the News group, 12 sheets in 
Sport, and 6 page sheets in Fashion.
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8 To select the rest of the sheets for the Features group:

a Click on the blue box as normal.

b Click Select Remaining at the bottom of the screen.

NOTE: All remaining sheets are now colored blue.

9 To view the contents of all groups, click the View All Groups.

a If sheets 37 and 38 should be in the Features group and not the (yellow) 
Sport group, click the yellow 12 button to the left of Sport, and then click 
on the sheet 37 and 38 icons to designate the sheets as unallocated. Then, 
click on the blue 14 button next to Features, and select sheets 37 and 38 
for inclusion in this group.

Sheets may be shared between groups (so that they appear in more than 
one Tracking display group). For example, a separate display can be 
created for a number of sheets expected to be late and requiring special 
attention.

b If pages 1, 2 and 45-48 are expected to be late, define them as the 
Late_Pages group in the normal way. When all groups are viewed, they 
display as rainbow icons.
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10 Move the cursor over one of the rainbow icons to display the Groups box 
below, which displays groups connected to sheets. For example, sheet 47 
above is a member of the Sports group as well as the Late_Pages group.

11 To clear one group, display just that group by clicking on the colored group 
icon, and then choose Clear Selected.

12 To clear all groups, click Clear All.

13 When finished allocating sheets to groups, Save this definition for future use 
when defining new *.pmd files for other editions. The number of pages of the 
new edition must match the number of pages referenced in the saved 
definition.

14 Go to File and choose Save As.
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15 Key in the filename of your choice. The file will be given a *.gru extension 
and will be placed in the Arkitex\Director\Config\Groups folder.

16 To use an existing *.gru file in a new *.pmd file, select File > Open.

17 Click OK to return to the Groups screen of Arkitex Publication Builder.

18 Click Next to move to the next Arkitex Publication Builder screen, or Edit to 
return to the sheet groups to make changes.

a If Sections have been defined for this edition, you will see this screen 
initially:

Director and Pair will automatically create one group per section if the 
Yes radio button is selected in Add 1 group per section.

b If one group per section is sufficient, leave the 1 group per section only 
radio button checked.

19 To additionally generate up to 7 custom groups, click Add custom groups to 
be taken to the Custom Sheet Groups definition screen defined above.
:Arkitex Workflow Reference Guide



192 PREVIEW AND CHANGE
Save and Activate

Before activating all the Publication Builder instructions, decide which Check 
PreProcess/Don’t check options to select. The Check PreProcess/Don’t check 
options at the bottom left of the Save and Activate screen advises Director if it 
should check for any previously processed files active in Director that relate to 
this edition.

� Setup

1 When the Check PreProcess option is selected, all files related to the 
editions selected in the PreProcess screen will be checked to see if their file 
names match the file names used within this edition.

a If Director finds previously processed files from these PreProcess selected 
editions that match with this edition, it will, by default, use the previously 
found files and the previously created SoftProofs and Ink Preset calcula-
tions for this edition.

b If the Use only files (not SP/IPS) value in Arkitex Director Setup is ‘Yes’, 
only the high-resolution files will be used from the preprocess editions for 
this new edition. The previously created SoftProof and InkPresets for the 
preprocess edition will not be used. New SoftProofs and InkPresets will be 
generated.
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2 When the Don’t check option is selected, only files input to the Arkitex/In 
folder after this edition is activated will be used with this edition.

3 When applying all the Arkitex Publication Builder instructions just config-
ured, decide to Save, Save & Activate, or Activate this edition.

a If an incoming page is to be shared between one or more editions, the 
following methods should be employed to allow minimal disruption to 
automatic workflow:

b If an edition’s input is controlled by File Name, and the editions have 
different filenames and structures, the easiest way to share a page from 
another edition is to change the name of the existing, expected page to the 
name of the expected shared page. Do this via the Preview and Changes 
screen within Arkitex Publication Builder.

c If the edition’s filename structure contains wild cards, then the file which 
is being shared must follow the structure defined for the edition. If neces-
sary the name needs to be changed before input so that the edition 
identifier, page number, and separation identifier match the wild card 
structure defined for this edition. The Check for conflicts registry setting 
should be set to ‘no’.

� Saving/Activate

Before applying all the Arkitex Publication Builder instructions just configured, 
decide whether to Activate the file without saving it, Save and Activate the file, 
just Save the file, or Update an active edition.

CAUTION: Editions that are sharing pages must use similar types of 
resubmissions rules. Shared page/s editions must use either the Ignore 
type of resubmission rule, or one of the Substitute types of resubmission 
rules on all editions sharing the same pages.
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1 To activate without saving the instructions into a *.pmd file, click on 
Activate.

2 If an edition has been created, and should be saved without activating it, 
select Save.

3 To save edition instructions as a *.pmd file and activate immediately, choose 
Save and Activate.

4 Another method of activating editions is available directly from the Arkitex 
Console.

a If not activating an edition, or not applying changes to a currently active 
edition, go to the section titled “Executing Save or Activation” on 
page 195.

b If applying changes to a currently active edition, decide how to apply 
these changes to the active edition prior to activation.

� Duplicated Plan Action

This option controls the update of editions that are already in production 
without losing the status of previously processed pages.

NOTE: These updates can be applied via the Publication Builder module and via 
the external created *.pmd files. 

Application of the Duplicated Plan Action can be performed by one of two 
methods:

■ Full Update

Changes made to old pages are applied, old pages without changes are kept, and 
all old and updated page status information is stored. Any completely new pages 
in this new edition are not created. No existing pages are removed.

■ Incremental Update
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Any completely new pages in this new edition are created. Changes made to old 
pages are applied. Old pages without changes are kept; and all new, old and 
updated page status information is stored. No existing pages are removed.

■ Replace

Any completely new pages in this new edition are created. Changes made to old 
pages are applied. Old pages without changes are removed; and all new, old and 
updated page status information is stored.

■ New Plan - Retain Status

Retain the status of editions that are already in production.

■ New Plan - Clear Status

Clear the status of editions that are already in production.

� Executing Save or Activation

1 Once an option to Save, Activate, or Duplicate an edition is chosen, select 
the option as previously described, and then click the Execute button.

2 If Save, or Save and Activate an edition is selected, define the name that will 
automatically be given to the *.pmd extension and saved in the 
APS_Plateroom\Config folder.

3 When the save or activation has been executed, the following message and 
new box will display on the Save and Activate screen.

CAUTION: To use the Duplicated Plan Action option to overwrite an existing 
edition, both editions must have the same Edition Name. The Edition 
Name is the name configured in the Create new or open existing *.pmd file 
screen, the very first of the Arkitex Publication Builder screens. The *.pmd 
file names do not have to match.
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4 If defining a complete New Edition, the first Arkitex Publication Builder 
screen reappears to create a new set of edition parameters for a different 
edition.

5 Alternatively choose to Exit this screen after the execution. Remember that 
the *.pmd file needs to be activated for the edition to appear in Client, and 
for Director and pair to know to expect incoming pages for this edition.

Related topics: • “Preview and Change” on page 175

Selective Activation of Editions

Selective activation of Editions is used to allow activating part of a plan. 
Changes for one or more editions in a plan can be activated individually. For 
example, you can selectively activate all the editions in a publication one at a 
time.

At the Edition level the activation order is determined by Press Run Times when 
all editions have Press Run Times defined. If there are no Press Run Times 
defined, the order is determined by the order the editions are activated.

If an edition is activated without press run times, it is now the last one in the 
parent/child relationship.

If your publications share pages between editions, and you want to maintain the 
child/parent relationships when activating individual editions, you must either:

■ Activate editions in order.

■ Set Press Run Times for editions within these publications (refer to “Press 
Run Time” on page 91).

NOTE: On the original publication, the Press Run Time must be set for each 
edition to keep the Parent edition and the Publication Tree in order in case you 
make changes like unshared pages, jump shares, etc.

In Client View under Set Preferences, check the Press Run Time box under the 
Client > Publication Tree tab to keep the Publication Tree display in order.

If your administrator has enabled Selective activation of Editions, you will see 
one of the following screens:
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Either all the editions will be preselected as in Example A, or no editions selected 
as in Example B. You then select the edition(s) as in Example C.

NOTE: If the administrator has not enabled selective activation of editions, 
there will be no check boxes next to the edition names.

Related topics: • “Executing Save or Activation” on page 195
• Arkitex Web Client Online Help, Set Preferences.

Editions with Multiple Output Locations

When configuring editions that output to multiple locations, but to different 
physical press locations, we recommend only changing the Edition Name and 
the Event Sequence for these type of editions, but not changing the Input File 
Name Structures. The incoming files would be shared, but the outgoing files 
would all be supplied to the correct destinations.

For example, if there is an edition with an Edition Name of NEWS_London, but 
a Input File Name Structure of NEWS##.$ outputting to an Event Sequence 
called London (this event sequence could have a drop folder on Arkitex 
Producer called London), the existing edition could be opened, the Edition 
Name changed to NEWS_China, and to an Event Sequence called China (this 
event sequence could have a drop folder on Arkitex Producer called China). 

Example A

Example B

Example C
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Using this example, two editions have been created that share the same input 
parameters, but output to different destinations.

Filtering AutoPlan and Planner Files

You can filter imported files from AutoPlan and Planner. For example if you have 
one printing layer and 20 doubleburn layers, these can be filtered by creating a 
custom doubleburn screen. This is done by using filtering and default .pmd files 
that are read by the imported file from AutoPlan and Planner.

When importing Autoplan or Planner files using Import, the files are filtered 
through a series of xslt to structure the plan for Pub Builder. Information for 
Default Inks, Copy Counts, Hold After values, Deadlines, etc., is added from the 
user defined defaults files. In the case of Courier plans, the plan is filtered by 
Destination.

In the Script directory create a .pmd called PubBuilderDefault.pmd. This file 
will contain the global defaults for Colors, Copy Counts, Hold After, Deadlines, 
Section Imposed By, Secondary Output, etc. The script directory may also 
contain publication specific defaults files with the name 
<pubname>Default.pmd, where <pubname> is the publication short name. If 
a publication specific file is found, it will be used instead of 
PubBuilderDefault.pmd.

The following items are used from the defaults files:

Publication Tree Edition, Zone, and Section as appropriate.

Publication Type Use single or imposed; previously paired may 
not work as expected.

Input Name Structure The defaults file value will be used if it con-
tains a %0V (doubleburn variable); otherwise, 
the value from the imported plan will be 
used.

Sheet Name Structure
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Filtering for destination requires the TransmissionConfiguration.xml 
(imported from the Courier web service), a Site name configured in the System 
Setup Destination Names, and transmission information in the plan, otherwise 
it is ignored.

Plan Import
Limitations

The following are Pub Builder limitations for plan imports.

■ Do not use Advanced Imposition. Planner and Autoplan do not supply the 
necessary book info.

■ While it should be possible to import a plan, changing the imposition by 
adding or removing pages may give unexpected results.

Output name structure If defined in the imported plan, the imported 
plan value will be used.

If not defined in the imported plan:

■ If not imposed, then input name structure 
will be used to generate it.

■ If imposed, and the imported file does not 
contain an output name structure, this 
value will be used.

Imposed by If sections are defined.

Inks Definition Ignored unless in imported plan.

Default Inks Should be set to match the order layers are 
defined in the imported plan if it is necessary 
to maintain color order.

Priority options Set to match the imported plan; the actual 
values will come from the plan.

Copies Set standard or custom; the copy count val-
ues are used to determine if the plan value is 
custom.

Hold After Set No Hold, Standard or Custom; the hold af-
ter values are to determine if the plan value 
is custom.

Deadline Set No Deadline, Standard, or Custom.

Secondary Output Enable and Select Filename Structure as ap-
propriate.
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■ Number of inks per plan is 7. Up to the first seven inks in the colors table 
referenced in the plan will be used. The remainder will be discarded.

■ Double page spreads (panoramas) may not be identified correctly. The 
page count may also be incorrect in this case.

■ Dinkys (fly pages) may not be identified correctly.

■ Output filenames and secondary output filenames may change when 
saving/activating. Pub builder generated them from the output name struc-
ture and secondary name structure respectively.

Script Folder Under Arkitex\Director is the Script folder.

This folder contains:

■ PubBuilderImport.vbs

■ .xslt and .xsl files

The PubBuilderImport.vbs script runs the .xlst and .xls files to translate 
imported plans.

The user creates default .pmd files with default settings that are used by the 
imported program.

■ PubBuilderDefault.pmd - This is a global .pmd file created by the user.

■ <pub short name>default.pmd - The import file searches and used this file 
first. If one is not created, it then used the PubBuilderDefault.pmd file if not 
found in the Script folder.
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NOTE: You must use the short publication name of the imported file, 
otherwise you not link to the correct default file.

In a Courier environment all pages are removed if they do not belong to a partic-
ular destination. To do this requires two pieces of information:

■ The transmission configuration file imported from the Courier system, only 
if the transmission configuration information is in the imported plan

■ In System Settings under Options > Destination Name parameter is set

This filters all files not going to that destination, assuming there is transmission 
to that location.

Default Settings NOTE: Unless specific information is defined in the default .pmd, this 
information will be pulled from the imported file which may cause 
unpredictable results.

� Setup

1 Click Default Settings to open the Publication Setup Configure dialog box.

2 Select the Misc tab.

3 Under Destinations you can point to the Courier system where the destina-
tion groups are defined.
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■ Destinations - Refers to Courier transmission sites that will send publication 
plans to press sites.

■ Web Service - Web Service gets transmission configuration information 
from the JBoss Server where the Courier engine runs.

� Host Name - The host name of the Courier server running the Courier 
engine. If local, enter localhost.

� Port - The port number of the Courier server. The default is 18181.

■ Import - Imports transmission configuration files from Courier servers. 
These are *.xml files stored in the Director > Config > General Settings 
folder.

NOTE: If Destinations is enabled, an additional tab called Transmission will 
appear after the Ink Presets tab. See “Transmission” on page 174.

4 Click the Import tab.
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■ The Import properties include:

� The Import Folder holds files for the monitor.

� The Save Folder saves imported files after processing. If there is a 
problem in processing, the files can be reprocessed.

� The Error Folder contains errored files.

NOTE: All three settings must be present for files to be saved. If blank, the files 
will be deleted.

NOTE: You can also use Browse  to locate the Import, Save, and Error 
folders. The path will fill automatically.

� Enable Import enables the Import Monitor.

� Enable Import On Startup automatically enables the Import Monitor on 
startup.

� Auto Scan Time (secs) is used to refresh the Import Monitor for 
scanning.

� Filter can be used to filter the Import file list displayed (refer to “Using 
Filter” on page 204).

An example filter string is:

*.pmd+*.xml+abc???.xml
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NOTE: Read-only files will be excluded from filtering.

5 Click OK to exit the Publication Setup Configure dialog box.

� Using Filter

Filtering works on the principle of the Like operator, used to compare two 
strings.

result = string Like pattern

Pattern-matching allows use of wildcard characters, character lists, or character 
ranges, in any combination, to match strings. The following table shows the 
characters allowed in pattern and what they match:

The use of a hyphen (-) at the start of the string means to ignore anything in that 
string.

-*.pmd (.pmd files will be filtered out)

Creating the
Default .pmd File

Without default files, you will be using what the imported file contains. Default 
files guarantee that settings will be correct. The default file is read first. If the 
imported configuration file matches the default file, it will not be marked as 
custom. If the imported file differs from the default file, the part of the plan that 
differs will be marked as custom, and these sheets are locked. 

NOTE: To unlock a custom sheet, refer to “Changing Custom Sheets” on 
page 210. 

Default files are global, where custom applies to specific sheets.

Characters in pattern Matches in string

? Any single character

* Zero or more characters

# Any single digit (0-9)

[charlist] Any single character in charlist

[!charlist] Any single character not in charlist
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� Setup

NOTE: Default .pmd files must match the imported AutoPlan or Planner file. 
If this has editions, sections, zones, include these in the default .pmd.

6 Under Publication Type select Imposed or Single publication.

7 At the Sheet tab define the Sheet Name structure and Section type.

8 At the Ink Defaults tab define the colors of the inks.

NOTE: Colors can now be swapped in this screen without having to create a fifth 
color.

9 Define the Inks order.

NOTE: If the ink order is not defined, it will pick up the order from the imported 
plan which may be incorrect if the plan is activated more than once.

10 Define number of colors used.
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11 Define the Priority.

12 Define the number of copies of inks, and whether it is Standard or Custom.
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13 Define the Hold status whether its No Hold, Standard, or Custom.

14 Set Deadlines whether its No Deadline Time, Standard, or Custom.
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15 Define Secondary Output.

16 Save/Activate the file.

Using Imported Files

When the Import Monitor is active, it will display at the bottom of the Start 
window. 
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NOTE: Information is contained in the .pmd file. If this is not set, no transmission 
information will be in the plan, and the pages will import even if those pages are 
not needed at every destination group.

Imported files will have the following status.

■ Waiting for Stability - File stability check. The file size will show zero.

■ Ready - File is stable. The file size will now display.

■ Processed - File has been processed.

■ Error - File was moved to the Error folder set up under Default Settings > 
Import.

■ Deleted - File was deleted. The file size will show zero.

Files can be manually selected for import, or auto selected.

� Manual Select

1 Click Import, and then select Open Folder .

2 The Open Configuration File dialog window opens.
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3 Select a file name, and click Open.

4 The name will appear in the name field.

� Auto Select

1 Select a file name from the Import File Name area.

2 Drag the file to the publication area under the Import radio button. The 

cursor will display as a white arrow with a plus sign .

NOTE: If the cursor is not in the correct place, it will display as a struck through 

circle .

� Changing Custom Sheets

If you have selected Custom, the only place you can make changes is on the 
Preview/Change screen.
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3 Click Save to save the .pmd file.
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Arkitex Engine

Engine Toolbar

The toolbar displays tools to control the engine, messages, client connections, 
and error conditions.

� Stopping and Starting the Engine

By default, the Engine begins running once the application is opened.

To run the application, click on the Engine button on the Arkitex 
Console. The following window appears.

Stop the Engine by clicking on the Stop button. The button turns red 
when it is depressed.

To restart the engine, click the Start button. The button turns green 
when it is depressed.
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� Log Window Messages

The log messages indicate the number of licenses purchased for different Arkitex 
Director, Foundation, and Pair modules.

Messages should be regularly cleared using this utility.

� Client Connections

The names of the computers on which the clients are running display, along with 
the last time the connection between them and the Engine was checked and 
found to be operational. These may be local or remote connections.

To display :Arkitex Client connections, click this option in the list.

NOTE: :Arkitex MacProof, Publication Builder, and Plate Builder connections are 
also available in the list.

The display information shows how many clients are logged onto the Engine 
(although licenses may have been purchased for more).

Log messages may be cleared by clicking the Clear Log Window 
button.

Various client connections can be monitored. To display the number 
of Clients currently logged on to the Engine, click the pulldown 
arrow on the Clients Connections button.
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� Disconnect Clients

To disconnect a client (local or remote), select the client connection type, 
followed by the appropriate user name. Click the Disconnect button.

NOTE: Only one user at a time can be disconnected.

� Error Buttons

To the right of the icon bar, there are three or four green buttons. Four green 
buttons will be displayed if the Show alarm button option has been enabled in 
System Setup. The default is three buttons.

The Alarm button will turn red if an error message is received from an external 
source, i.e., not from the standard OMAN2PRM feedback software. If the Error 
button is red, it will display a text window (tool tip) containing the error 
message when hovering over it with the mouse.

Clear the alarm by clicking on the Alarm button on the Engine. This will revert 
the button to green. If any other buttons are red, clicking them will clear the 
error.
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� Format Error

If a file is input to the Engine and not recognized as a supported format (i.e., 
PostScript, EPS, DCS 1.0, DCS 2.0 [single file], PDF or 1-bit TIFF single-strip 
[uncompressed, or CCITT Group 3 / 4 or PackBits]), it will be moved to the 
FRMT sub-folder of the ERROR directory. The Format button on the Engine 
screen turns red. An alarm sounds, and the error button on Arkitex Client also 
turns red.

The names of wrongly formatted files may be viewed by clicking on the Check 
Format Error Files button on the Engine screen:

■ To remove a file from the window list and from the ERROR/FRMT folder, 
select it, and click the Remove button. 

■ The Remove All button removes all files currently in the list and deletes them 
from the ERROR/FRMT folder. The alarm color and sound are automatically 
returned to normal if all files are removed from the list, and Close is clicked. 

■ If a file is to be left in the ERROR/FRMT directory, stop the alarm from 
continuing by clicking on the Cancel Sound button. 

NOTE: The alarm will continue if an error condition is detected that turns the 
Check Soft Proof Error files or Clear Arkitex Producer Alarm buttons red; or 
a new, incorrectly formatted file is input into the Arkitex Director and Arkitex 
Pair system.
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■ The Clear Alarm button clears not only the sound, but also turns the red back 
to green on the Engine, and on the Error button in Arkitex Client.

■ The Refresh button enables any new filename errors detected by the Engine 
to be displayed in the window list.

� Soft Proof Error

If the Soft Proof option is configured, and an error occurs while the soft proof is 
being generated, the Soft Proof button turns red. The alarm sounds, and the 
Error button on Arkitex Client turns red. Clicking on Soft Proof displays a 
screen similar to Format with an additional area to view the soft proof page. 

■ If a soft proof is displayed in the window, the error relates in some way to the 
name of the file. 

■ Arkitex Director and Arkitex Pair modify filenames of PostScript files for soft 
proof purposes. Occasionally the PostScript file is not modifiable. If the 
external filename does not match the internal job name, a naming error will 
be generated in the system. In this case, route the incoming PostScript file for 
conversion to Tiff or EPS before sending it.

■ If a file is sent directly to GRAFIXrip Soft Proof page setup, rather than 
through the Arkitex Director and Arkitex Pair input folder, a naming error 
will be generated. The return file is not expected nor recognized in the 
SoftProof\In folder.

■ If no soft proof is displayed, the error probably relates to the Soft Proof page 
setup being incorrectly configured on GRAFIXrip.
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Last Soft Proof - To the right of the Engine log window is a box headed Last Soft 
Proof. The display constantly updates to show the latest Soft Proof view(s) 
generated for a particular page.

� Arkitex Producer Error

The Arkitex Producer icon on the Engine turns red if an error has been detected 
by Producer. This may be a:

■ Hardware error (Arkitex GRAFIXrip or imager)

■ PostScript error (discovered by Arkitex GRAFIXrip)

To rectify the error, view the Producer’s Activity Monitor display.

If Arkitex Director and Arkitex Pair is configured to drive two Producers, the 
Producer button splits in two. The left half represents the first Producer 
configured, and the second half represents the second configured.

Renaming Rules Within the Engine module is a powerful renaming facility, which may be set up 
independently for output processing. These renaming rules allow all the 
filenames to be analyzed, then creates new output filenames and associated 
processing parameters to be generated as a result of this analysis.

Renaming works via a table of rules and name generators held in each output 
process set up.

Input rules are scanned in order until a match is found. Then output names and 
parameters are generated according to the table. If no match is found, the 
filename is left unchanged.

CAUTION: The order of the entries in the table may be important in 
resolving ambiguities in renaming. Entries at the top of the table are tested 
first.
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� Creating a Renaming Rule

Unique Renaming Rules are configured for:

■ Input Files - Files found in the Arkitex\In folder

■ Soft Proofs - Files found in the SoftProof\In folder

■ Ink PreSets - Files found in the Arkitex\InputInkPresets folder

■ PDF conversion - Files found in the PDF conversion folder defined by the 
user through Arkitex System Setup

■ TIFF conversion - Files found in the TIFF conversion folder defined through 
Arkitex System Setup

■ Parameters - 

■ Secondary Output - 

� Setup

1 To create a Renaming Rule, select Renaming Rules... from File on the 
Engine’s menu bar. The following Renaming Rules dialog box appears.

2 Select the tab that corresponds to where the renaming rules are to be applied: 
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Input; Soft Proof; InkPresets; PDF conversion; TIFF conversion; or 
Parameters.

3 InFile: The first column in the table holds the set of input rules that are used 
to analyze and match incoming filenames. InFile rules are a mixture of 
parameters and literal strings.

A parameter is %xyzCode, where xyz is an optional format, and Code 
controls how the file is interpreted. If xyz is present, then it determines the 
number of characters scanned for this parameter. If it is not present, then the 
next part of the rule must be a literal. All characters up to this literal will be 
scanned.

The possible codes are:

D – Date: For date parameters, the format can contain dmyw characters to 
pick out the day month year and week numbers.

example: %dd-mm-yyyyD

will scan and pick out the Date string in the filename. If week numbers are 
used, then the day and month will be ignored. If year or month are not 
defined, they default appropriately. Day numbers are assumed to be ‘later 
than the day before yesterday’. If today is 29th March, then 27 is assumed to 
be March, but 01 up to 26 are assumed to be April. The same logic applies to 
years.

NOTE: If the month is not specified, then strange results may occur if an 
inappropriate day number is used (e.g., dd=30 when the current month is 
February).

N – Number: For number parameters, the format can be a number that will 
be the number of characters scanned and evaluated as a number.

example: %3N 

will take 3 characters as a number; %N_ will take all characters up to the “_” 
as the number field.

S – String: For string parameters the format can be a number that will be the 
number of characters scanned and kept as a string.

example: %5S

will take 5 characters as the string; %S_ will take all characters up to the “_” 
as the string field.

[CharSet] – Wildcard: This can be used to match input characters against a 
set of characters. All characters in the input segment must match against one 
of the characters in the Charset. The segment is available for use in output 
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naming just like the D, N, or S parameter codes. The Charset can be a list of 
characters and can contain ranges.

example: %2[A-Z0-9]

will take 2 characters as a string, and check that they are both alphanumeric. 
As each parameter is scanned, it is saved as a sequentially indexed variable 
(starting from 1) for later renaming usage. There are no limits to the number 
of input rules, or the number of fields in each rule. Matching has been 
optimized to allow high speed matching of multiple rules and large look-up 
tables held in the rules.

4 OutFile: The second column in the renaming table holds output rules used to 
transform the outgoing filenames. OutFile rules are a mixture of parameters 
and literal strings.

The output name templates are a mixture of literal characters and 
parameters obtained from the input rule. A parameter is %n:xyzCode and 
may be used in any position in the output name template. Parameters can 
also be repeated in different positions and with different formats.

The possible codes are:

D – Date: For date parameters the format can contain dmyw characters to 
pick out the day month years or week number.

example: %3:mmddyyD

will reformat the 3rd scanned parameter Date string in the output filename. 
If week numbers are used, the first week of the year is controlled by a system 
parameter in the environment file. Similarly, day numbers or day names are 
also controlled by a system parameter in the environment file.

The following formatting characters can be used:

d Display the day as a number without a leading zero (1 – 31).

dd Display the day as a number with a leading zero (01 – 31).

ddd Display the day as an abbreviation (Sun – Sat).

dddd Display the day as a full name (Sunday – Saturday).

ddddd Display the date as a complete date (including day, month, and year), 
formatted according to the system's short date format setting. For Microsoft 
Windows, the default short date format is m/d/yy.

dddddd Display a date serial number as a complete date (including day, 
month, and year) formatted according to the long date setting recognized by 
the system. For Microsoft Windows, the default long date format is mmmm 
dd, yyy.
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w Display the day of the week as a number (1 for Sunday through 7 for 
Saturday).

ww Display the week of the year as a number (1 – 54).

m Display the month as a number without a leading zero (1 – 12). If m 
immediately follows h or hh, the minute rather than the month is displayed.

mm Display the month as a number with a leading zero (01 – 12). If m 
immediately follows h or hh, the minute rather than the month is displayed.

mmm Display the month as an abbreviation (Jan – Dec).

mmmm Display the month as a full month name (January – December).

q Display the quarter of the year as a number (1 – 4).

y Display the day of the year as a number (1 – 366).

yy Display the year as a 2-digit number (00 – 99).

yyyy Display the year as a 4-digit number (100 – 9999).

F – Filtered: This will filter the scanned parameter to only have alphanu-
meric characters. All other characters are stripped out.

L – Left String: This will output the left part of the scanned parameter.
example %2:3L

will output the left 3 characters of the scanned string. If the number is left 
out, it defaults to 1. If the scanned parameter is not long enough, all of it is 
used. If the number is negative, this refers to the number of characters to take 
off the right part of the string (e.g., %2:-3L will produce abcd from abcdefg)

M – Middle String: This will output the middle part of the scanned 
parameter.

example: %1:3:2M

will output the 2 characters of the scanned string starting from the third. If 
one of the numbers is left out, it defaults to 1. If the scanned parameter is not 
long enough, all of it is used.

N – Number: This will output the scanned parameter as a formatted number.
example: %3:000N

will output the number as 3 digits with leading 0s. If no formatting string is 
present, the number will be variable length. If the number is too large to fit, 
it will be truncated.

R – Right String: This will output the right part of the scanned parameter.
example: %2:3R 
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will output the right 3 characters of the scanned string. If the number is left 
out, it defaults to 1. If the scanned parameter is not long enough, all of it is 
used.

S – String: This will output the entire string. If there is a formatting string, it 
will be used to pad scanned parameters to the length of the formatting string. 
Normally, the padding is to the left of the string. If the first character of the 
formatting string is a /, it will fill using the remainder on the right.

example: %1:######S will produce ###ABC

If the first parameter is ABC, %1:/######S will produce ABC###.

T – Table: This will search throughout the table again matching the param-
eter against the input rules. This may be used to translate arbitrary strings 
like titles or colors. If a formatting string is present, it will be added to the 
front of the scanned parameter before the In rules are searched. This can 
make it easier to document the rules and can avoid ambiguity in the rule 
matching. 

example:%2:Col=T with a scanned parameter of “C”

� Editing the Rename Table

Entries in the rename table may be added or edited by clicking in the cell and 
typing. Cursor keys may be used to move between cells. The contents of a cell 
may be cut and pasted to other cells.

A single row may be inserted by clicking on the small gray column and pressing 
the insert key. The contents of multiple rows may be deleted by marking them 
using the first gray column, and pressing the delete key. This does not actually 
delete the rows; but rows with empty rules will be automatically removed when 
the dialog box is closed.

Multiple rows may be copied and pasted to other rows in the same table or to 
the tables in the other folder set ups. This is useful for putting the same set of 
rules into all folders. Mark the rows using the gray column. Use CTRL-C and 
CTRL-V keys to copy and paste. When rows are pasted, they will overwrite pre-
vious contents.

� Testing Rename Rules

If using complex or multiple rules, two entry boxes below the rules table are 
used for testing prior to file processing.

The contents of the left-hand box are transformed into the right-hand box using 
all the rows in the table. Change the text, the rules, and names. The effect on 
the new name generated immediately displays.
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� Renaming Examples

■ Reordering Fields

The filename consists of PPTTTEEEC, where PP is a page number, TTT is a 
Title, EEE is an edition, and C is a color. The desired output filename is:

TTT_EEE_PP_C.tif 

As the input filename has fixed length fields, it is simple to scan and re-order:

InFile = %2N%3S%3S%1S
OutFile = %2S_%3S_%1:00N_%4S.tif
Result = 09ABCDEFK -> ABC_DEF_09_K.tif

■ Extracting SubFields

The filename consists of Title.Edition.P.Color, where P is a variable length page 
number, Title is a variable length Title, Edition is a variable length edition, and 
Color is a color name. The desired output filename is TT_EEE_PP_C.tif, where 
TT is the second and third letters of the title, EEE is the last three letters of the 
Edition, PP is a fixed length Page number, and C is the first letter of the Color.

As the input filename has separators, use these to scan and reprocess the fields 
with the string selection Output parameters.

InFile = %S.%S.%N.%S
OutFIle = %1:2:2M_%2:3R_%3:00N_%4:1L.tif
Result = 3DTimes.FirstED1.3.Cyan -> DT_ED1_03_C.tif

■ Using Multiple Rules

Two types of filename exist. Some use Title.Edition.PP.C, where P is a fixed 
length page number, Title is a variable length Title, Edition is a variable length 
edition, and Color is a color character. Alternatively, for the ‘Main’ Title, the for-
mat is Edition.PP.C, and the Title is assumed to be Main. The desired output 
filename is Title_Edition_PP_C.tif.

As the input filename has separators, use these to scan. Use two rules to pick 
out the variants.

InFile Rule1 = %S.%S.%N.%S
OutFile Rule 1 = %1S_%2S_%3:00N_%4S.tif
InFile Rule 2 =%S.%N.%S
OutFile Rule 2 = Main_%1S_%2:00N_%3S.tif
Result = 3DTimes.FirstED1.3.Cyan -> DT_ED1_03_C.tif
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■ Using Table translation

The filename consists of E.P.C where E is an edition number (1=First, 2= 
Second), P is a page number, and C is a color code. The desired output filename 
is EditionName_PP_ColourName.tif.

As the input filename has separators, use these to scan. Use two sets of table 
rules to translate the Edition and color names.

InFile Rule1 = %S.%N.%S
OutFile Rule 1 = %1:edT_%2:00N_%3:colT.tif
InFile Rule 2 = ed1 OPName2 = First
InFile Rule 3 = ed2 OPName3 = Second
InFile Rule 4 = colC OPName4 = Cyan
InFile Rule 5 = colM OPName5 = Magenta
InFile Rule 6 = colY OPName6 = Yellow
InFile Rule7 = colK OPName7 = Black
Result = 2. 3.K -> Second_ 03_Black.tif

■ Changing date format

The filename consists of TTDDPPC, where TT is a title, D is a day number, PP is 
a page number, and C is a color. The desired output filename is: 
YYYYMMDDTTPPC.

As the input filename has fixed lengths, use these to scan. Use the date scanner, 
and do not separate PPC as this is a string needed in the output.

InFile Rule 1= %2S%ddD%S
OutFile Rule 1= %2:yyyymmddD%1S%3S
Result = AB1205K -> 20020312AB05K

� TIFF Compare

You can avoid unnecessary plate productions while re-making a new page 
version. When a new version of a page is issued with minor changes only 
affecting one separation (e.g., a spelling change on black), currently all plate 
separations are produced.

The goal is to remove duplicate versions (versions where the bitmaps are 
identical, or within some threshold) from the system.

■ Parameters
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Version comparison is not applied to all TIFF input files. The Director Engine 
decides which files to process based on expected input file names. Configure this 
by using the new “Parameters” tab in the Renaming Rules dialog box.

This accommodates the requirement to be able to restrict TIFF comparison to 
specific editions. In the example above, any TIFF file that has “AM” in the 
expected file name will be compared to the last version received and discarded 
if they are identical with that version. Any files that have “PM” in the filename 
will not be compared to a previous version.

Parameter Values can be entered by hand, which requires knowledge of 
supported parameter names and the values that they can take on. “Compare 
Tiffs” is currently the only parameter supported by Director Engine, and 
accepted values are “yes”, “no”, or an integer that specifies threshold for compar-
ison. Possible values are:

Possible Values of the Compare TIFFs Parameter

No, -1 (default) No TIFF comparison.

Yes Compare TIFF with a threshold of 0.

>= 0 Number of pixels allowed to be different. The 
Engine imposes upper limit of 100000000 on this 
value. If it is smaller than 0 or greater than the 
upper bound, then TIFF files will be compared until 
the end of the file is reached.

Note: It is an actual pixel-by-pixel comparison. 
That means it will detect if something has moved, 
depending on the comp method.
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NOTE: Parameters can also be configured by double-clicking within the 
Parameters column. This will bring up a dialog box in which you can more easily 
enter values individually for all supported parameters.

Parameters are looked up based on expected input file name. This means that 
matching is done after any input or conversion renaming rules have been 
applied.

When a TIFF file arrives in the In folder, the Engine checks if TIFF comparison is 
enabled. If it is, the Engine searches for previous (latest) versions of the file in 
the Complete folder and, if found, compares the two files.

The files are considered the same if the bit difference is less than the allowed 
threshold. If the files are deemed to be the same, the Engine deletes the input 
file, and logs a message. This message is displayed in Sheet History in the 
Client. If the files are different, the new input file is processed normally.

� Preserve Original Input Filenames

Often input files have extra information added to them. This information is not 
needed by our system, but is needed by another system (such as an inking 
system) and are fed via secondary output. As a result, plans are often configured 
using wildcards, which may result in some unforeseen problems.

This feature would maintain the input file name for later use in secondary file 
naming and annotation. When a file is renamed, the system will remember the 
original input file name. If the input file name includes version numbers (i.e., 
“2”), then that is remembered as part of the input file name. This original file 
name will be used as a variable in secondary output, or for plate annotations 
(i.e., original input file name, low imposition original input name, etc.).

■ Secondary Output

The Renaming Rule screen includes a new tab called Secondary Output that 
allows you to further modify the name to the secondary output.
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� Annotations

In the case of annotations, there is no Renaming rule, so the original file name 
(including version numbers) used is unchanged. For annotations, it should 
support the same list of selections for the “original file name” variable (%F) as 
for the “expected file name” variable (%f) (high imposition original input file 
name, low imposition original input file name, etc). 

� Variables

The following new variables are now available for use in labels, barcodes, and 
secondary output names:

%1F Lower imposition page original input filename

%2F Higher imposition page original input filename

%3F Lower even imposition page original input filename

%4F Higher even imposition page original input filename

%5F Lower odd imposition page original input filename

%6F Higher odd imposition page original input filename

%1:1F Page original input filename for row 1, column 1
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CHAPTER

Client

This chapter describes how to access and log into Arkitex Client.

� Log In

1 Click Client from the Console toolbar.

2 Enter a logon and password.

3 Select a Director or Courier server from the server drop down list.

Related topics: • For information on Arkitex Client functionality, refer to the Arkitex Client Online 
Help.

Arkitex Client is a web-based interface accessible from the Console 
toolbar.
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Arkitex Plate Builder
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Plate Builder

Arkitex Plate Builder can build page templates that allow pages to be paired. If 
an Arkitex Pair licence is purchased, Arkitex Plate Builder can be configured to 
pair 2 pages. If an Arkitex Imposer license is purchased, Arkitex Plate Builder can 
be configured to pair up to 4-8 pages. 

The Plate Builder software generates a plate template within which the user 
defines the position of all plate elements — first the position of the page on the 
plate and then any edits (additions or deletions). Plate templates are stored with 
a *.pmt filename extension in the Arkitex\Director\Config\Pef folder.

Templates may be applied to one or more editions using Arkitex Plate Builder’s 
Link button to activate the Linker module or via the Linker module activated 
from the Arkitex Console module. Editions must be activated for a link to be 
made.

Open Arkitex Plate Builder Module

When Arkitex Plate Builder is opened, a user login may be required to gain 
access. In this case, the supervisor will have allocated a user login, which should 
be entered from the Console\Configuration\User Logins menu.

Settings

The first requirement is to specify some general settings. Select View > 
Settings: 

To open the Arkitex Plate Builder module, click the Plate Builder 
button on the Arkitex Console.

CAUTION: From the Plate Builder menu bar if File > Login is selected and 
cancelled without entering a user and password, or an invalid user and 
password is entered, a message will display that says Connection refused. 
Closing the pop-up message will abort Plate Builder.
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Units of measurement may be defined in millimeters, centimeters, inches, or 
pixels.

The Colours box allows the user to choose the colors displayed on the screen 
during Arkitex Plate Builder operations.

Pages and components for which no preview is available may be defined and 
will, by default, be displayed in green. Areas of the incoming page chosen by the 
user to be erased will be displayed by default in pink. Non-printable areas of a 
plate are displayed by default in mauve.

To change any of these color displays, click on the color, and choose a new one 
from the palette.

The color of Guides used in Arkitex Plate Builder operations may similarly be 
changed and the related snap value, which defaults to 8 pixels, may be increased 
or decreased. Guides may be set to display on top of, or below, page previews or 
components when the template is being created.

The 0,0 position relates to the reference point that applies when positioning 
pages or components on the plates. By default this is the bottom, left corner of 
the plate. The Custom button will be highlighted if Settings is viewed after the 
user has defined a custom 0,0 point during Arkitex Plate Builder operations.

The first piece of information required by Arkitex Plate Builder when defining a 
template is the size of the plate, and that may be selected in a number of ways. 
Choose File > New or Objects > Select Plate. Another way is to hit the shortcut 
key, F2. A third way is to choose the Select Plate option from the toolbar.
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All 'long-hand' operations on the Arkitex Plate Builder screen menus can be 
similarly selected from the toolbar. The icons — reading from left to right — 
indicate:

■ Create New *.pmt 

■ Open existing *.pmt

■ Save *.pmt

■ Link *.pmt - (activating the Linker module)

■ Cut

■ Copy 

■ Paste

■ Undo

■ Redo

■ Select Plate

■ Select Page

■ Add Component

■ Add Text

■ Add Barcode

■ Move

■ Crop

■ Flip

■ Rotate
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■ Erase

■ Remove

■ Zoom in

■ Zoom out

The pull-down menu at the end of the toolbar indicates the item currently 
selected by the cursor.

NOTE: Some icons will be disabled because they are not relevant to the current 
task performed by the mouse (e.g., the erase icon will not be enabled unless a 
Plate has been opened).

Related topics: • “Page Definition” on page 241

Plate Definition

Having chosen Select Plate, click the New plate button. The plate size to be 
defined may be used for a number of different publications. Be careful to specify 
a plate name that is meaningful for all operators at a site. The maximum width 
and height is 1200mm each.

Any non-printable areas of the plate are defined by setting margins. For 
example, for a plate sized 350mm x 500mm, but with a non-printable area of 
30mm at the top, simply specify 30mm in the Top text box.

Click the Add button once the plate definition is complete. 

To edit a plate definition, highlight the plate definition, and select the Edit 
Selected Plate button.

Make the edits required, and click the Update button to save them.

To delete a plate definition, highlight it, and click the Remove selected plate 
button — the one with the red cross.
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The plate definitions may be viewed in three ways:

� Setup

1

2 As a text list with the next button depressed:

3 As a detailed text list with the last button depressed, whereby the dimensions 
of each plate size are shown:

As large icons with this button depressed.
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4 Once a plate definition has been created, it may be displayed by double-
clicking on the icon on the Select Plate screen, or by highlighting the plate 
definition icon, and selecting Open.

In the following diagram the plate is 350mm x 500mm and the non-printable 
margins (30mm in each case) are shown in mauve (reflecting the definition in 
View/Settings).

■ The red triangle at the bottom left of the plate indicates that this is the 0,0 
position in relation to the positioning of the page on the plate. This is the 
default setting — it may be changed in View > Settings to one of the other 
three corners of the plate.

■ Another position may be defined as the reference point. In the picture a ruler 
is displayed along the top and left of the work area. The ruler is displayed by 
selecting View from the screen menu and Show Rule (or by selecting Ctrl R). 
This works on a toggle basis so the ruler disappears if the selection is 
repeated. 

As an example, a new 0,0 point is defined to be the top left corner of the printable 
area of the plate.

5 Click on the top left corner of the rulers to see two red intersecting lines.
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6 Drag these to the top left corner of the printable area. The rulers' zero points 
move to reflect the new definition.

7 When the plate is selected, to the left of the picture the plate area 
measurements are specified in the Properties box.

8 The measurements of the plate may be changed by keying new values in to 
the text entry boxes under Properties.

NOTE: If values are changed in this way, the Plate Name changes. The ruler 
settings are also lost and will need to be re-defined.
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9 The original Tabloid definition will remain unaltered, and the new Custom 
Plate will be available for one-off use — its definition is not stored.

Page Definition

The next piece of information required when creating a template is the position 
of the page on the plate. The soft proof of an existing typical page from a publi-
cation may be used as a place holder, for example, to add press marks or delete 
unwanted marks that are incorporated at the origination site. A blank dummy 
page may also be defined to use in the template if the required size is known.

� Setup

1 Click Select Page on the toolbar.

2 To use a dummy page, select the Not received tab, and specify the width and 
height of the expected page.

3 If the page Not received option is used, a green box is displayed (green being 
the Components color defined in View/Settings).
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4 When the page is selected, its details are reflected in the Properties box. The 
top, left, bottom and right positions relate to the distance from the bottom 
left corner of the plate, which is the 0,0 point in this case (indicated by the red 
triangle). 

NOTE: The Combo box on the toolbar, which indicates that the selected item is a 
dummy page, has been created by the user. 

5 The other items known about at this stage are:

� The work area, which is the gray background part of the display. It can be 
used for placing components prior to positioning, if required.
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� The plate name — in this example, a definition named Tabloid.

6 To move the page, click on the left mouse button so that the hand clenches to 
a fist, and drag the page to the required position. 

7 A number of aids are provided to enable an accurate move. Assume the page 
is positioned at 10mm inside the top left margins of the printable area. A 
Zoom In icon on the toolbar:

� allows a particular area of the page to be highlighted and displayed in 
detail on the screen (for example, clicking on the work area, and dragging 
the cursor around the top edge of the page to form a box). 

� Alternatively, single clicks of the Zoom In button will enlarge the display 
in incremental steps.

8 The Zoom Out icon works similarly.

9 Another zoom possibility is in the bottom left of the Arkitex Plate Builder 
screen:

10 Use the marker to increase the zoom percentage, or key in a specific value in 
the text entry box.

The Navigation window is displayed on the left of the Arkitex Plate Builder 
screen.
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■ The red box represents the area of the plate being viewed. The red box may 
be 'grabbed' by clicking on it with the left mouse button, and moved to any 
part of the plate to display that particular area at the defined percentage. 

■ The side and bottom scroll bars enable fine tuning of positioning of the 
display.

Guides may be created to help position the page within the printable area. In the 
example, the 0,0 point has been set to the top left of the printable area of the 
plate.

� Guides

1 If a 10mm margin is required inside the printable area, select Show Guides 
from the View menu.

2 Click on the top ruler.

3 Drag the newly created Guide down to the marker on the left rule indicating 
-10.

4 Similarly, click on the left ruler.

5 Drag the newly created Guide across to the marker on the top ruler indicating 
10. 

6 To revert to the ‘fit in window’ size (100%), click on the icon in the Zoom 
window.

7 Now click on the page and drag its top left corner towards the intersection of 
the two guides.

8 The snap value defined in View/Settings will act as a magnet as the page 
arrives, to ensure that the page aligns perfectly with the guides.

� Dependent upon if the Show Guides option is enabled in the View menu 
and your choice in View/Settings, the guides will display on top of or 
below preview pages and components. Multiple guides may be created 
throughout Arkitex Plate Builder operations to enable components to be 
accurately positioned. To remove a guide, select it and drag it back into 
the ruler.

� When dragging the visual page into position, the contents may be viewed 
while dragging or not, depending on if the Show contents while 
dragging option is enabled under the View options on the screen menu.
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Depending on whether the options are enabled in the View menu, the following 
information is also displayed:

■ Rulers

■ Components

■ Erased areas

■ Orientation and references of pages and components 

In addition, if the Selected Erased area transparent option is enabled, erased 
areas can be made transparent when selected.

Another useful tool is the ability to show a border around pages or components, 
which makes it easier to position them.

So far the examples have used a green dummy page. A visual dummy page is also 
available. In the following example, page 1 of the PARIS edition has arrived, and 
a Soft Proof has been generated, which may be viewed on the screen to work 
with if required.

� Preview

1 Click Select Page on the toolbar:
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2 Click the Show Preview box to see a thumbnail display of what PARIS01 
looks like.

3 Select Add to view the page positioned on the plate.

4 A warning message may appear indicating that the width and/or height of 
the page does not match the existing soft proof.

� Arkitex Director and Pair compares the size of the page it received with 
the size of the Soft Proof it generated according to a tolerance defined in 
System Setup. If this page belongs to an edition where the Label option 
has been applied using Publication Builder, a template will already have 
been applied to that page and may have increased the size of the page that 
will end up being output.

� For example, if a barcode is to be automatically generated by Arkitex 
Director and Pair and positioned to the top and left of the page on the 
plate, then the Soft Proof (reflecting final output) will be wider and 
deeper than the page that first arrived in Arkitex Director and Pair.

� The warning message allows the choice to display the existing Soft Proof 
or to generate a preview for use in Arkitex Plate Builder that relates only 
to the original incoming page.

5 If the page has not yet been placed into the Arkitex\Director\In folder (i.e., 
not yet in production), the Browse screen in the Open Page Menu can be 
:Arkitex Workflow Reference Guide



 

7 ARKITEX PLATE BUILDER 247
used to locate the page and position it on the plate prior to production. This 
is especially useful when planning multiple pages.

6 If using composite input, press Add to place that page on the Arkitex Plate 
Builder canvas

7 However, if using separated input as shown above, select multiple separated 
files to position on the canvas.

� In the screenshot there is a close-up of part of the Browse screen.

� The green page icon indicates that Arkitex Plate Builder has automatically 
created a preview for this file. The gray page icon indicates that a preview 
has not yet been created for this file.

8 To create a preview for this file, click on it, and wait for the cursor to change 
from an hourglass back to a cursor.
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9 When the preview for this file is created, the page icon will change. The file 
will be sent for preview granulation via the same channels as configured for 
Soft proof generation.

10 When previews have been generated for each separated files (all page icons 
are green), select to view these separations as a composite page by selecting 
all separations with the mouse (use the keyboard Ctrl button to select 
multiple files), and clicking on the Composite Preview, Generate button.

11 If files that do not have preview previously generated are selected, the 
following message will be displayed.

NOTE: A composite preview does not need to be generated. Just use one of the 
separated files for placing the page within Arkitex Plate Builder. But only a 
grayscale preview of that individual separation would be seen.

12 If the colors assigned to each color is not displayed correctly, use the pull 
down menus below each of the separated files to select the correct color; then 
repeat this task for each separation.

NOTE: If all the assigned colors are not identified, a warning message will 
appear: “Please select the identifier of each separation”. If the same color is 
accidentally selected, a message will appear: “Colour separation has to be 
unique”.
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13 Press the Create Preview button, and an hourglass will appear for a few 
moments while the Soft Proof is being generated.

14 After the composite preview has been generated, press Exit to return to the 
Add component screen.

Related topics: • “Settings” on page 234
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Properties Dialog Box 

Look at the Position, Operation, Align, and Orientation options at the bottom 
of the Properties box. 

� Position

The Position options allow selection of any page element, e.g., page or text label, 
and position it in a specific position within the Plate.

� Operation

There are two modes of operation for positioning the pages and page furniture: 
combine and overwrite.
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When the Operation Icon displays rectangular images that are opaque, the 
Overwrite mode has been selected.

When the Operation Icon displays rectangular images that are transparent, the 
Combine mode has been selected.

The Operation Icon switches between each mode when clicked with the mouse.

The easiest way to understand these operands is to consider the example of two 
mono pages placed one on top of the other (page 1 and 2).

At output time, the system needs to know which page element should be on top 
of which; i.e., which page element is laid down first. However, it also needs to 
know whether the page on top will erase the one underneath completely (to 
overwrite it), or whether to display the data of both pages simultaneously 
(combined). To lay page 1 down first, with page 2 erasing it completely, page 2 
would have to be defined with an overwrite operand. Page 1 could be defined 
with either a combine or an overwrite operand because it is laid down first.
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This would result:

In the following example, page 2 is defined with a combine operand.

Page 1 may be defined with either a combine or an overwrite operand, because 
it is laid down first.

The combine/overwrite consideration needs to be made with regard to pages 
and to components.

� Operand

1 To apply the operand, select the page element with the mouse.

2 Click on the Operation Icon.

3 Select the correct operand mode by clicking on the Operation Icon to switch 
from Combine to Overwrite.
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� Align

Sometimes pages may be input for this edition that do not conform to the single 
page size defined above. The Align option specifies where such pages (whether 
larger or smaller) should be positioned in relation to the usual single page 
position.

1 Choose left, right, centered horizontally and top, bottom or centered 
vertically.

2 To apply this option, click on the page element, and then select the required 
form of alignment.

� Orientation

A plate (canvas), page, and page elements (including text and barcode) may be 
positioned at a different angle in relation to the x,y origin and mirrored, 
according to the right read/wrong read requirements of the printing production 
using the Orientation option.
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Looking more closely at the screen, the plate and each page element have an AB 
Icon indicating the orientation of the element.

There are six orientation choices: right reading 90, 180 or 270 degrees; or wrong 
reading 90, 180 or 270 degrees.

A request to orientate at 90 degrees will turn the page clockwise from the bottom 
left and will retain the origin of the new position at the defined parameters. 

A request to move the page right-reading, 90 degrees would move the page as 
follows:

The effect is of a 90-degree rotation; however, the x and y position of the page 
remains the same.
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A request to move the page wrong-reading, 90 degrees would move the page as 
follows:

NOTE: If using Arkitex Plate Builder to rotate or flip pages, remember to check 
the RIP Page Setups to ensure the RIP Page Setups are not additionally rotating 
or flipping the pages. Otherwise the rotation/flipping will be duplicated.

Rotate and Flip Tools

Another way to apply a single rotate action to a page — or any page element — 
is to select the Rotate icon on the toolbar and then select the item to be rotated.
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If Ctrl and the Rotate icon are pressed down together, consecutive page 
elements may be clicked, and the rotate action will be applied to all.

Flipping is useful when incoming pages have been prepared for film output. If 
wrong-reading input is received, clicking the Flip button, and then clicking the 
item to be flipped, will switch it to right-reading. The Flip button works on a 
toggle basis — the next time it is clicked, the item’s display will revert to wrong-
reading. 

If Ctrl and the Flip icon are pressed down together, consecutive page elements 
may be clicked, and the flip action will be applied to all.

Erase

At the top left of our example visual page dummy is text running across and 
down the page. Imagine this arrives on every page from a particular editorial 
site, and it needs to be erased before output. Click on the Erase icon on the 
toolbar:
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Then click and drag a rectangular shape over the area to be removed (shown in 
pink here — the color reflects the definition in View/Settings):

The erased area, as any other item, may be moved, sized or deleted. To delete an 
item, click on the Remove icon on the toolbar,

and then click on the item to remove. Confirm removal of the correct item when 
prompted.

The Ctrl button may be used with the Erase and Remove buttons to effect 
multiple actions as described under Rotation and Flip above.

Apart from removing unwanted marks/areas of incoming pages, the following 
may be added:

■ Components such as color strips etc.

■ Text strings

■ Barcodes

These may be applied to both printable and non-printable areas.
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Add Component

By selecting the Add Component icon from the toolbar:

This screen will display:

There are two types of file format that can be used as components in Arkitex 
Director and Pair: pre-separated and composite components. An example of a 
separated component may be from a set of scanned CMYK films. Each color layer 
is a separate file seen by Arkitex Director and Pair that makes up a component. 
The file has a matching file name structure, and the color identifier is in the same 
position for each layer. An example of a composite component may be from a 
graphic saved as an EPS file from Photoshop. This is a single file containing 
multiple color layers.

Composite components must be used in a composite workflow, and pre-
separated components must be used in a pre-separated workflow. Composite 
components cannot be mixed on a pre-separated page, or vice versa.

� Components

1 To use a component in Arkitex Director and Pair, copy the file(s) (whether 
they are single composite files, or multiple separated files) into the Arkitex 
\Director\Components folder.
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2 Providing that the Engine is started, these files will be collected from the 
components folder and sent for preview generation, if the file does not 
already have a valid preview attached (i.e., EPS with a view file from a MAC 
or PC).

3 The file will be sent for Soft Proofing via the same channels as configured for 
full Page Soft Proofs.

4 When the Soft Proof preview files have come back from the RIP, the Engine 
will advise the preview for Arkitex Plate Builder is done. The file can then be 
previewed in Arkitex Plate Builder.

5 A preview of the component may be seen if the Show Preview box is 
checked.

� In the screen shot a component exists called 1016dot. This is a composite 
component. Composite components may only be applied to incoming 
composite pages. 

� If incoming pages to which a template is to be applied are separated, then 
separations must be generated of any components for placing in the 
template. In the screenshot, the separated components are 1016dot.c, 
1016dot.m, 1016dot.y, and 1016dot.k.

� If the incoming file is a composite component, then the preview will 
typically appear automatically in color.

� If using composite components, and using a Contone Soft Proof RIP Page 
Setup or Contone Soft Proof with Ink Presets RIP Page Setup, a color 
preview will display in the Add Component screen. However, if using a 
Bitmap Soft Proof RIP Page Setup or Bitmap Soft Proof with Ink Presets 
RIP Page Setup, a grayscale preview will display. 

� Preview

If the incoming file was a separated color file (i.e., 4 separate TIFF files), there 
will be four separate preview files, one for each color.
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1 Use this feature to generate a composite preview of the four separate files to 
see this component in color when placing it within Arkitex Plate Builder. 

NOTE: A composite preview does not need to be generated. Just use one of the 
separated files for placing the component on the page within Arkitex Plate 
Builder. But only a grayscale preview of that individual separation will display.

2 Next click on the pull down menus below each of the separated files just 
inserted.

3 From the pull down menu select the separation relevant to that separated 
file; then repeat this task for each separation.

4 Press Create preview, and a Generating Soft Proof message will appear for 
a few seconds while the Soft Proof is being generated.
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5 The composite preview has now been generated. Press Exit to return to the 
Add component screen.

NOTE: If a composite preview is generated, use the Change per separation 
check box when placing components on the page in Arkitex Plate Builder.

Arkitex Director and Pair have a useful tool where only one of the component 
layers needs to be used for positioning.

6 To enable this feature, select the Change per separation box.

7 The 1016dot.c is highlighted, and Arkitex Plate Builder has assumed that the 
*.C extension of the component’s name relates to its color and has 
highlighted the C in red.
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8 It has also fed into this screen the information that the color id starts at 
position 9 in the filename and is one character in length.

9 1016dot.C can now be positioned on the template, and it will be applied to 
an incoming cyan separation of a page to which that template is linked.

� Because Change per separation was separated, the same template will 
apply 1016dot.K to the incoming black separation of that page — and 
1016dot.M to the incoming magenta separation of that page... and so on.

10 In the Composite ID box specify which character is being used as a dummy in 
the composite component filename.

11 If this template is applied to a mixed edition of composite and separated 
input, then Arkitex Director and Pair will be able to apply the correct compo-
nent to the composite pages. In the example, the number 1 (of 1016dot.1) 
should be entered here.

If advised to expect an ad (regarded as a component) to be stripped into a 
particular incoming page, a template may be prepared ahead of time even if the 
ad has not yet arrived, as long as its file name and size are known. This template 
will appear in green.

12 Select the Not Received tab:

13 Enter the name of the expected file and its width and height as prompted. 
Again the Change per separation tool is available.

When the ad arrives, it should be input – as all components should – into the 
Arkitex\Director\Components folder. Some high-resolution component files 
also include a preview. If Arkitex Director and Pair does not find a preview, it will 
send a copy of the high-resolution component via the Soft Proof queue to the 
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GRAFIXrip in order to generate one (which will be returned for display in the 
relevant screen in Arkitex Plate Builder).

NOTE: Depending upon the setup, the Soft Proof queue may be routing files to a 
page setup that generates single black separations per layer. The Engine then 
recombines these and colors them accordingly so that Soft Proof pages can be 
viewed. 

14 To apply a component to a template, click the Add button.

Components may be moved into the required position on the template as 
described previously for pages — onto printable or non-printable areas. They 
may also be scaled, sized or cropped and locked into position.

Related topics: • “Crop” on page 263

Crop

Arkitex Plate Builder has a crop tool, positioned between Move and Flip on the 
icon bar.

The following example positions a component in the left corner of the page. The 
component has a large area of white space around it which needs to be cropped 
out before positioning.
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� Setup

1 Select the Crop tool, and pull down the white space until it reaches the top of 
the graphic.
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2 Repeat, pulling the white space across from the right.

3 Under the Properties box, click the Crop tab to see that the top of the compo-
nent is now 10.345mm less wide than the original file and 118.830mm less 
high. These figures may be adjusted here if required for pinpoint accuracy.

NOTE: Once the crop has been implemented, the component can be placed.
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� Lock Elements

■ Page elements can be locked into position on the template by clicking the 
padlock under Properties while the component is selected.

■ Another way to lock a component is to choose Objects/Lock from the pull-
down menu.

■ A third way is to select the component and right mouse click to see this:

■ To lock a component, select Lock. To unlock a locked component, select 
Unlock. To delete a component, select Remove.
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� Move Up/Down

■ In the following example, a CMYK strip has been placed on top of the circles, 
which is positioned on top of the page dummy. With the circles highlighted, 
if Move Down is selected, it will be positioned beneath the page.

■ If Move Up is selected, it would be positioned on top of the CMYK strip.

■ With the CMYK strip selected, if Send to Back is selected, it will be positioned 
underneath the page.
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� Add Text

1 To add a text string to the template, click the Add Text icon on the toolbar:

2 This screen will display:

3 Key the required text in the Label entry box. A number of variables are avail-
able for inclusion by clicking on the Variables arrow button.

The fonts available for use with text strings are shown in the combo list and will 
have been entered previously from within the Arkitex Console settings. The 
fonts listed must be available on the RIP, and their naming in Arkitex Plate 
Builder should match exactly their naming on the RIP (i.e., case sensitive).
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Alignment — left, right or centered— relates to the positioning of the text string 
on the template.

The picture shows that a text string has been added within the non-printable 
area of the plate. The string itself is not visible on the graphic. If the cursor rests 
on the graphic, the tool tip will display the text string. 

The text is also displayed in the Properties box:

■ %0f Sheet output filename

■ %t Total number of sheets

■ %c Color name

■ %0d Publication date

The text may be changed in the Properties box, followed by hitting Return on 
the keyboard.

The text is also displayed in the combo box at the top of the screen, which lists 
all the elements included in this template.

Because left alignment was chosen, the tip of the red triangle indicates the 
starting y position of the text string. 

� Pivot Point

The Pivot Point gives the exact resting place of the bottom left edge of the text 
string. This point is indicated on the text string graphic by the red place holder 
at the bottom left.
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■ Remember that text characters are printed with 'shoulders' of white around 
them, so the pivot point takes the white area into account.

■ The position of the pivot point may be fined tuned by entering values into the 
X and Y boxes.

If the alignment is changed from Left, Right, or Centered using the box within 
Properties, this is the position result of text moving.

■ Text labels may be re-positioned using the Position, Operation, Align, 
Orientation options, or the Flip and Rotate tools However, the bottom left 
corner of the component is always positioned at the Pivot point regardless of 
its rotation.

■ In the example where right alignment has been chosen, the red square acts as 
the reference marker, indicating the y point at which the text string will 
finish.

� Changing Fonts

The chosen font is also displayed in the Properties box and may be changed 
without the need to re-open the Add Text definition. Select from the Properties 
box.
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� Variable Name

In the Plate Item ID field, each Plate Builder variable added to the plate is given 
a name, in this example Label003. The default name configured by Plate Builder 
can be used for this name, or it can be renamed to a specific name (if required) 
by deleting the current name and re-typing a new name in the Plate Item ID 
field.

Add Barcode

This works on exactly the same principle as the Add Text option, except that the 
font list available includes only those fonts defined under Console > File > 
Configuration > Plate Builder as barcode fonts.
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The graphic showing an added barcode looks like this:

Below is an enlarged version of a barcode.

When the barcode component is selected, a red square is displayed indicating 
the left alignment of the page element.

Conditional Plate Furniture

Plate furniture can be defined so that it only appears under certain conditions.

■ A label “Section A” will only appear if the variable %S=AA. 

NOTE: %S is the section short name.

■ For pairs there might be a color bar or gray bar between pages. Only include 
a color bar if either page is color.

■ If neither is color, use the gray bar.
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■ If the low imposition page number is color, or the second page on the same 
plate is color, print the component on the plate.

NOTE: Conditional components are actually variable plate furniture. Although it 
describes a component, it is also valid for other plate furniture.

■ One template can be defined instead of multiple. Certain newspapers might 
add a registration mark or a press ID on a specific page number.

� Rather than defining a separate template for page 5, a component may be 
assigned a condition where the component only appears if the page 
number is 5.

Shortcut Buttons

There are five shortcut buttons to the bottom left of the Arkitex Plate Builder 
screen:
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They toggle their features on and off.

■ The first is View On/Off and relates to the viewing of erased areas. It is a 
shortcut to the View/View Erased Areas setting on the menu bar.

■ The second is Show/Hide Components and is a shortcut to View/Show 
(Hide) Components. A page may be viewed in a template with the compo-
nents either visible or not.

■ The third is Guides on top/bottom and is a shortcut to View/Settings.

■ The fourth is Show/Hide while dragging and is a shortcut to View/Show 
contents while dragging. The contents of components may be viewed, or not 
as preferred while dragging/positioning. 

■ The fifth is Make selected Erased area transparent On/Off and is a 
shortcut to View/Selected Erased area transparent. If an Erase area is 
selected, it can be made to display as the chosen color or transparent.

Imposing Pages

If either of the Imposition licences have been purchased, Arkitex Plate Builder 
will have the ability to impose more than one page on a plate. There are two 
Imposition licenses, an Arkitex Pair license which allows the imposition of 2 
pages per plate, and the Imposer license which allows the imposition of up to 8 
pages per plate.

When configuring imposition of multiple pages, it is especially important to 
ensure the orientation of the plate is correct.

Before creating a multiple-up plate, it is important to consider the following:

■ The size of the plate

■ The size of the pages to be planned

■ The number of pages to be planned

■ The image area of the film imager (if outputting to film)
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■ The image area of the plate imager

■ Required margins

■ Whether a printing blanket will be used to print from

All of the above will affect the orientation of the plate and the pages.

In the example the page placed on a plate has a number in its bottom, left-hand 
corner. This is the lowest page number placed on the plate so far.

� Change Orientation

However as previously mentioned before extra pages can be added to this plate, 
consider the orientation of the page and the plate. 

1 In the example to plan up 4 pages, and image the plate from left to right (not 
from bottom to top), change the orientation of this plate and this page.
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2 The plate and page have been rotated using the Orientation option.

NOTE: As each customer configures their plates differently, the following 
plate layout is purely a guide to demonstrate how to create an imposition of 
multiple plates within Arkitex Plate Builder, and is not an instruction of how 
to configure plates.

3 To add an extra page to the plate, click on the Page Icon and add a plate.

4 Or, copy the existing page, and paste it on to the plate.
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5 To Copy and Paste the existing page, select the existing page.

6 Either select Copy and Paste from the Edit menu.

7 Or, right-click with the mouse, and select Copy and Paste.

In the example the second page placed on a plate has a different number in its 
bottom, left-hand corner. This is the second and highest page number placed on 
the plate so far.

The Change page flow order option on the shortcut menu can be used to 
change the page order.
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8 Continue adding pages until there are 4 pages on the plate.

NOTE: Up to 8 pages per plate are supported.

In the example 4 pages are now positioned on the plate. At present, all the pages 
have the same orientation; e.g., they are all facing in the same direction. The 
orientation for two of the pages has to be changed as they will be printed head 
to head, or top to top. 

The pages needing changes are 3 and 2:
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9 Begin to add the page furniture.

10 Ensure any components, text, and barcodes are also oriented.

NOTE: In the example, some page elements are rotated 90 degrees; some are not.

■ An example of a plate with 8 pages imposed is shown.
:Arkitex Workflow Reference Guide



280 IMPOSING PAGES
■ To fit all the pages onto one plate, many different orientations are used.

Related topics: • “Properties Dialog Box” on page 250

Direct Printing To allow for printing onto film or direct to press (without a blanket), the 
orientation of each page can be changed to wrong-reading, yet still reflect the 
correct amount of rotation.
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Fan Out Fan out is the horizontal stretching of newsprint as multiple inks are printed to 
the paper. The stretching is due to water absorption into the paper and causes 
the paper to stretch. The result is apparent mis-registration.

There are two means by which Arkitex Plate Builder enables users to overcome 
the fan-out problem.

� Fan Out

The first method is to create multiple *.pmt files which can then be assigned to 
individual sheets. 

The second method is to purchase the Arkitex Fan Out Cost Option. For each 
page on a template, the user can enter Fan-Out Adjustmenrt details for each 
possible color, as well as information about the page that is not color related.

1 Right-click on a page in the template to be able to select Fan Out. The 
following screen appears:

2 For each page on a template, enter Fan-out Adjustment details for each 
possible color, as well as information about the page that is not color related. 

3 Spot colors are handled as follows:

� Spot 1 takes the Fan-Out Adjustments for Cyan
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� Spot 2 takes the Fan-Out Adjustments for Magenta

� Spot 3 takes the Fan-Out Adjustments for Yellow

4 The X and Y Offset causes the position of each page on the plate to move 
position. This can be either a negative or a positive number and indicates 
how far to adjust the page.

5 The X and Y Scale causes the amount of scaling in the dimensions of each 
page layer to change. This amount is supplied as a percentage.

� Scaling only works with true symbolic EPS and PDF. Ripping occurs after 
imposition or after pages are put onto plates.

� TIFF cannot be scaled because scaling works for the entire plate, not for 
separate elements.

Set Anchor Point - When using X or Y scaling to adjust for Fan-Out, there is an 
implied “Anchor Point”. This is the position on the plate from which the page is 
stretched. The Anchor Point is set by selecting one of the four corner radio 
buttons displayed in Set Anchor Point.

■ Anchor identifies the zero point, a fixed point. For each color layer there can 
be a different zero point by adjusting the X position for each layer.

■ For TIFF the zero point can be used to adjust the position on the page, but not 
for individual scaling.

All Fan-Out adjustments are reflected in the soft proof thumbnails displayed in 
the Arkitex Client.

Growing Gutters As an edition is printed, the gutter needs to grow between each page to cope with 
the increased thickness of the edition as the pages are folded over each other. If 
an allowance is not made to cope with this increased gutter size, parts of the 
printed page are hidden to the reader.

Arkitex Plate Builder enables users to overcome this creep problem by creating 
multiple *.pmt files containing increased gutters between pages, which can then 
be assigned to individual sheets. 

� Saving Arkitex Plate Builder files:

Once a template has been completed, it needs to be saved using an appropriate 
name. This may be up to 25 alphanumeric characters in length, but should not 
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include spaces or \ /:*?"<>|. Remember that one template may be applied to 
several editions. 

1 Go to File > Save.

2 Arkitex Plate Builder will automatically apply a *.pmt extension to the 
chosen filename and save the file in the Config\Pef folder.

Activating the Linker module from Arkitex Plate 
Builder

In order for the page elements to be applied correctly and automatically to 
incoming pages, the template must be linked to the relevant pages. Within the 
Arkitex Plate Builder program a template must be open (i.e., displayed on the 
screen) in order to be linked. Linking within Plate Builder is typically done 
immediately after creation of a template.

■ To link previously defined templates, it is not necessary to enter the Plate 

Builder program — use the Linker button  on the Arkitex Console.

■ To link a template within Arkitex Plate Builder, select the Link  icon 
from the toolbar to activate the Linker module.
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Arkitex AutoInk

The AutoInk module allows ink density calculations to be made automatically by 
Arkitex Director and Arkitex Pair. The ink parameters are created in the IDT (Ink 
Density Table) format.  The InkCalc data is routed to the InkCalc folder with an 
*.ik extension. This data file contains information that is used by the customer’s 
Ink Press Control system to determine the amount of ink coverage used per ink 
column. This is a valuable way to decrease press startup time and minimize 
newsprint waste.

Calculating Ink Coverage

Arkitex now has two methods of calculating ink coverage.

■ The old method of ink calculation used by AutoInk is the same as that used by 
Integrator.

■ The new method allows outputs in the following formats: Ink Column 
Percentages, CIP3 data, XML data, or in a custom data type.

The old and new Ink Preset methods are selectable in System 
Setup\Engine\Ink Presets\Ink Presets Calculation Method. Set the value to 
0 to use the new method (default), or 1 for the old method. After changing this 
value, restart the Engine, Console, and Publication Builder for the changes to 
take effect.

Related topics: • Arkitex Workflow System Administration Guide, Part Number CG+0948500001

� Creating Ink Presets Profile

1 Open the Ink Presets module.

2 A Units value can be set to inches, pixels, or millimeters.

From the Arkitex Console, click on the Ink Setup icon to bring up the 
InkCalcConfig window.
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3 Click on the Add a new Parameters section icon. This will add a Parameters 
icon and parameters.

4 If the unit of measure is inches, rename the parameter Name to Set Units to 
Inches.

5 Edit the parameter window to Units = Inches.

� Establish Filter Column Parameters

The Parameter section is like a filter, and the conditions should be set so that 
only specific pages will use the calculations in this parameter.

1 Click on the Add a new Parameters section icon. This will add a Parameters 
icon and parameters column located on the left-hand side of the screen.

2 In the Name field, rename the parameter to an appropriate name.
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3 Set the appropriate conditions for this parameter. 

� Edit Plate Layout

1 Click on the Edit the Plate Layout icon.

2 Select the Units preferred.

3 Select the appropriate Top and Left Tiff Mask value.

4 Select the appropriate page Height and Width value.

5 Select the appropriate TIFF DPI value.

6 Select the appropriate AB symbol depending on whether the image is rotated 
and/or wrong reading. 

7 Set the number of columns (10 for example). Take the remaining page width, 
and divide it (by 10 for example). Place this value in every column.

CAUTION: All Filter\Column parameters must be supplied before creating 
the Ink Percentage, or CIP3 Image section.
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� TIFF Parameter Testing 

There is a way to test an actual TIFF file to see what the file will look like if 
columns and TIFF masks are displayed on the page.

1 Click on the Crossed Rules  button.

2 Browse to a TIFF file.

3 Click Save. This will create a new TIFF file with the original name, and an 
.out.tif extension added at the end.

4 Double click on the file, and the Imaging program will show exactly how the 
Ink coverage column will appear.

� CIP3 Image Section

Parameters can be passed from Director to the InkCalculation file.

1 Click on Add a new percentage section, or Add a new CIP3 Image section. 

NOTE: This should always be the last parameter in the ink parameters list.
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2 Supply the parameters in the Parameter field to be passed in Publication 
Builder.

NOTE: The parameters need to be separated by a colon.

3 Text can be added that will allow passing parameters into the ink calculation 
file. In this example, these parameters have been added:

Sheetname = <CmdParameter(1)>

Shortname = <CmdParameter(2)>

4 After all the settings are complete, the InkCalcConfig should be saved as a .ini 
file to the Arkitex\Director\Config\InkPresets folder.

5 This file will be selected from Publication Builder.
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Related topics: • AutoInk Reference Guide, Part Number CG+095140001.
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Activate

This chapter describes how to activate editions.

� Activate Editions

1 Select an edition file from the list, and click the Activate button.

NOTE: Multiple editions may be selected by holding the Shift key.

2 The *.pmd files displayed are those stored in the default CONFIG folder. To 
search for a *.pmd file stored elsewhere, use the Browse button.

3 The *.pmd files may be deleted by highlighting one or more, and clicking the 
Delete button.

The Activate button activates edition *.pmd files. Previously 
defined edition instructions can be loaded into the Arkitex Director 
and Pair database without entering Publication Builder.
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NOTE: A currently activated edition is not removed from Arkitex Client if the 
*.pmd file is deleted in this way. Arkitex Client continues to display edition 
instructions until they are purged from the database using the Manual Purge 
Utility.

4 When finished activating editions, clicking the Exit button to leave the 
screen.
:Arkitex Workflow Reference Guide



CHAPTER

Linker

This chapter describes the Linker module.
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Linker Button

■ The Linker module cannot be activated from the Console if Plate Builder is 
activated. It can only be opened using the Links button in Plate Builder.

■ The Linker module is only available if the Plate Builder license has been 
purchased.

� Activating Linker via the Console

When the Linker module is activated from the Console, Arkitex Director and Pair 
will allow selection of any *.pmt file to link to editions listed in the Link 
Template screen.

The Linker module can be activated by selecting the Linker icon 
from the Arkitex Console, or by selecting the Link button from within 
the Plate Builder module.

CAUTION: When changing .pmt files for each edition, only .pmt files that 
impose the same number of pages per sheet can be interchanged.
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NOTE: The Link button will not become enabled until a *.pmt file has been 
loaded into Linker.

� Activating Linker via Plate Builder

When the Linker module is activated via Plate Builder, it will assume to link the 
current *.pmt file open in Plate Builder to the editions listed in the Linker screen.

Using the Linker

The standard Linker functionality is the same if the Linker is activated via Plate 
Builder, or the Console.

� Show Sheets

1 You can choose to show sheets or pages for linking.

a Click the drop-down arrow.

b The option box displays.

2 Sheets display with green circles if they are already linked to templates. The 
template name will be appended to the composite and separation layers.
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� Page Options

Pages display with red circles if they are not linked to a template.

NOTE: The composite and separation layers do not have a template name 
displayed.

The All Sheets check box is used to select all sheets at that level for that page.
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A composite is always listed, followed by each expected layer, so that the 
template may be applied automatically whether the sheet arrives as a composite 
or separated input.

NOTE: It is not necessary to remove an existing template in order to link a new 
one. If requesting a link to a sheet/separation where a link already exists, an 
overwrite prompt will appear.

� Partially Linked

If there is a blue circle, this indicates that the sheets of this edition are only 
partially linked.

NOTE: Only the Cyan layer is linked to a template and has a green circle.

Refresh The Refresh  button updates the screen display after making changes.
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Selection Options The display view can be filtered using Selection options. All, Odd, Even, None, 
Monochrome sheets/pages, and Color sheets/pages can be chosen.

■ All odd pages are displayed:
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Color Selections Colors selections allow you to select a color and have it automatically checked 
on all pages:

■ All black separation layers have been selected. This makes it easier to link a 
template to a specific layer.
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Expand Options All pages, pages that are Fully Linked, Partially Linked, or Not Linked can be 
expanded in the display:

■ Only fully linked layers are expanded:
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Collapse Options The expanded display can be collapsed by All pages, Partially Linked, Fully 
Linked, and Not Linked.

■ Only full linked pages are collapsed:
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Linking When Link is selected, a link message is sent to the engine: 

Link Different
Template

Separate layers, pages, or sheets can be selected and linked to different 
templates.

■ Page 2 has been linked to the template JRPDF Broadsheet.pmt. The name is 
displayed in each layer name for Page 2.
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Exit When Exit is selected, a prompt will appear asking Are you sure. Selecting Yes 
will close Linker.
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This chapter describes the Manual Purge Utility.
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How Manual Purge Works

Manual Purge works with the Engine and Client Tracking and should be run 
regularly.

� Starting

1 Click the Manual Purge icon.

2 A password prompt will appear.

3 Enter your password.

NOTE: 
1. Manual purge is only available to users with system administrator permission.

2. The Engine or Client modules do not need to be closed when the utility is used.

4 The Manual Purge dialog box displays.

Manual Purge
Modes

There are four display modes, depending on the configuration in System Setup: 
Basic, Multiple, Advanced, or Scheduled purging.

■ Basic Mode

In System Setup > Manual Purge, if the Purge Mode is set to ‘0’, the basic 
Purge Utility screen will display.

Manual Purge is accessible from the console using this button, and 
from the Windows Start Menu via Start > Programs > Arkitex 
Director > Manual Purge.
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Basic mode does not allow selection of specific editions for deletion or for 
resetting. Log message deletion is located on the same screen instead of under a 
separate tab as in Advanced mode.

� Scenario:

As an example, incorrect pages 8 and 9 have been sent.

■ There is no change in the edition instructions — the first output needs to be 
disregarded.

■ As it is so near the beginning of the production cycle, the edition will be reset 
to clear the display: “pages 8 and 9 have been received and output”.

■ With the edition selected, clear the Client Tracking display by:

� Clicking Reset.

� Selecting Clear.

� Reactivating the *.pmd file.

■ In each of these cases, the incorrect pages 8 and 9 will still exist in the 
COMPLETE folder.

� Steps:

1 To reset and remove the files, check the Delete associated files box before 
clicking Reset:
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2 To delete log messages relating to pages 8 and 9, check the Selected edition/
output location box before clicking Reset.

� Messages that are more than one day old will be deleted. This is the 
default setting.

3 To save a log backup file before the messages are deleted, check the Save a 
backup log box. 

� In this example, the ‘older than’ entry has been changed to 0 days.
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4 The Engine generates a number of system messages during processing. These 
messages can be deleted at the same time.

NOTE: In this case, general messages not relating to any particular edition(s) 
will be deleted.

5 If Delete were clicked instead of Reset, the edition would be removed from 
the Tracking display in Client. The edition would not display in the Client 
Publication Tree, and the Engine would no longer recognize incoming pages.
:Arkitex Workflow Reference Guide



310 HOW MANUAL PURGE WORKS
NOTE: The *.pmd file is not removed using this method. Use the Activate 
button on the Console to delete *.pmd files from the CONFIG folder.

6 To purge all currently activated editions at once, highlight All Editions, and 
click Reset or Delete.

■ Multiple Mode

To select multiple editions for deletion or reset, in System Setup enable 
Multiple purge selection. Boxes will appear in the display to select multiple 
editions.

■ Advanced Mode

To select Advanced Purge Mode, set Purge Mode to ‘1’. Screens are now 
configured to Delete the edition/s plus associated files without deleting log 
messages. The utility now has two tabs: Editions and Log Messages.
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■ The Log Messages displays a list of editions for which messages are currently 
being held:
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NOTE: If Purge Mode in System Setup is set to ‘1’, delete log messages at regular 
intervals to maintain system performance.

� Scheduled Purges

1 To automate when the Arkitex Director and Pair system is purged, press the 
Schedule button.

NOTE: The first time Schedule is pressed, a Purge Configuration message will 
display advising that no Purge Tasks have currently been defined, and asking if 
a task should be created. If Yes is selected, the Create Purge Task menu 
appears. The Purge Configuration message will also display if all Purge Tasks 
have been deleted.

2 To create a new Purge Task, select File > New from the Purge Configuration 
screen.

3 To edit or delete an existing task, highlight the name, and select File > Open, 
or File > Delete.

Shortcuts

The Purge Configuration screen has the following command shortcuts:

� New

Select Ctrl + N, or click on the icon.
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� Open

� Run

� Refresh

� Delete

� Main Menu

The shortcut options are also available from File on the main menu:

Select Ctrl + O, or click on the icon.

Select Ctrl > R, or click on the icon.

Select F5, or click on the icon.

Select Delete on the keyboard, or click on the icon.
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1 To manually activate a Purge Task, highlight the task, and select File > Run.

2 Use Refresh to update tasks after a purge has been run, or when Purge Tasks 
have changed.

3 To activate, select File > Refresh.

4 To delete a task, select File > Delete.

5 To exist the purge utility, select File > Exit.

Configure Tasks

The first step when configuring a task is to decide on a name to identify the task. 
Type this name in the Name field. The next step is to choose the type of task to 
create:

� Delete or Reset Editions

This task allows editions to be deleted or reset, and their associated files to be 
deleted, reset, and backed up.

� Remove Files

This task allows files to be removed or archived to a different location.
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NOTE: While creating a task, if an error is made during configuration, the Back 
button can be used to return to a previous screen. Alternatively, the 
configuration process can be stopped by pressing the Cancel button.

Configuring a Purge Task

If this type of task was created, the next screen will display the Purge Editions 
and Schedule screens only.

� Purge Editions Screen

1 In the Purge Editions screen, the name of the Purge Task under creation is 
displayed in the title bar of the menu and by the title Name. The type of 
editions to purge must be configured in this screen.

2 The conditions for purging can be via ‘x’ number of Minutes/Hours/Days, or 
Weeks after an edition has been Created or Published.
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3 The remaining options are:

� Reset the editions without deleting them

� Delete associated files

� Delete edition log messages

� Delete system log messages

NOTE: The ‘older than ‘x’ days’ option relates to both the Delete edition log 
messages and the Delete system log messages options.

4 The Save backup log to option allows editions and associated files to be 
backed up to a defined folder prior to the purge. Press Browse to select the 
location to store the backed up files.

User Account To allow purging, the utility must have permission to access the files. A user 
account must be configured that has access permission, typically a system 
administrator account.

� Setup

1 To configure the User Account, press Set Password.

2 In the Set Account Information screen, enter a Username and Password that 
has permission to access and change all the relevant locations.

CAUTION: The Published condition relates to the Published Date for an 
edition. A Publication Date cannot be configured in the Edition Setup 
module. The Published condition can only be applied to externally created 
*.pmd editions.
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3 By default, the Suppress Interactive Messages check box should be 
disabled (unchecked). This option should only be enabled when running 
diagnostics.

4 Press OK to save the user account information and close the Set Account 
Information screen.

Schedule Screen Use the Schedule screen to configure how often (if scheduling is enabled) this 
Purge Task is launched.

This system has two types of scheduling: basic and advanced.

� Basic Scheduling

The basic schedule allows a task to be run as often as daily, every ‘x’ number of 
days from a specified start time;

CAUTION: The Enabled (scheduled tasks run at specified time) box 
should be checked to automatically run scheduled purges. Otherwise, this 
Purge Task must be run manually from the Purge Configuration screen. 
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■ Weekly, every ‘x’ number of weeks, commencing at a specific time on specific 
days;

■ Or, monthly, on specific months, on a specific date in the month.
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1 Press the Select Months button to reveal the Select Months screen.

2 Or, on a specific first, second, third, fourth, or last day in the month:
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.

3 A purge can also be scheduled to run At System Start-up, At Logon, or 
When idle for a specific number of minutes.
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� Advanced Scheduling

1 Press the Advanced button to display the Advanced Schedule Options 
screen.

� This option enables a purge to be done between specific dates and 
repeated within specific intervals.

2 Click OK to return to the Schedule screen.

� Multiple Schedules

1 To create additional schedules for this Purge Task, enable (check) the Show 
Multiple Schedules option.

2 Select New to create another schedule for this task to be repeated again.

3 To remove a schedule, highlight it in the list, and press the Delete button.
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Configuring Purge Task That Removes Files

This section explains how to create a Purge Task that removes files. If this type 
of Purge Task was created, the next screen will display the Purge Editions, 
Schedule, and Location screens.
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� Setup

1 Before pressing Next, enter the main folder to purge in the Purge field. 

NOTE: When specifying folders for purging, additionally specify that only certain 
formats of files should be deleted from these folders by typing an asterisk (*) 
followed by the suffix of the file format at the end of the folder path (e.g., 
C:\DAILY PAGE STORE\*.TIFF.

2 Press Next.

� Purge Editions screen

In the Purge Editions screen, the name of the Purge Task under creation is 
displayed in the title bar of the menu, and by the title Name.

CAUTION: While configuring this type of Purge Task, multiple folders may 
be specified to be deleted. However, this main folder is the only folder that 
can be archived to another location before deleting the original folder.
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The Folder field displays the main folder to be deleted, as configured in the 
previous screen.

1 Configure the type of files to be removed.

� The conditions for files to be removed can be by ‘x’ number of Minutes/
Hours/Days, or Weeks after an edition has been Created or Modified.

2 The Archive option allows the files to be backed up to a previously defined 
folder before purging.

3 Press Browse to select the location in which the archived files are to be 
stored.

� User Account

• “User Account” on page 316

CAUTION: Remember to enable or disable the Include subfolders check 
box.
:Arkitex Workflow Reference Guide



 

11 MANUAL PURGE UTILITY 325
� Location screen

1 Use the Location screen to configure more folders to remove.

2 To specify deletion of only certain file formats from these folders, add an 
asterisk (*) and the file format suffix to the end of the specified folder’s path.
e.g., C:\SPORTS_PICS\*.EPS.

3 Click Add to display the Select Folder screen:

4 Then press Browse to select the relevant folder to be purged.
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5 Once the location of the folder is specified, define (if required) the particular 
format of files within this folder for deletion by adding an asterisk (*) and the 
suffix of that file format to the end of the path.

6 Press OK.

7 To edit the location of a previously specified Purge Folder, select the folder 
from the list of Purge Folders, and press the Edit button.

8 To remove a previously specified Purge Folder, select the folder from the list, 
and click Remove.

Schedule Screen

The Schedule screen is used to configure how often (if scheduling is enabled) 
this Purge Task is launched.

This system has two types of scheduling: basic and advanced.

� Basic Scheduling

“Basic Scheduling” on page 317

� Advanced Scheduling

“Advanced Scheduling” on page 321

� Multiple Schedules

“Multiple Schedules” on page 321

� Complete Setup

1 Once configuring is finished, click OK to save these settings and close the 
menu.

2 The Purge Tasks created will now appear in the Purge Configuration screen.
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3 Any errors when running will be displayed in the Purge Configuration screen.

4 Select File > Exit to return to the Purge Utility screen.

5 Click OK to exit the program.

Related topics: • Arkitex Workflow System Administration Guide, Part Number CG+0948500001

Soft Proof Files and Purging

Soft proof files are identified with an *.sptmp extension. When a soft proof is 
generated, the files are moved to the Director\Complete folder.

These files will remain in the Complete folder for up to 24 hours, even if you run 
purge. This is designed to permit re-imaging a soft proof file.

In a future purge operation, the date stamp will be examined. If the date is more 
than 24 hours old, the files will be purged from Complete.
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APPENDIX

Incoming DCS 2.0 pages

Arkitex Director & Arkitex Pair supports input of pages in DCS 2.0 (single file) 
format. Arkitex Director & Arkitex Pair immediately separates the colors on 
receipt of files; therefore, DCS 2.0 files are regarded as separated input and not 
composite. Each color layer generated is given a separation identifier to match 
that defined by the user in Publication Builder.

Some front-end programs generating DCS 2.0 files (particularly foreign-
language applications) alter the C, M, Y, and K names for these four layers such 
that the words Cyan, Magenta, Yellow, and Black do not appear inside the DCS 
2.0 files. In this case it is important when defining color inks for an edition 
expecting incoming DCS 2.0 pages that the correct separation names that will 
appear inside the DCS 2.0 pages are defined (e.g., in French: Cyan, Magenta, 
Jaune and Noir).

The names should be keyed in for each edition on the Inks Definition screen 
within Publication Builder. It is essential that the spelling and case match exactly 
the name inside the DCS 2.0 file. For example, if the name inside the DCS 2.0 file 
for yellow is Jaune, you should type in Jaune and not JAUNE.
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APPENDIX

Generating Custom 
Reports

Arkitex Director & Arkitex Pair is based on a Microsoft SQL database and can be 
queried by standard packages such as Microsoft Access, or Seagate Crystal 
Reports. Whether or not the Arkitex Report option is purchased, the SQL 
database can still be accessed in order to generate custom reports.

To load the external Arkitex Director & Arkitex Pair data into the report writer, 
create an ODBC data source with a default database connected to the SQL 
database called PRMLog and the Tblog table.

Below is a list of the field names and descriptions used in PRMLog/Tblog:

Edition: (dbText,75)

The edition name.

SubEdition: (dbText,75)

The output location name.

Step: (dbText,25) 

An internal code for the stage at which the action has taken place.

PageNumber: (dbText,7)

The relevant page number (0 or nothing in this field indicates that the action is 
not related to a specific page number).

Separation: (dbText,25) 

A number between 1 and 7 relating to the ink order defined (up to) seven inks in 
Arkitex Publication Builder; 8 indicates a composite file; 9 indicates that the 
action is not related to a specific color separation).

Date: (dbdate)

The date on which the action has taken place.
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Time: (dbdate)

The time at which the action has taken place.

Message: (dbText,200)

A short explanation of the relevant action.

ErrorNum: (dbLong)

A number related to the action if it is an error condition (0 = non-error 
condition).

File: (dbText,75) 

The filename involved in the action (if any).

Action: (dbByte)

The code number that is given to this particular action.

The following are the numbers currently allocated to error or action codes, 
together with their meanings:

1 start/stop engine

2 disconnecting client

3 temporary password

10 before Hot time

11 Hot time

12 after Hot time

13 new edition/output location

14 edition deleted using Purge Utility

15 edition reset using Purge Utility

18 no Hot time

19 edition not found
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29 error outputting file

31 ready for processing

33 update from oman

34 update from processor

35 update from press

36 file on hold

37 unholding file

38 file not found

40 sending to softproof

43 processing softproof

44 wrong filename

51 page in deadline time

52 page on hold

60 start/stop edition output

61 unhold edition

62 unhold separation

63 clear plate

64 damaged plate

65 manual change of deadline time

69 manual change: ignore page

As an example, code “33 update from oman” indicates Arkitex Producer has 
reported successful completion at the RIP/imager. At the end of production, 
querying the Action field for instances of code 33 related to a specific edition in 
the Edition field would indicate the number of plates produced for that edition.
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APPENDIX

AutoPlan Files

AutoPlan files are *.pmd files that have not been created by the Publication 
Builder module. Briefly, *.pmd files are MAXML format files conforming to a set 
format.

Agfa publishes a document called “MAXML Publication Plan Input” (Part 
Number CG+0948950001), which specifies how to create an AutoPlan format 
file.

External files of this type may be created by downloading information from an 
external planning application (e.g., Arkitex Planner) or a third party press 
planning system (providing this information can be formatted to the MAXML 
either manually or via a filter or interface).

A major benefit of using these externally generated *.pmd files is that it removes 
the need to re-enter previously existing information via Publication Builder. The 
same features and functionality are shared whether *.pmd files are created in 
Publication Builder or via other methods according to this specification. 

For the latest input specification document, refer to the local AGFA Sales Office 
or Distributor.
335



336 AUTOPLAN FILES
:Arkitex Workflow Reference Guide



APPENDIX

EPS Samples (Included 
on DVD)

This section describes EPS samples:

� Samples .................................................................................................................. 338
� CMYK identifiers .................................................................................................. 340
� Calibration bars .................................................................................................... 343
�
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Samples

MARK1.EPS

MARK2.EPS

MARK3.EPS

MARK4.EPS
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MARK5.EPS

MARK6.EPS

MARK7.EPS
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MARK8.EPS

MARK9.EPS

CMYK identifiers

CMYK1.EPS

(200%)

CMYK2.EPS

(200%)
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CMYK3.EPS

(200%)

CMYK4.EPS

(200%)

CMYK5.EPS

(200%)

CMYK6.EPS

(200%)
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CMYK7.EPS

(200%)

CMYK8.EPS

(200%)

CMYK9.EPS

(200%)

CMYK10.EPS

(200%)
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CMYK11.EPS

(200%)

CMYK12.EPS

(200%)

CMYK13.EPS

(200%)

Calibration bars

STRIPB/W.EPS

(200%)
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STRIP1.EPS

(200%)

STRIP2.EPS

(200%)

STRIP3.EPS

(50%)
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STRIP4.EPS

(100%)
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APPENDIX

Variables

Symbol Definition Sample

%0n Sheet ID S012

%1n Lower imposition 
page ID

P001

%2n Higher imposition 
page ID

P012

%3n Lower even imposi-
tion page ID

P001

%4n Higher even imposi-
tion page ID

P012

%5n Lower odd 
imposition page ID

P001

%6n Higher odd imposi-
tion page ID

P012

%1:1n Page ID for row 1, 
column 1

P001

%3:4n Page ID for row 3, 
column 4

P008

%0f Sheet output 
filename

Sheet12.k

%1f Lower imposition 
page input filename

Page01.k

%2f Higher imposition 
page input filename

Page12.k

%3f Lower even imposi-
tion page input 
filename

Page01.k
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%4f Higher even imposi-
tion page input 
filename

Page12.k

%5f Lower odd 
imposition page 
input filename

Page01.k

%6f Higher odd imposi-
tion page input 
filename

Page12.k

%1:1f Page input filename 
for row 1, column 1

Page01.k

%3:4f Page input filename 
for row 3, column 4

Page08.k

%0p Sheet name 1

%1p Lower imposition 
page name

1A

%2p Higher imposition 
page name

12A

%3p Lower even imposi-
tion page name

1A

%4p Higher even imposi-
tion page name

12A

%5p Lower odd 
imposition page 
name

1A

%6p Higher odd imposi-
tion page name

12A

%1:1p Page name for row 
1, column 1

1A

%3:4p Page name for row 
3, column 4

8A

%1P Lower imposition 
page number

1

Symbol Definition Sample
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%2P Higher imposition 
page number

12

%3P Lower even imposi-
tion page number

1

%4P Higher even imposi-
tion page number

12

%5P Lower odd 
imposition page 
number

1

%6P Higher odd imposi-
tion page number

12

%1:1P Page number for 
row 1, column 1

1

%3:4P Page number for 
row 3, column 4

8

%0a Resubmit counter 
for the sheet

12A

%1a Lower imposition 
page resubmit 
counter

1

%2a Higher imposition 
page resubmit 
counter

12

%3a Lower even imposi-
tion page resubmit 
counter

1

%4a Higher even imposi-
tion page resubmit 
counter

12

%5a Lower odd 
imposition page 
resubmit counter

1

%6a Higher odd imposi-
tion page resubmit 
counter

12

Symbol Definition Sample
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%1:1a Page resubmit 
counter for row 1, 
column 1

1

%3:4a Page resubmit 
counter for row 3, 
column 4

8

%t Total number of 
sheets

48

%b Barcode LO12BCD45M

%x Extra information TO12CYL04

%e Edition identifier London

%s Section identifier BUS

%q Event sequence CTP_Polaris

%c Color name Black

%C Color ID K

%G Device group used 
to output this job 
when imposition is 
done at NewsDrive. 
Otherwise, an 
empty string

GROUP1

%I Device name used 
to output this job 
when imposition is 
done at NewsDrive. 
Otherwise, an 
empty string

CTP1

%K Copy number when 
imposition is done at 
NewsDrive. 
Otherwise, an 
empty string

1

Symbol Definition Sample
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%N The job ID when 
imposition is done at 
NewsDrive. 
Otherwise, an 
empty string

--

%R Recorded time --

%0d Publication Date --

%% The % character --

Symbol Definition Sample
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Index

Symbols

*.ik 285
*.pmt 27, 132, 134, 135, 

136, 164, 234, 236, 281, 
282, 283, 294, 295

Numerics

1/2 web 149, 150, 151, 
152

3/4 web 152

A

Activating Pub Builder 27
active 32, 192, 193, 194
add components 259
add text 236, 268, 270, 

271
adjust for creep 132
alarm button 216, 218
align 250, 253, 270
always on top 22
apply to all 69, 136, 139, 

181, 184
Arkitex client 16, 17, 18, 

21, 32, 62, 67, 90, 92, 93, 
113, 115, 131, 158, 185, 
196, 217, 218, 292

arkitex console 14, 21, 22, 
194, 214, 234, 268, 283, 
285, 294

Arkitex Publication 27
arkitex publication 

builder 15, 16, 17, 27, 
32, 92, 147, 165, 167, 170, 
178, 184, 191, 192, 193, 
194, 195, 196, 246, 331, 
335

autoupdate 73

B

barcode 18, 160, 161, 162, 
163, 164, 165, 166, 175, 

178, 181, 236, 246, 253, 
271, 272, 350

browse button 291, 316, 
324, 325

C

change all layers 123
changing 11, 39, 68, 113, 

114, 117, 119, 120, 121, 
123, 124, 175, 180, 184, 
197, 285, 294

child 43, 44, 52, 54, 119, 
121

clear alarm button 218
clear window button 215
clients connection 

button 215
color solid 93
colors 15, 51, 91, 92, 93, 

94, 95, 97, 98, 99, 119, 
121, 136, 140, 143, 144, 
155, 176, 179, 235, 248, 
263, 299, 329

coloured paper 91
colours 100, 235
columns 118, 122, 288
combo box 75, 184, 242, 

269
convert to CMYK 95, 97, 98
Copies 63
creep 131, 132, 282
crop 236, 263, 264, 265
custom 17, 75, 93, 124, 

126, 127, 128, 129, 130, 
144, 154, 156, 158, 159, 
185, 186, 191, 235, 241, 
285, 331

custom day 126

D

DCS 15, 217, 329
deadline time 19, 126, 

128, 129, 130, 176, 180, 

181, 184, 333
dinky 52, 149, 150, 151, 

152
direct printing 280
disconnect button 216
double burn 38, 102, 103
duplicated plan action 194, 

195

E

edit plate layout 287
editions 16, 17, 19, 20, 27, 

31, 32, 38, 39, 45, 46, 47, 
48, 52, 55, 57, 58, 59, 64, 
65, 91, 92, 113, 117, 118, 
122, 124, 138, 190, 192, 
193, 194, 195, 197, 198, 
213, 234, 283, 291, 294, 
295, 310, 311, 314, 315, 
316, 322, 323

editorial content 105
engine 17, 21, 69, 93, 164, 

165, 166, 213, 214, 215, 
216, 217, 218, 219, 259, 
263, 285, 306, 309, 332

EPS 15, 217, 218, 259, 
325, 337, 338, 339, 340, 
341, 342, 343, 344, 345

erase 237, 251, 256, 257, 
274

ERROR/FRMT folder 217
Event sequence 63

F

fan out 281
fasttrack 16, 27, 31, 32
flip 236, 255, 256, 257, 

263, 270
flip tools 255
full update 194
functional description 13
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G

Generating Editions 27
growing gutters 281
guides 15, 235, 244, 274

H

hardware error 219
HoldAfter 63

I

impose button 132, 146
impose sheets 133, 134, 

151, 176, 179
imposing pages 274
imposition 32, 33, 52, 73, 

131, 132, 138, 145, 146, 
157, 176, 274, 276, 347, 
348, 349, 350

incremental update 194
initial status 62, 90
ink coverage 285, 288
ink name 93, 162
Ink Presets 63
ink setup 21, 285
InkCalcConfig 285, 289
input file formats 15
input file name 

structure 65, 67, 69, 115, 
147, 197

introduction 11

L

label definition 159, 164
last softproof 219
link template 21, 294
linker 20, 27, 176, 234, 

236, 283, 293, 294, 295
lock 266
log viewer 17

M

manual purge 21, 305, 306
manually assign # of 

inks 99, 100
misc tab 38, 117
move 36, 143, 185, 190, 

191, 236, 240, 243, 254, 

255, 263, 267
multiple children 44, 45, 

52

N

names tab 33, 34, 35, 60
next day 126
no hold 63, 127

O

operation 120, 250, 251, 
252, 270

orientation 132, 167, 170, 
245, 250, 253, 254, 270, 
274, 275, 276, 278, 280

output file name 
structure 69

P

page definition 241
page input name 101
page style 141, 155
parent 43, 44, 45, 119, 

121, 122
paste 155, 156, 183, 236, 

276, 277
PDF 8, 9, 15, 16, 116, 131, 

158, 217
plate definitions 238
Plate Template 64
position 52, 65, 67, 132, 

141, 142, 160, 234, 235, 
239, 241, 243, 244, 245, 
247, 250, 253, 254, 258, 
262, 263, 266, 269, 270

PostScript 15, 16, 64, 94, 
217, 218, 219

postscript error 219
press run time 91, 123
preview generation 259
preview screen 53, 184
priority 62
properties 240, 242, 250, 

265, 266, 269, 270
publication builder 92
publication tree 27, 36, 43, 

57, 91, 123
purge 20, 21, 126, 292, 

305, 306, 310, 312, 314, 

315, 316, 317, 320, 321, 
322, 323, 326, 327, 332

purge utility 20, 126, 292, 
305, 306, 327, 332

R

replace 37, 195
reset all to default 184
review & activate tab 32
rotate tools 270

S

saddle stitch 74, 75, 98
same day 126
saving/activate 193
Secondary Output 64
secondary output 158, 159
select page 101, 236, 241, 

245
settings 7, 34, 39, 47, 56, 

90, 117, 124, 183, 234, 
235, 239, 240, 241, 244, 
257, 268, 274, 289, 326

share from other 119
sheet name structure 67, 

68, 69
short-cut buttons 272, 273
show preview 246, 259
Softproof 63
softproof 16, 17, 20, 61, 

63, 91, 92, 93, 164, 192, 
217, 218, 219, 241, 245, 
246, 248, 249, 259, 260, 
262, 263, 333

special shares 119, 120, 
121

specify %C for 
composite 67

substitute and do not output 
plates 62, 92, 106

substitute and output all 
plates 61, 92, 106

substitute and output 
pending plates 61, 92, 
106, 128

T

TIFF 15, 16, 64, 116, 131, 
217, 218, 259, 287, 288, 
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323
TIFF parameter testing 288
tool icons 119
tracking barcode 161, 162, 

163, 164, 165, 178
tree preview 58, 59

U

unlock 266

V

variables 33, 35, 65, 67, 
68, 69, 159, 162, 166, 268, 
347

View 8
view group screen 54

X

XML 16, 285
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PUBLICATION BUILDER

Activate Pub Builder

Publication Tree

Publication Date

Edition

Section

Open

Indicates that this edition is configured differently from the others in the tree

Ignore page

Double Burn Type - Monochrome/Monochrome

Double Burn Type - Monochrome/Color

Double Burn Type - Color/Monochrome

Double Burn Type - Color/Color

Check box used to indicate the layer is to have a double burn

Editorial approval

Advertising approval

Classified approval

Change black layer
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Change color layers

Change all layers

Share from previous

Share from other

Deadline time based on the color of the icon

A warning icon appears next to the specific edition to identify the 
indicated edition(s) could not be imposed

Used to hide sections by clicking the arrow to the left of the edition bar

Allows a text label to be defined and placed on the plate output of all 
incoming pages for this edition

Clicking on the icon allows the plate to be switched from positive to 
negative, right-reading to wrong-reading using a toggle effect.

Add a text label

A barcode label that will not be used by APS PRM for tracking 
purposes

A tracking barcode label

Indicates a group has been defined

ENGINE

Engine

Start/Restart Engine

Stop Engine

Clear Log Window button

Displays Client connections

Clear External Source Alarm
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Clear Alarm

Check Format Error Files

Check Softproof Error Files

Clear Arkitex Producer Alarm

CLIENT

Client button

PLATE EDITOR

Plate Editor button

Open

Open From Database

Save

Link icon in Plate Builder

Copy

Cut

Paste

Redo

Undo

Select Plate

Edit Selected Plate

Remove Selected Plate
:Arkitex Workflow Reference Guide



360
Large Icons

List

Details

Select Page

Add Component

Add Text

Add Barcode

Move Component

Crop Component

Flip Component

Rotate Component

Erase Component

Remove Component

Zoom In

Zoom Out

Operation

Align

Orientation

Fit to Window

View Erase On
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View Erase Off

Show Components

Hide Components

Guides on Top

Guides on Bottom

Show While Dragging

Hide While Dragging

Make Selected Erase Transparent

Make Selected Erase Non-Transparent

Show Element Information

Hide Element Information

INK SETUP

Start a New Ink Configuration File

Open an Existing Ink Configuration File

Save to the Current Ink Configuration File

Print the Current Ink Configuration File

Cut the selected section to the clipboard

Copy the selected section to the clipboard

Paste the clipboard as a new section

Add a new Parameters Section
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Add a new Percentage Section

Add a new CIP3 Image Section

Edit the Plate Layout

Overlay a tiff with ink setup

Select the Preprocessing orientation of the file

ACTIVATE

LINK TEMPLATE

Refresh

MANUAL PURGE

All Editions

Unplanned

Log Messages

New Task

Open and Edit the Selected Task

Run the Selected Task

Refresh the Task List

Delete the Selected Task
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